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Preface

The Oracle AutoVue User Manual explores AutoVue's key capabilities and is designed
to help you get the most out of AutoVue's extensive functionality.

For the most up-to-date version of this document, go to the AutoVue Documentation
Web site on the Oracle Technology Network at
http://www.oracle.com/technetwork/documentation/autovue-091442.html.

Audience
This manual is intended for Oracle AutoVue end users.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing
impaired.

Related Documents
For more information, see the following documents in the Oracle AutoVue
documentation library on OTN:

■ Installation and Configuration Guide

■ Viewing Configuration Guide

■ Client/Server Deployment Security Guide

■ Release Notes

■ Supported Formats List

■ Product Variations - Feature Matrix

Conventions
The following text conventions are used in this document:
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Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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1Introduction

Oracle's AutoVue suite of enterprise visualization solutions provides native document
viewing, markup and real-time collaboration capabilities that enable Web-based
document review on hundreds of native document types, including 2D/3D CAD,
EDA, Office and graphic formats. AutoVue enterprise visualization solutions address
the challenge of accessing, reviewing and collaborating on documents, both internally
and with globally dispersed teams and partners, in a secure and reliable manner
without compromising security or precision. Improved team productivity, reduced
errors, and accelerated innovation and time to market are just a few of the business
benefits organizations can expect to achieve.This manual explores AutoVue's key
capabilities and is designed to help you get the most out of AutoVue's extensive
functionality.

1.1 Oracle AutoVue
Oracle AutoVue is a viewing and markup application that has been developed for both
business and technical users. AutoVue is capable of displaying hundreds of file
formats without the authoring application. Supported file types include Text, Office,
Graphics, EDA, 2D Engineering Drawings, and 3D Models. Even contents of archive
files can viewed in AutoVue.

AutoVue will no longer open file with a missing or incorrect
extensions.

Oracle AutoVue is available in various product variations. Refer to the AutoVue
Product Variations - Feature Matrix document to see what features are available for
each variation.

1.2 Marking Up Documents
AutoVue has the ability to create markups for all its readable file formats without the
document's authoring application. AutoVue creates markups for different formats
without modifying the original file.You can attach comments, notes, and drawings to
any file you display in AutoVue. This is called “marking up a file”, commonly known
as annotating or redlining. A markup is an object or entity that you attach to a file. All
markups are saved in a separate file called a Markup or a Markup file. When you
display a file with its markups, the markups are overlaid as a layer on top of the
drawing. AutoVue provides a variety of flexible, user-friendly entities. To name a few,
there are circles, clouds, polygons, and leaders. You can also attach text to entities,
insert a note for longer comments, add attachments, or add a stamp such as a

Note:
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company logo. In addition, you can create measurement markup entities and
hyperlinks that link between the current file and other associated files or applications.
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2AutoVue Basics

This section introduces the basics of working in AutoVue; such as starting and exiting
AutoVue, the help menu, changing the locale of AutoVue, displaying file versions
information, and the AutoVue graphical user interface (GUI). The section on the
AutoVue GUI discusses the included menu bars, tool bars, navigation panel, and
navigation tree.

2.1 AutoVue Version Information
The About dialog displays AutoVue version and build information. You can also view
the version, build number, and build date of components that are shipped with
AutoVue. You can also export this information into a text file.

2.1.1 Viewing Version and Build Information
To view product version information:

1. From the Help menu, select About.

The About dialog appears and displays the AutoVue version number and build
date.

2. To view version and build information for components, click Version Info.

3. To export the version information click Export.

The Export dialog appears.

4. Navigate and select the directory to which you want to export the list.

5. Enter a file name (the default name is fverinfo.txt).

6. Click Save.

The list is exported to the specified file.

7. When you are finished viewing the file version information, click Close.

8. Click OK to exit the About dialog.

2.2 AutoVue Graphical User Interface
This section introduces you to the basics of working with AutoVue’s graphical user
interface (GUI). The following image displays the AutoVue GUI for a 3D drawing:
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Figure 2–1 AutoVue User Interface

This is the default view of AutoVue. If you are using a
customized AutoVue GUI file, the menu items and toolbars may vary.

2.2.1 Menu bar
The menu bar is the main access to all the menu commands. The selection of
commands changes according to the tasks being accomplished by AutoVue.

2.2.2 Toolbars
AutoVue has three toolbars: AutoVue toolbar, Markup Properties toolbar, and Markup
Entity toolbar.

2.2.2.1 AutoVue Toolbar
The AutoVue toolbar displays below the menu bar when you open AutoVue. It is the
default toolbar and includes the most commonly used functions when viewing a
file—open a file, create a new markup, print, zoom, and many others. Depending on
the file that is opened, the toolbar buttons will change. For example, the following
image shows the AutoVue toolbar when a 3D file is open:

Note:
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Figure 2–2 Toolbars Menu

2.2.2.2 Markup Properties Toolbar
The Markup Properties toolbar displays below the AutoVue toolbar when you enter
Markup mode. It includes the available property and formatting options for the
markup entities—save markups, change font, fill type, line style, and many others. The
following image shows the default Markup Properties toolbar:

Figure 2–3 Markup Properties Toolbar

2.2.2.3 Markup Entity Toolbar
The Markup Entity toolbar displays by default on the left side of the AutoVue window
when you enter Markup mode. It includes all the available markup entities for the
opened file.

Depending on the file that is opened, the toolbar buttons will change. For example, the
following image shows the Markup Entity toolbar when a 3D file opens.

Figure 2–4 Markup Entities Toolbar

The AutoVue GUI can be customized by the system
administrator. The GUI that is displayed is dependent upon whether it
is customized and on the type of customization.

2.2.3 Navigation Panel
The Navigation Panel displays by default on the left-hand side of the AutoVue
workspace when you view a drawing. For example, when viewing an EDA drawing, it
allows you to navigate through a list of component instances, nets, and the associated

Note:
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pins and net nodes (pins connected to a net) present in the current schematic drawing
or Printed Circuit Board (PCB) design.

To hide or display the Navigation panel, click .

The columns displayed in the Navigation Panel are determined by the profile of the
entity types in the current schematic drawing or PCB design. Lists can be sorted in
order to group similar component instances.

You can also use the Navigation Panel to select (highlight) single or multiple
components or entities; zoom to a component or entity, and query entity information.

Figure 2–5 Navigation Panel

2.2.3.1 Bookmarks Tab
The Bookmarks tab lists links to specific views (Draft views, 2D plans, 3D Views of an
EDA design) or pages or bookmarks structure that is saved in files such as PDF.

Figure 2–6 Bookmarks Tab

Navigate between the pages or files or views by clicking the appropriate link.
Bookmarks lead to various views of CAD files such as AutoCAD file Model Space, the
3D model of a file and associated 2D engineering drafts.

Note:
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If a plus sign appears to the left of a bookmark, click it to expand and view the lower
bookmark levels. If a minus sign appears to the left of the bookmark, click it to
collapse the lower bookmark levels.

To go to a destination specified by a bookmark, click the bookmark text or the page
icon located to the left of the bookmark text.

2.2.3.2 Components Tab

The Components tab displays only for the EDA pages of a
drawing.

The Components tab lists component instances and the associated pins.The top
portion of the tab lists all the instances of the currently displayed page of the drawing.
The lower portion of the tab lists the associated pins for selected instances.

When you select a component, it appears highlighted on the drawing. To select more
than one component, press the Shift or Control key while selecting. All the selected
components and their associated pins are highlighted.

Figure 2–7 Components Tab

2.2.3.3 Nets Tab

The Nets tab displays only for EDA drawings.

Figure 2–8 Nets Tab

Note:

Note:



AutoVue Graphical User Interface

2-6 Oracle AutoVue User Manual

The Nets tab lists nets and associated net nodes (pins connected to a net). The top
portion of the tab lists all the nets of the drawing’s currently displayed page. The
lower portion of the tab lists the associated net nodes for the selected nets.

All selected nets are highlighted on the drawing. To select more than one net, press the
Shift or Control key while selecting. Alternately, in the Nets panel, you can click and
drag in the Navigation Panel list to select multiple nets. The Nodes on Net panel lists
the associated nodes for the selected nets.

2.2.3.4 Models Tab and Model Tree
The Models tab displays the Model Tree. The tree displays the model’s hierarchy,
inter-relation of different parts, assemblies, and bodies. The tree also indicates if a
required external reference (XRef) is missing. With the tree, you can select different
parts and modify their attributes such as color, visibility, render mode or
transformation.

Figure 2–9 Models tab

See Displaying XREFs for more information on XRefs.

The Models tab displays only for 3D drawings.

2.2.3.5 Views Tab
The Views tab lists the defaults, standard, native, and user-defined views. You can
switch to a standard, native, or user-defined view, as well as add or delete
user-defined views.

Figure 2–10 Views Tab

The Views tab displays only for 3D drawings.

Note:

Note:
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2.2.4 Markup Navigation Tree
When you are in Markup mode, a Markup Navigation Tree appears below the
workspace. If the tree does not appear, from the Options menu, select Show Panel,
and then select Markup Panel.

Figure 2–11 Markup Navigation Tree

The tree displays a hierarchy of markups or comments created by users. You can
navigate through the markups. A set of properties is generated for each markup. You
can sort the markups in the tree according to each property by clicking the column
headers. These properties are:

Table 2–1 Properties

When a markup entity is created, it appears in the tree and the information is recorded
and saved in the Markup file.

Hover your mouse over an entity to display its author and
date properties.

2.2.5 Status Bar
When in View mode or Markup mode, the status bar is located at the bottom of the
main window. The fields displayed from left to right on the status bar are: marker,
current active filename, file type, zoom factor, current page and total number of pages,
current active file size, file creation date, and cursor’s coordinate position. The
following image shows the status bar:

Figure 2–12 Status bar

There are three markers that may be present on the status bar: the Markup Indicator
icon indicates associated markups, the Missing Resource icon indicate

Property Description

Markup Entity Type of markup entity created.

Author The name of the user who created the markup entity.

Last Modified The date and time the markup entity was last modified.

Page Page number of the original document on which the markup entity is
created.

Layer Markup layer on which the markup entity is created

Note:
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missing resources, and the Substituted Resource icon indicates substituted
resources.

The Markup Indicator indicates that the current active file has associated markups.
While in View mode, click the Markup Indicator icon to view the Markup Files dialog,
then select a Markup file or group of Markup files to open.

The Missing Resource icon indicates that some main resources required to properly
display the current active file are not available. To identify the missing resources, click
the Resource icon to display the Properties dialog.

The Substituted Resource icon indicates that if a required resource is missing, AutoVue
has replaced it with another resource. To identity the substituted resources, click the
Substituted Resource icon to display the Properties dialog.

2.2.6 Quick Menus
One of the quickest ways to access options is through Quick Menus or
context-sensitive shortcut menus. These are the menus you see when you right-click in
the workspace, Markup Navigation Tree, and Model Tree. The available Quick Menu
options depend on the location where you right-click.

2.2.7 Moving Objects
The left mouse button provides different functionality in the View and Markup modes:

Table 2–2 Different Modes

2.2.8 Accessing Commands with Shortcut Menus
AutoVue provides shortcut menus to access the majority of its functions. To do so,
right-click with the pointer in the View window to access to the appropriate
commands.

2.2.9 Canceling an Operation in Progress
To cancel an operation in progress, right-click the mouse anywhere in AutoVue client.

For example, if while drawing a box you realize that you would prefer to draw a
cloud, right-click while drawing the box to cancel the operation.

2.3 Opening Files
You can open base files and Markup files from the File menu and Markup menu,
respectively.

2.3.1 Opening a Local File
1. From the File menu, select Open. From the AutoVue toolbar, you can also click

Open File .The File Open dialog appears.

2. Browse to locate the file that you want to open.

Modes Left Mouse Button Functionality

View Mode By default, drag to perform an auto-zoom of all supported file formats
(excluding 3D formats). Select the area to enlarge.

Markup Mode If objects are selected, drag to modify and move objects. If no objects are
selected, then drag to perform an auto-zoom (same as in View mode).
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3. Click Open. The file opens in the AutoVue workspace.

2.3.2 Opening a URL
You can open a file by specifying the URL to the file.

1. From the File menu, select Open. From the AutoVue toolbar, you can also click
Open File. The File Open dialog appears.

2. From the left panel, click Web URL .

3. In the File name field, enter the URL of the file to open. For example,
http://AutoVueServer/files/abc.dwg or ftp://ftpserver1.com/files/abc.doc.

4. Click Open. The file opens in the AutoVue workspace.

2.3.3 Opening a File from Agile PLM

This section applies to AutoVue for Agile PLM.

With AutoVue for Agile, you can open a file located in Agile PLM from the File Open
dialog.

1. From the File menu, select Open.

The File Open dialog appears

2. To open a file from the backend DMS system, from the left panel, click Agile .

The bookmarked Agile Objects appear in the File Open dialog.

3. Select a file, and click Open. The file opens in the AutoVue workspace.

2.3.3.1 Searching for Files in Agile PLM
With AutoVue for Agile, you can search for files in the system by entering specific
search criteria in the File Open dialog.

1. From the File menu, select Open. The File Open dialog appears

2. To search for a file from the backend DMS system, from the left panel, click Search
Agile .

The Search criteria options load in the File Open dialog.

3. Enter the search criteria and then click Search.

Alternately, to view all files in Agile PLM, leave the search criteria fields empty
and click Search.

The file results appear in the dialog. For each AutoVue session, all search results
are saved and can be referenced from the File Open dialog as Search Results 1,
Search Results 2, and so on.

4. Select a file, and click Open. The file opens in the AutoVue workspace.

2.3.4 Streaming Files
AutoVue generates streaming files for most supported file formats. When a file is
accessed by AutoVue for the first time, a streaming file is generated. The streaming file
contains file data and provides the benefit that AutoVue can access the streaming file

Note:
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much faster than it can the native file. As a result, rendering time is significantly faster
when loading from the streaming file.

If the native file changes or its external resource files change or if an INI option
changes, the streaming file is invalidated. In this case, AutoVue opens the display from
the native file and generates a new streaming file.

2.3.5 Browsing Files
When you use the Browse option, all files and folders in the current directory are
displayed in the Browse dialog box and the last file opened is highlighted.

1. From the File menu, select Browse.

The Browse dialog box appears listing the files located in the current active
directory.

2. To change the current active directory, type the full path of the directory in the text
field at the top of the Browse dialog box.

The list of files contained in the directory appear.

3. Select the file that you want to view.

The file is displayed in the AutoVue workspace.

4. Continue selecting and viewing files as often as you like since the Browse dialog
box floats over the other AutoVue windows.

5. Click Close to exit the Browse dialog box.

The last file displayed remains open.

2.3.6 Viewing Files in Separate Windows
When you select the View Files in separate Viewer Windows option, each file is
displayed in a separate Viewer window.

1. From the Tools and Settings toolbar button, select View Files in Separate
Windows menu item.

Each file is displayed in a separate Viewer window.

2. If you want to view all the files in one window, de-select the option View Files in
Separate Windows.

2.3.7 Archive Files
The full archive file directory displays in the AutoVue window. It is not necessary to
decompress the file. Double-click a file to display it within AutoVue. If you would like
to markup an archived file, the file must be made accessible to AutoVue in a
decompressed form.

2.3.8 File Properties
From the File menu, select Properties to open the Properties dialog. The Properties
dialog provides information specific to the current active file, such as filename, file
size, date of creation, and file type. The file properties that you can view are:



Table 2–3 File Properties

The Properties dialog varies for each file format that is open.
As a result, some property tabs may be absent when viewing a file.
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2.3.8.1 Viewing File Properties
To view file properties, do the following:

1. From the File menu, select Properties. The Properties dialog appears.

2. The File Properties tab displays the file name, file size, date last modified, file type,
and number of pages the document contains. To view the file properties, click the
File Properties tab.

3. To view resource information, click the Resource Information tab. All included
resources are listed in the Resource Information tab. If a resource that is required
to fully display the file is missing, it is listed with the Missing Resource icon . If
a resource is found it appears with the Found Resource icon . If a required
resource is missing and AutoVue substitutes it with another resource, the
Substituted Resources icon appears.

4. To view native properties, click the Native Properties tab.

5. Click OK to close the Properties dialog.

2.3.9 Navigating a Document with Multiple Pages
AutoVue provides navigation buttons in the AutoVue toolbar to allow you to navigate
through a drawing (for example, Office, 2D, EDA, or 3D files) that contains multiple
pages.

The navigation buttons appear by default. The toolbar contains frequently used tools:
Previous Page, Next Page, and Page Number.

You can also access the navigation buttons from the View menu by selecting Page, and
then the required navigation button.

2.3.10 Opening Agile Attachment Files

This section only applies to AutoVue for Agile PLM.

Property Tab Description

File Properties Information specific to the current active file, such as filename,
file size, date of creation, file type, number of pages, and x, y and
z dimensions. It also indicates if the file is loaded from a
streaming file.

Resource Information Resources specific to the current active file, such as text font,
shape file, line style, and external reference files.

Native Properties Custom properties for file types, such as last person who saved
the file, signature verification, and author comments.

DMS If AutoVue is integrated with a backend DMS/PLM/ERP
system, a DMS tab appears that lists file attributes retrieved
from the backend system.

Note:

Note:
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You can view files from either the Attachments tab of a business object or from the
Files tab of a file folder object.

When multiples files are displayed in AutoVue, use the
document navigation buttons in the viewer toolbar to select the
document that appears in the viewer window.

2.3.10.1 Viewing Files from Web Client, Attachments Tab
To view a file from Web Client, Attachments tab:

1. Go to the attachments tab of a business object that references the file.

2. Click the file name link in the attachments table.

If the attachment row refers to a file folder with only one file, AutoVue opens and
displays that file.

If the attachment row refers to a multiple-file folder, each file is listed in the File
Name column. Click the file link to open a the file with AutoVue.

2.3.10.2 Viewing Files from Web Client, Files Tab
To view a file from Web Client, Files tab:

1. Go to the Files tab of a file folder object containing the files to be reviewed.

2. Click the filename link in the file table.

AutoVue opens and displays the file.

2.3.10.3 Viewing Files from Java Client, Attachments Tab
To view a file from Java Client, Attachments tab:

1. Go to the Attachments tab of a business object that references the file.

2. Double-click the attachment row.

If the attachment row refers to a file folder with only one file, AutoVue opens and
displays the file.

If the attachment row refers to a multiple-file folder, the Select Files window
appears. Select one or more files to view and then click OK. AutoVue opens and
displays the files you selected.

2.3.10.4 Viewing Files from Java Client, Files Tab
To View a file from Java Client, Files tab:

1. Go to the Files tab of a file folder object containing the files you want to view.

2. Double-click the filename in the file table.

AutoVue opens and displays the file.

2.3.11 Opening Agile Attachment Files from the Viewer Window
When the AutoVue window is open, you can use the viewer menus to select additional
Agile files. For many viewer functions this is a preferred method when compared to
pre-selecting the files in the Agile client.

The available AutoVue menu options that allow you to select another attachment file
are as follows:

Note:



The list of available AutoVue menu selections for an Agile
attachment file varies. These menu options are dependent on the
function originally selected in the Agile PLM when AutoVue was
opened (that is, View, Compare, or Overlay were selected) and the file
type of the currently viewed file. As a result, some of the following
menu options may not be available to choose in a specific viewer
session.
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■ From the File menu, select Open URL.

■ From the Analysis menu, select Compare.

■ From the File menu, select Import File as Overlay (only available if a 2D file is
active).

■ From the Analysis menu, select Cross Probe.

Selecting one of these menu options opens the File Open dialog. From this dialog you
can select a file to view or to add to the current analysis view. The Agile Browse
button in the dialog allows you to use your Agile bookmarks to select a file. The Agile
Search button in the dialog allows you to perform a quick search and select a file.

Select an Attachment File
To use your Agile Bookmarks to select an attachment file:

1. Select an available Viewer menu option:

■ From the File menu, select Open URL.

■ From the Analysis menu, select Compare.

■ From the File menu, select Import File as Overlay.

■ From the Analysis menu, select Cross Probe.

2. Follow any dialog prompts until the File Open dialog appears.

3. From the File Open dialog, click the Agile Browse button.

If you did not define any bookmarks in Agile PLM, then the Agile Browse button
does not appear in the File Open dialog.

The DMS: File Open dialog appears and displays your Agile Bookmarks in a tree
structures.

4. Click the plus symbol to expand a bookmark and display its item revision or its
file folder versions.

5. Click a revision or version row to highlight the file you want to view.

6. From the DMS: File Open dialog, click OK.

AutoVue opens the selected file, or, if appropriate, adds the selected file to the
current analysis function.

Quick Search to Select an Attachment File
To perform a quick search to select an attachment file:

1. Choose an available Viewer menu option:

■ From the File menu, select Open URL.

■ From the Analysis menu, select Compare.

Note:
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■ From the File menu, select Import File as Overlay (only available if a 2D file is
active).

■ From the Analysis menu, select Cross Probe.

2. Follow any dialog prompts until the File Open dialog appears.

3. From the File Open dialog, click Agile Search.

The Search dialog appears.

4. From the Search dialog, define your search and then click Search:

Table 2–4 Search Options

5. From the Search Results table, click the + next to the object number to expand the
list of attachment files for the object.

6. Click a revision row or a version row to select the file you want to review.

7. Click Load File.

The selected file name appears in the File Name field of the File Open dialog.

8. From the File Open dialog, click OK.

AutoVue opens the selected file, or, if appropriate, adds the selected file to the current
analysis function.

2.3.12 Comparing Revisions or Versions of a File
AutoVue allows you to compare multiple revisions or versions of a file.

Compare Multiple Revisions of a File
To compare multiple item revisions of an attached file:

1. From the item Attachments tab, select the file you want to compare.

2. From the tab menu, select View.

AutoVue opens and displays the selected file.

3. From the viewer menu, select Analysis and then Compare.

The File Open dialog appears.

4. Select the Document Version check box.

5. From the drop-down menu, select another revision of the file to compare.

Option Description

Class Select an object class (for example, Items).

Search Parameter Enter a text string or number.

Agile PLM searches the object ID number attribute and the object
Name or Description attribute. A Quick search behaves similar to a
Contains search for text strings. The search criteria is treated as a
single string and Agile PLM searches for names or descriptions that
contain the search parameter string. In the case of ID numbers, Agile
PLM searches for a exact match. However, you may use wildcard
characters to specify part of an ID number as a search criteria.

Search Attachment
Content

Set this parameter to Yes in order to search the contents of attachment
files as well.
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Only released item revisions appear in the drop-down list. To compare the
attachment of a pending revisions, view the pending revision and then use the
Compare feature to select released revisions for comparison.

6. Click OK.

AutoVue opens the selected version in a second window and displays the
differences between the two files in a third window.

7. To compare another revision, from the viewer menu, select File and then Exit
Compare.

8. Repeat steps 3 through 6 to select another item revision.

Compare Multiple Versions of a File
To compare multiple file folder versions of a file:

1. From the file folders File tab, select the file you want to compare.

2. From the tab menu, select View.

AutoVue opens and displays the selected file.

3. From the viewer menu, select Analysis and then Compare.

The File Open dialog appears.

4. Select the Document Versions check box.

5. From the drop down menu, select another file folder version of the file for
comparison.

6. Click OK.

AutoVue opens the selected version in a second window. A third window displays
the differences between the two files.

7. To compare another file version, select File and then Exit Compare.

8. Repeat steps 3 through 6 to select another file folder version.

2.3.13 Viewing Design Object Structures
When you open a CAD assembly file in a Design object, Agile PLM automatically
opens the subordinate CAD part files in AutoVue, allowing you to view the entire
CAD design. Agile PLM uses the assembly structure (as defined in the Structure tab of
the Design object and the Structure tabs of its child Design objects).

Viewing structured data in a Design data model class object
relies on the Structure tab to resolve related objects in the structure.

This process is seamless and requires no action by the user other than initiating the
view function for the assembly file.

The following list provides details on how Agile PLM extracts CAD Structure files
from the Design object and its Structure table for CAD design viewing:

■ The file type of the Design objects selected file must be designated as a CAD
Structure file type on the File Association tab of the Viewer & Files node in Agile
Administrator.

■ The structure used to extract files is explicitly set on the Design object Structure
tab.

Note:
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■ Agile PLM identifies which Design object files to extract by the following
methods:

– If the value of the File Category attribute from any file row of a child Design
matches the File Category value of the starting file, the file is extracted.

– If the selected starting Design object file has no value for Category, then all
files in all child Designs are extracted, including the starting Design object.

■ If multiple file rows on a Design object structure have the same Category value as
the starting file, they are all extracted at any level in the tree.

■ If the user selects multiple Design object files and then selects View, then each
selected file is interpreted separately (based on Design structure viewing logic).

■ When a Design object is from a business object's Attachment tab, Agile PLM uses
the rules for viewing Designs. As a result, Design object viewing rules are always
applied to Design objects whether the viewing action is initiated from a Design
object or from the business object Attachments tab.

2.3.14 Viewing Document Structured File Types

Viewing structured data in a File folder class object relies on
the DocuBOM or the Relationships tab to resolve related objects in the
structure. While this technique for viewing structured CAD files in
DocuBOMs is still supported, it has been superseded by Design
structures as the preferred way for storing and viewing data.

CAD data can be stored in Agile PLM using document object BOM structures. This is
accomplished automatically when Agile PLM and Engineering Collaboration (EC) are
integrated using EC CAD connectors. A CAD assembly file is attached to an Agile
document object, and the subordinate CAD part files are also attached to Agile
document objects. The part file document objects appear on the BOM tab of the CAD
assembly document object, thus creating a hierarchical file structure for the attached
files.

File types that are used in structured file hierarchy are
specified in Agile Administrator Viewer & Files node with the CAD
Structure file association.

When you open a CAD Structure assembly attachment, Agile PLM automatically
opens the subordinate part files in AutoVue, allowing you to view the entire CAD
design. This process is seamless and requires no action by the user other than initiating
the view function for the assembly file.

The follow list provides details on how Agile PLM extracts CAD Structure files from
the document BOM structure for CAD design viewing:

■ Agile PLM extracts only file types specified as CAD Structure file types. If an
attached file type is not specified as a CAD Structure file type, Agile PLM does not
traverse the document structure to find other files.

■ If the file type is specified as a CAD Structure file type, then Agile PLM will
traverse all levels of the document hierarchy. It starts with the selected file and
then extracts other files necessary to build the complete model.

Note:

Note:
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■ In order to avoid pulling out unnecessary files, the viewing logic makes use of the
Attachment Type attribute on the document's Attachments tab. If there is a value
in this attribute (such as SOURCE) for the originally selected file attachment, then
only files whose Attachment Type attribute matches this value will be extracted. If
there is no value in the Attachment Type attribute, then all files within the
structure hierarchy will be extracted.

■ If there are multiple file attachments with the matching value of Attachment Type
on the same document, they will be extracted and sent to AutoVue. This includes
the document from which the view operation was initiated.

■ If any given document in the hierarchy does not have any file attachments, or any
with the correct value of Attachment Type, then the extraction process continues
down the tree.

■ The Agile administrator may have configured Agile PLM to use the CAD Revision
BOM attribute. This is used by standard Agile EC CAD connectors to provide an
As Saved fixed BOM resolution for CAD designs. If enabled, when viewing a past
revision of a design object, it appears in the same state as when it was last saved. If
disabled, view of the design may differ if child components were revisioned (that
is, standard Agile BOM resolution logic is followed).

■ You can select any document revision for viewing (including a pending revision).
If the CAD Revision attribute is enabled, when viewing a pending revision, all
active pending revisions that were saved from CAD will be displayed within the
structure.

■ All AutoVue operations support CAD Structure file types, including: View,
Markup, Compare, Cross Probe, and Overlay.

2.3.15 Using the Version Browser
When a File Folder object is open in Web Client, you can view object version
information by selecting View All Versions from the Action menu.

When a Design object is open, you can view Design version/revision information by
selecting View All Versions from the Action menu.

Switching Versions of a Design Object in Web Client
To switch between versions of a Design object in Web Client, from the Version
drop-down list at the top of the Design object, select the version/revision you want to
view.

A version number in brackets (for example, [4]) indicates a
version that has not yet been checked in. That is, for example, when
version 3 was checked out, a pending version [4] was created.
Selecting [4] from the drop-down list allows you to view and work
with the pending version.

Select View All Version from the Actions menu to open the Versions palette.

The View All Versions action is only available in Web Client.
Java Client does not support Design objects.

The Version palette displays the following information about each version:

Note:

Note:
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Initiating Actions in the Versions Palette
The following are actions you can initiate in the Versions palette:

■ View – Click the View drop-down menu to choose one of the following options:

– View: Select any version row and click View to view the file or files in
AutoVue.

– Compare: For single file versions, select two versions rows and then select
Compare form the View drop-down list. AutoVue compares the selected files.

Initiating Actions from the Design Object Version Palette
To initiate actions from the Design object Version palette:

■ Comparison Report: (Design objects only) Click the Comparison Report
drop-down menu to select one of the following options:

– Compare: Select any two version rows and click Compare to compare the
Designs in the Comparison Report drop-down menu. A Design Comparison
Chart displays a comparison report.

– Comparison by Search: Select a version row and click Compare by Search in
the Comparison report drop-down list. A Compare by Search palette opens. In
the drop-down list select either Latest Version or All Versions. Enter a search
string (enter * to search for any design object) and execute a quick search.
Choose from a list of Designs to compare with the original Design object. The
Design Comparison Chart displays a comparison report.

– Design Comparison Chart: The Design Comparison Chart displays reports of
the compared Design objects. The plus sign expands the Design object to
display a list of child objects attached to it. You can collapse the object using
the minus sign. Click the gray dot icon to see more details about Attributes
and Files. Colors indicate the state of the Design object.

For example, Blue - Added, Orange - Modified, Red - Deleted.

■ Purge Version: Design objects store large CAD files, which are updated regularly.
The Purge Version action allows you to remove unwanted Design versions and
help optimize file storage. To begin the process, the Design object needs to be in
the checked in state. Purging starts at the original version and continues down the

Version Columns Description

Column 1 Displays the approval status of the file folder version.The approval
status is displayed only if there are approvers on the Routing Slip.

Version The version number.

Checking Date

Checking User

The date the version was checked in and the user who performed the
checking.

Change Info Indicates how the version was modified before it was checked in.

Files indicate that the object's files were modified; for example, files
were replaced, added, or deleted.

For Design objects, Structure indicates that the Design's Structure tab
was modified.

Label, Revision,
Revision Date

These are version-specific editable fields used primarily with Design
data model objects.
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Structure tab, and goes through all the versions, including the child objects. The
process stops if you cannot purge a child object.

2.3.16 Accessing Different File Versions from the Business Object Attachments Tab
You can get, open, view, and print any version of an attachment file from the
Attachments tab of the business object.

You can easily access history without clicking through to the File Folder object. This is
useful when a single file is being modified and accessed by multiple people/different
functions. For instance, user can easily trace and identify in which versions another
user made their edits - this is identified from version create date and checkout user.

The Versions dialog displays, for each version, the Version Creation Date (date the
version was created), whether that version has redlines (indicated by the Has Been
Redlined icon), and the Checkout User (user who created that version). This allows
you to easily see the history of an attachment from the Attachments tab, including
who modified the file, and when it was modified.

Switching Between File Folders Version in Web Client
To switch between versions of file folders from an object's Attachments tab in Web
Client:

1. From the Attachments tab, select the required attachment row.

2. From the tab menu, select Menu and then View Versions.

The Versions dialog appears.

3. From the Versions dialog, select the required row, then select the Get, View or
Print from the dialog menu.

Optionally, select two version rows, and then choose Compare or Overlay from the
View action button drop-down menu.

Switching Between File Folders Version in Java Client
To switch between versions of file folders from an object's Attachments tab in Java
Client:

1. From the Attachments tab, select the required attachment row.

2. Click Show Versions.

The Versions dialog appears.

3. Select the version rows that you want to access.

4. Click the appropriate action (Get, Open, View, or Print).

Optionally, click the Has Been Redlined icon to open AutoVue and to display the
redlines. Select two version rows, then select either Compare or Overlay from the
View action drop-down menu.
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3Comparing Files

In Agile, a file comparison is initiated from either the File tab of the File Folders or
from the Attachments tab of business objects.

For detailed information on file comparison features, refer to Comparing 2D Files.

Note that Markups (redlines) and comparing Office formats are not supported in
AutoVue Compare mode.

3.1 Comparing Files in Web Client and Java Client

This section only applies to AutoVue for Agile PLM.

You can select and compare two files from a single file folder Files tab or a single
business object Attachments tab.

To initiate comparing files:

1. Display the Attachments tab or the Files tab.

2. Select the files you want to compare and then select one of the following:

For Web Client, select View and then Compare.

For Java Client, select View File(s) and then Compare.

The file and the comparison results display in a single viewer window.

3.2 Comparing Files by Search
The Compare Files by Search attribute allows you to:

■ Compare files from different released revisions of an item.

■ Compare files from different file folder versions.

■ Select any file on any business object Attachments tab or on any file folder Files
tab, and then search for a file to use for comparison.

Depending on your search, you can select a business object, and then select a file from
the list of related files for that object. Or, if you have the appropriate privileges, you
can search for file folder objects, and then select a file from the list of related files for
the selected file folder.

Note:



For item objects, introductory revisions and unreleased
pending revisions do not appear in the related files list.
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3.2.1 Initiating a File Compare by Search
To initiate a file compare by search:

1. Display the Attachments tab or Files tab.

2. Select a file row you want to work with and choose:

■ 9.2.1.x or 9.2.2.x Web Client: View > By Search > Compare

■ 9.3.x Web Client: View > Compare By Search (A search dialog allows you to
search for the object.)

■ Java Client: View File(s) > By Search > Compare

The Compare Files By Search dialog appears with three search tabs.

3. The search dialog allows you to search for any business object (for example items
or manufacturer parts) and select the attachments of those objects to compare.
User any of the following search methods:

■ Search tab lets you create a simple search or an advanced search. You can
check to search attachment contents, too.

■ Saved Searches tab opens to your navigation pane where you can browse in
search folders, select a search, and run it. Again, returned results may be
moved to the Selected Items table, and click OK.

■ Shortcuts tab opens to your navigation pane where you can select objects from
My Bookmarks or Recently Visited. The system displays shortcuts to only
those objects that are appropriate to the operation you are performing.

Only business objects with attached files appear in the search results table. For
example, a business object that you viewed recently will not appear on the
Recently Visited list of the Shortcuts tab if it has no attachments.

4. When the results of your search are returned, select a row in the results table, and
the related files for that object appear in the Related Files table.

5. In the Related Files table, select the file you want:

■ If the selected search object is a file folder, use the Version drop-down list in
the Related Files table to select the file folder version you want.

■ If the selected search object is an item, in the Related Files table displays item
attachments for each released revision of the item (the file name followed by
the revision number or letter, for example, widget.dwg - A and widget.dwg -
B).

For item objects, Introductory revisions and unreleased
pending revisions do not appear in the related files list.

■ If the selected search object is a business object, select the Show Matching File
Types Only check box to display only the related files that are the same file
type as the file with which you want to compare.

6. When finished, click OK.

Note:

Note:
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You can continue to run multiple searches or shortcuts until you are finished
selecting the attachments you want.

The files and the comparison results appear in a single viewer window.

3.2.2 Initiate Compare in AutoVue

This section applies to all flavors of AutoVue.

The following sections describe how to initiate a compare in AutoVue.

3.2.2.1 Initiating Compare in AutoVue
To initiate comparing files in AutoVue:

1. View an appropriate file for compare.

2. Display the Attachments tab or the Files tab.

3. Select a file row you want to work with and choose:

■ Web Client: View > View

■ Java Client: View Files (s)

AutoVue opens and displays the selected file.

4. In the AutoVue Analysis menu, choose Compare.

The File Open dialog appears.

5. Use one of the following File Open dialog methods to select a file to compare:

■ Browse to browse your local directories to select and open files from the
AutoVue window.

■ Agile Browse to use Agile bookmarks to open files from the AutoVue window.

■ Agile Search to perform an Agile Quick Search to select and open files from
the AutoVue window.

3.2.2.2 Selecting a File From Local Directory
You can select an attachment file by browsing your local directories:

1. From the File Open dialog, click Browse.

2. Use the Look in drop-down list to select the directory you want.

3. Select the file you want and click Open.

4. Click OK in the File Open dialog

The Viewer opens the selected file, or, if appropriate, adds the selected file to the
current analysis function.

3.2.2.3 Selecting a File from Agile Bookmarks
To use your Agile Bookmarks to select an attachment file:

1. From the File Open dialog, click Agile Browse.

The DMS: File Open dialog appears and displays your Agile Bookmarks in a tree
structure.

Note:



If you have not defined any Bookmarks in Agile PLM, the
Agile Browse button does not appear in the File Open dialog.
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2. Click + to expand a bookmark and display its item revisions or its file folder
versions.

3. Click a revision or version row to highlight the file you want to view.

4. Click OK in the DMS: File Open dialog. The selected file name appears in the File
Name field of the File Open dialog.

5. Click OK in the File Open dialog.

The Viewer opens the selected file, or, if appropriate, adds the selected file to the
current analysis function.

3.2.2.4 Selecting a File with Agile Search
You can use Agile Search to perform a quick search to select an attachment file:

1. From the File Open Dialog, click Agile Search.

The Search dialog appears.

2. From the Search dialog, define your search with the following options and then
click Search.

Table 3–1 Search Options

3. In the Search Results table, click the + next to the object number to expand the list
of attachment files for that object.

4. Click a revision row or a version row to select the file you want to view.

5. Click Load File. The selected file name appears in the File Name field of the File
Open dialog.

6. Click OK in the File Open dialog.

The Viewer opens the selected file, or, if appropriate, adds the selected file to the
current analysis function.

Note:

Option Description

Class Select an object class. For example, Items.

Search Parameter Enter a text string or a number.

Agile PLM searches the object ID number attribute and the
object Name or Description attribute. A Quick search behaves
like a Contains search for text strings. The search criteria is
treated as a single string and Agile PLM searches for names or
descriptions that contain the search parameter string. In the
case of ID numbers, Agile PLM searches for an exact match,
however, you may use wildcard characters to specify part of an
ID number as a search criteria.

Search Attachment
Content

Set this parameter to Yes to search the contents of the
attachment files as well.
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4Working with 2D Files

When working with vector and non-vector 2D files in AutoVue, you can instantly
change how the active file is displayed in the workspace by choosing from a number
of different view options. For example, you can zoom into an area of the drawing,
magnify a part of the drawing, and rotate a file’s orientation clockwise,
counterclockwise.

When viewing 2D vector files, you have access to entity information, views saved in
the drawing, and the ability to “intelligent snap” when performing measurements. All
the information is obtained by AutoVue by referencing various sources; either internal
files or external reference files that are located outside the file.

In addition to the features mentioned, this chapter provides detailed information on
how you can modify AutoVue to suit your needs and preferences through a broad
range of configuration options.

4.1 Searching Text
You can perform a text search on 2D vector and text-based documents.

AutoVue provides search options that you can use to customize a search. These
options are as follows:

You cannot perform a text search on raster files.

Table 4–1 Search Options

4.1.1 Searching Text
To search for a text, do the following:

1. From the Edit menu, select Find Text. The Find dialog appears.

2. Enter the word or phrase that you want to find in the Find What field.

If you are searching in a vector file, select a text string from the list.

Note:

Option Description

Match Whole Word Only Match a complete word

Match Case Search for a word or text with specific capitalization

Up Search backward in the document

Down Search forward in the document
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3. You can refine your search by selecting Match Whole Word Only or Match Case.

4. Click Find Next.

AutoVue highlights the text and zooms into the text area. For PDF files, AutoVue
highlights the text but maintains the current zoom level.

5. Click Close to close the Find dialog.

4.2 2D Viewing Options
From the View menu, you can change how the active file is displayed in the
workspace. For example, you can zoom into an area of the drawing, magnify a part of
the drawing, and rotate a file’s orientation clockwise, counterclockwise.

You can access these options from the View menu. The options are:

Table 4–2 Options in View Menu

Menu Sub-Menu Description

Zoom Zoom Box Click and drag to draw a box around an object that
you want to enlarge to fill the window.

From the AutoVue toolbar, you can click or
right-click in work-space and select from pop-up
menu.

Zoom In Zoom in by a factor of 2.

From the AutoVue toolbar, you can click .

Zoom Out Zoom out by a factor of 2.

Zoom Previous Reverts to the previous zoom level.

Note: You can also right-click the workspace and
select Zoom - Previous.

Full Resolution
Display the file at full resolution .

Fit

Note: Resizing
the AutoVue
window
where an
image in the
workspace has
been zoom
fitted
(Horizontal,
Vertical or
Both) results
in the
proportional
resizing of the
image.

Horizontal Fit the image horizontally in the active window. The
vertical dimensions of the image are zoomed
proportionally but may be too large or small for the
window.

Note: You can also right-click the workspace and
select Zoom - Page Width.

Vertical Fit the image vertically in the active window. The
horizontal dimensions of the image are zoomed
proportionally but may be too large or small for the
window.

Both AutoVue finds the best fit for the current file with
respect to both its vertical and horizontal
dimensions.

From the AutoVue toolbar, you can also click

Note: You can also right-click the workspace and
select Zoom - Fit
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4.2.1 Using the Pan and Zoom Window
The Pan and Zoom Window view option allows a close-up view of a particular area of
a file while maintaining a full view of the file. The Pan and Zoom Window displays a
miniature version of the file and has a movable box frame on top of the miniature to
indicate the area of the file displayed in the AutoVue workspace.

The Pan and Zoom Window option is disabled for text-based
documents and spreadsheets.

1. From the View menu, select Pan and Zoom Window.

From the AutoVue toolbar, you can also click Pan and Zoom Window .

The Pan and Zoom window appears displaying a full view of the file.

2. From the Options menu, select Dynamic to view the changes in “real time”.

3. To view a close-up of a specific area of the file in the AutoVue workspace,
minimize the frame box by clicking and dragging the frame handles.

4. To view a different area of the file in the AutoVue workspace, click and drag the
frame box to the area that you want to view.

If you perform a zoom function in the AutoVue workspace, the area displayed in
the workspace is highlighted by the frame box in the Pan and Zoom Window.

5. From the Pan and Zoom menu, select Exit to close the window.

The last view performed remains in the AutoVue workspace.

4.3 Working with 2D Vector Files
In addition to all the features that are available for generic 2D files, AutoVue provides
the ability to access entity information, access views saved in the drawing, and the
ability to “intelligent snap” when performing measurements.

Pan and Zoom
Window

Display a close-up view of a particular area of a file
while maintaining a view of the entire file.

From the AutoVue toolbar, you can also click

Note: The Pan and Zoom Window option is disabled
for text-based documents and spreadsheets.

Pan Click and drag to move the drawing. To exit
right-click.

From the AutoVue toolbar, you can click

Rotate

Note: The
Rotate option
is disabled for
archived files,
text-based
documents
and
spreadsheets.

Rotate Clockwise Rotate the file 90 degrees clockwise.

From the AutoVue toolbar, you can click

Rotate Counter
Clockwise

Rotate the file 90 degrees counter clockwise.

From the AutoVue toolbar, you can click

Note:

Table 4–2 (Cont.) Options in View Menu

Menu Sub-Menu Description
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AutoVue references various sources to obtain all data required to completely and
accurately display vector files. These sources can be internal to the file—like layers,
blocks, and overlays—or external reference files (XRefs) that are located outside the
file.

4.3.1 Manipulating 2D Vector Files
The Manipulate menu option allows you to manipulate how the current active file is
displayed. For example, you can select which layers, blocks, and external reference
files (XRefs) to display.

The Manipulate menu options are:

Table 4–3 Manipulate Menu Options

4.3.1.1 Displaying Layers
Use this option to configure the layers to display of the current active file.

1. From the Manipulate menu, select Visibility Control, and then select Layers.

The Select the Layers to Display dialog appears listing the layers and layer
visibility for the current active file.

2. To sort the list of layers in the dialog, click Name to sort alphabetically or
numerically, or click Status to sort by visibility.

3. You can modify the visibility of a layer or layers by doing one of the following:

■ De-select/select the Status check box beside the layers that you want to
hide/display.

■ Click All On to display all the layers or click All Off to hide all the layers.

■ Select a layer from the dialog and then click Toggle to hide/display the layer.

4. Click OK to close the dialog and to apply your changes.

4.3.1.2 Selecting Blocks
Use this option to select a block to display from the current active file.

1. From the Manipulate menu, select Visibility Control, and then select Blocks.

The Select a Block to Display dialog appears listing the blocks for the current
active file.

Menu Sub-Menu Description

Visibility Control Layers Select and display different layers of a drawing.

From the AutoVue toolbar, you can click

See Displaying Layers for more information.

Blocks Select and display a block from a drawing.

From the AutoVue toolbar, you can click

See Selecting Blocks for more information.

XREFs Select the XRefs to display in the drawing.See
Displaying XREFs for more information.

Overlays Select an overlay to modify. See Adding an Overlay
for more information.
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2. From the list, select the block that you want to display.

3. Click OK.

The selected block is displayed.

4.3.1.3 Displaying XREFs
AutoVue references various sources to obtain all the data required to completely and
correctly display files. These sources can be internal to the file, like layers and blocks.
External reference files (XRefs) are located outside the file.

Use the XRefs option to display the external references of the current active file.

1. From the Manipulate menu, select Visibility Control, and then select XREFs.

The Select the External References to Display dialog appears listing the external
reference files associated with the current active file.

2. You can modify the visibility of the XRefs by doing one of the following:

■ De-select/select the Status check box beside the XRef that you want to
hide/display.

■ Click All On to display all the XRefs or click All Off to hide all the XRefs.

■ Select a XRef from the dialog and then click Toggle to hide/display the XRef.

3. Click OK to close the Select the External References to Display dialog.

The selected XREFs are displayed.

4.3.1.4 Displaying Details About Resources
Resource information for a file is displayed in the left of the AutoVue status bar. If a
file is missing resources the Missing Resource icon appears to the left of the
AutoVue status bar. These missing resources can be XRefs, text fonts, linestyles, or
shape files. If a missing resource has been substituted for another resource, the
Substituted Resource icon appears.

In order to correctly display a file, you must make sure all
required resources are provided to AutoVue.

See Viewing Missing XRef Notification Icon for information on missing XRefs.

1. Click the Missing Resource icon or the Substituted Resource icon on the AutoVue
status bar.

From the File menu, you can also select Properties.

The Properties dialog appears.

2. Click the Resource Information tab to display details about missing or substituted
resource information required to properly display this file.

A green check mark indicates the resources that AutoVue is able to access. A red
indicates that resources are not accessible. A yellow exclamation mark indicates

that a missing resource has been substituted for another resource.

3. Click OK to close the Properties dialog.

Note:
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4.3.1.5 Overlaying Files in Web Client and Java Client
You can overlay files from the Attachments/Files tabs by selecting View, and then
Overlay or View File(s) and then Overlay from the Web Client and Java Client,
respectively. Alternately, from the Java Client, you can initiate overlaying files with the
By Search feature:

1. Display the Attachments tab or the Files tab.

2. Select a file row you want to work with and choose:

■ 9.2.2.x or 9.2.1.x Web Client: From View, select By Search, then Overlay.

The View Files by Search dialog appears, with three Search tabs.

■ 9.3.x Web Client: View.

The file opens in AutoVue. From File, select Import File, then Overlay.

■ Java Client: From View File(s), select By Search, then Overlay

The Select Files dialog appears, with three Search tabs.

3. The search dialog allows you to search for any business object (for example, items
or manufacturer parts) and select the attachments of those objects to use to
overlay. Use any of the following search methods:

Table 4–4 Search Methods

Only business objects with attached files appear in the search
results table. For example, a business object that you viewed recently
will not appear on the Recently Visited list of the Shortcuts tab if it has
no attachments.

4. When the results of your search are returned, select a row in the Results table, and
the related files for that object appear in the Related Files table.

5. In the Related Files table, select and move attachments to the Selected Files table.

6. You can continue to run multiple searches or shortcuts until you are finished
selecting the attachments you want.

7. When you are finished, click OK.

The files are displayed in a single viewer window, one on top of the other.

4.3.1.6 Initiate Overlay in AutoVue
To initiate overlaying files in AutoVue:

1. Select and view an appropriate file. That is, a file type that can be used for overlay
analysis.

Tab Description

Search Create a simple search or an advanced search. You can also check to search
attachment contents.

Saved Searches Opens to your navigation pane where you can browse in search folders,
select a search, and run it. Again, returned results may be moved to the
Selected Items table, and click OK.

Shortcuts Opens to your navigation pane where you can select objects from My
Bookmarks or Recently Visited. The system displays shortcuts to only those
objects that are appropriate to the operation you are performing.

Note:
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2. Display the Attachments tab or the Files tab.

3. Select a file row you want to work with and then choose:

■ Web Client: From the View menu, select View.

■ Java Client: View File (s)

AutoVue opens and displays the selected file.

4. From the AutoVue menu, choose Import File as Overlay. The File Open dialog
appears.

5. Use one of the following File Open dialog options to select a file to overlay:

Table 4–5 Overlay

1. From the Manipulate menu, select Overlays.

The Modify Overlay dialog appears.

2. Select the overlay that you want to modify.

3. Click the Action that you want to apply to the overlay.

4. Click Move if you want to move the overlay. Click a point on the base file where
you want to set the lower left corner of the overlay. Click another point where you
want to set the upper right corner of the overlay.

As you select the point to define the position of the upper right corner, you can
resize the destination box.

5. Click Scale if you want to resize the overlay. Enter the XOffset and YOffset
coordinates and/or the Scale Factor.

XOffset and YOffset are relative to the base drawing and all options are displayed
at their current values.

6. Click Warp to adjust the overlay. Click a point on the overlay and drag the cursor
to where you want the overlay starting point. Click another point and drag the
cursor to where you want the overlay to end.

The overlay’s size is scaled to accommodate the origin and destination points you
defined.

7. Click OK.

To modify other overlays, repeat steps 2 to 4.

The changes are applied to the selected overlay.

Browsing Local Directories to Select File
You can browse your local directories to select an attachment file:

1. From the File Open dialog, click Browse.

2. Use the Look in drop-down list to select the directory you want.

Option Description

Browse Browse your local directories to select and open files from the AutoVue
window.

Agile Browse Use Agile bookmarks to open files from the AutoVue window.

Agile Search Perform an Agile Quick Search to select and open files from the AutoVue
window.
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3. Select the file you want and click Open.

4. Click OK in the File Open dialog. The Viewer opens the selected file, or, if
appropriate, adds the selected file to the current analysis function.

Using Agile Bookmarks to Select File
You can click Agile Browse to use your Agile Bookmarks to select an attachment file:

1. From the File Open dialog, click Agile Browse. The DMS: File Open dialog
displays your Agile Bookmarks in a tree structure.

If you have not defined any Bookmarks in Agile PLM, Agile
Browse does not appear in the File Open dialog.

2. Click the plus symbol to expand a bookmark and display its item revisions or its
file folder versions.

3. Click a revision or version row to highlight the file you want to view.

4. Click OK in the DMS: File Open dialog. The selected file name appears in the File
Name field of the File Open dialog.

5. Click OK in the File Open dialog. The Viewer opens the selected file, or, if
appropriate, adds the selected file to the current analysis function.

Using Agile Search to Select File
You can use Agile Search to perform a quick search to select an attachment file:

1. From the File Open dialog, click Agile Search. The Search dialog appears.

2. Define your search using the following options and then click Search.

Table 4–6 Search Options

3. In the Search Results table, click the plus symbol next to the object number to
expand the list of attachment files for that object.

4. Click a revision row or a version row to select the file you want to view.

5. Click Load File. The selected file name appears in the File Name field of the File
Open dialog.

6. Click OK in the File Open dialog. The Viewer opens the selected file, or, if
appropriate, adds the selected file to the current analysis function.

Note:

Option Description

Class Select an object class, for example, Items.

Search Parameter Enter a text string or a number.

Agile PLM searches the object ID number attribute and the
object Name or Description attribute. A Quick search behaves
like a Contains search for text strings. The search criteria is
treated as a single string and Agile PLM searches for names or
descriptions that contain the search parameter string. In the case
of ID numbers, Agile PLM searches for an exact match, however,
you may use wildcard characters to specify part of an ID
number as a search criteria.

Search Attachment
Content

Set this parameter to Yes to search the contents of the attachment
files as well.
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4.3.1.7 Adding an Overlay
When working with 2D files, you can overlay other files over the current active file.
You can also adjust an overlay, move an overlay, and scale an overlay by defining the X
and Y coordinates and the scaling factor.

When working with a raster file, it should be used as the base
file because raster formats are opaque and would hide files
underneath them.

1. Open the file that you want to use as the base file for the overlay.

2. From the File menu, select Import File as Overlay.

3. Click Add File.

The Please Select an Overlay File dialog appears.

4. Select a file to overlay and then click Open.

5. To add another file, repeat steps 3 through 4.

You can hide/display certain overlays by selecting/de-selecting corresponding
check boxes in the Visibility column.

6. When done, click OK to close the Overlays dialog.

The base file is displayed with the selected overlay files on top of it.

4.3.1.8 Modifying an Overlay
To modify the overlay do the following:

1. From the Manipulate menu, select Overlays. The Modify Overlay dialog appears.

2. Select the overlay that you want to modify.

3. Click the Action that you want to apply to the overlay.

4. Click Move if you want to move the overlay. Click a point on the base file where
you want to set the lower left corner of the overlay. Click another point where you
want to set the upper right corner of the overlay. As you select the point to define
the position of the upper right corner, you can resize the destination box.

5. Click Scale if you want to resize the overlay. Enter the XOffset and YOffset
coordinates and/or the Scale Factor. XOffset and YOffset are relative to the base
drawing and all options are displayed at their current values.

6. Click Warp to adjust the overlay. Click a point on the overlay and drag the cursor
to where you want the overlay starting point. Click another point and drag the
cursor to where you want the overlay to end. The overlay’s size is scaled to
accommodate the origin and destination points you defined

7. Click OK. To modify other overlays, repeat steps 2 to 4.

The changes are applied to the selected overlay.

4.3.1.9 Removing an Overlay
To remove the overlay do the following:

1. From the File menu, select Import File as Overlay.

The Overlays dialog appears.

Note:
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2. Select the overlay that you want to remove.

3. Click Remove.

The overlay is removed from the list.

4. Click OK.

The overlay is removed from the display.

4.3.2 Selecting Views
The Views option allows you to access different named views of a file.

1. From the View menu, select Views.

The Select a Named View dialog appears.

2. From the list, select the view that you want to display.

3. Click OK.

The selected view is displayed.

To return to the default view, select Default View.

4.3.3 Specifying a View Point
The View Point option allows you to render a drawing from a selected viewpoint.

1. From the View menu, select View Points.

The View Point dialog appears.

2. Enter the X, Y and Z coordinates for the view point with which you want to render
the drawing.

3. Click OK.

The drawing is displayed from the selected view point.

4.3.4 Analyzing 2D Vector Files
With the analysis functionality, you can measure entities, compare two files, or view
drawing information. These options are available under the Analysis menu.

The following table lists all the options from the Analysis menu:

Note:

Table 4–7 Analyzing 2D Vector Files

Menu Sub-Menu Description

Measure Measure the distance, area, angle, and arc of
an entity.

From the AutoVue toolbar, you can click

Measure .

See also Measuring in 2D Files.

For more information click Measure .

Compare Compare two files.

See Comparing 2D Files for more
information.
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4.3.5 Comparing 2D Files
AutoVue provides the ability to visually compare two files and display color-coded
comparative data. Generally when comparing two files, you should first open the
newer version of the document and then compare it with the older version.

When comparing files, AutoVue displays three windows:

■ The right window displays the newer version of the document.

■ The left window displays the older version of the document.

■ The bottom window displays the comparison results.

By default, the result windows display added, deleted, and unchanged entities. In the
Comparison Result window you can specify whether you want to display only the
additions, deletions or unchanged, or any combination of the three. To access these
options, right-click in any window and select an option from the pop-up menu. By
default, the Comparison Result window displays the unchanged, deleted, and added
information.

The Compare feature performs a graphical comparison not a
geometrical comparison.

The comparison results are displayed in different colors to differentiate the results of
the file comparison. The comparison options and corresponding colors are:

Table 4–8 Results of the Comparison

1. View the newer file in AutoVue.

2. From the Analysis menu, select Compare.

The File Open dialog appears.

Show Drawing Information Select Single
Entity

Displays information for the selected entity.

See Also Viewing Details of a Single Entity
for more information.

List
Tags/Attributes

List block attributes and tags.

See Also Viewing Tags/Attributes for more
information.

Entity
Information

View information of a set of entities.See Also
Viewing Information for a Set of Entities for
more information.

Note:

Option Color Description

View Additions Green Displays data that is present in the newer file but not in
the older file.

View Deletions Red Displays data that is missing in the newer file but present
in the older file.

View Unchanged Blue Indicates that there is no change between the newer file
and old file.

Table 4–7 (Cont.) Analyzing 2D Vector Files

Menu Sub-Menu Description
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3. Enter the file name or browse to select the file that you want to compare with the
newer file.

4. Click OK.

If you apply a change from the View menu, all three windows display the
synchronized change.

AutoVue displays three windows, the first displaying the newer file, the second
displaying the older file and the third displaying the comparison results.

5. To access the Compare options, right-click in any of the windows.

A menu appears displaying the Compare options.

6. When comparing AutoCAD files, you can view a file without viewports. To do so,
from the View menu, select View Without Viewports.

7. To maximize any of the windows, double-click the title bar of the window that you
want to maximize. To restore the window, double-click the title bar.

8. To exit Compare mode, from the File menu, select Exit Compare.

From the AutoVue toolbar, you can also click Exit Compare Mode .

The newer file appears in the workspace.

4.3.5.1 Align and Scale
You can scale or translate a file in order to compare files accurately. With the Align and
Scale option you can select to automatically align the files, select points to align and
scale, modify the coordinates (XOffset and YOffset) or enter a scaling factor for the
second file.

To align or translate the file, do the following:

1. While in Compare mode, from the View menu, select Align and Scale.

The Align and Scale dialog appears.

2. Select one of the following options:

Table 4–9 Options

3. Click Apply.

The align and scale modifications are applied to the file in the second window.

4. Click OK to the close the Align and Scale dialog.

Option Description

Automatic AutoVue selects the best fit for the two files.

Select Points to Align Select snapping points to align to.

Select Points to Align and Scale Select snapping points to align and scale to.

Custom You can enter a scale factor as well as X and Y offset
values; XOffset and YOffset are relative to the base
drawing and all options are displayed at their current
values.



Working with 2D Vector Files

Working with 2D Files 4-13

4.3.6 Drawing Information
The Drawing Information option is only available with AutoCAD and MicroStation
drawings, and is accessed from the Analysis menu. The Drawing Information options
available are: Select Single Entity, List Tags/Attributes, and Entity Information.

4.3.6.1 Viewing Details of a Single Entity
The Select Single Entity option allows you to view information of a single entity.

1. From the Analysis menu, select Show Drawing Information, and then select
Select Single Entity.

2. Click the entity for which you want to view information.

3. If you did not select an entity, a message appears informing you that no entities
were found and prompts you to select again.

4. The Get Entity Info dialog appears displaying the information for the selected
entity. The Extended Data (XData) button appears if additional information exists
for that entity. Click XData to view the information.

5. Click OK to close the Get Entity Info dialog.

4.3.6.2 Viewing Tags/Attributes
The List Tag/Attributes option allows you to view information on block attributes and
tags.

1. From the Analysis menu, select Show Drawing Information, and then select List
Tags/Attributes.

2. Click in the area of the file for which you want to view information on block
attributes and tags.

If there are no entities within the selected box, a message appears informing you
that no entities were found and prompts you to select again.

The Block Attributes dialog appears displaying the attributes/tags for the selected
entity.

3. Click OK to close the Block Attributes dialog.

4.3.6.3 Viewing Information for a Set of Entities
The Entity Information option allows you to view information of a set of entities
contained in a specific area of a drawing.

1. From the Analysis menu, select Show Drawing Information, and then select
Select Single Entity.

2. Click and drag to highlight the entities for which you want to view entity
information.

If there are no entities within the selected area, a message appears informing you
that no entities were found and prompts you to select again. To exit, right-click the
mouse anywhere in the workspace.

The List Entities dialog appears displaying the information of all the selected
entities.

3. Click OK to close the List Entities dialog.
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4.4 Working with PDF files
This section lists AutoVue features that are specific to Adobe PDF files.

4.4.1 Navigating through PDF files
When navigating through a PDF file you can use the mouse-wheel to zoom and to
scroll. For a single page PDF, the mouse wheel is used to zoom in and out of a
document. For a multi-page PDF, the mouse wheel is used to scroll from page to page.

4.4.2 Navigating through Markups
When navigating through markups, AutoVue preserves the current zoom level. For
example, when the Go To feature is selected from the Markup Navigation tree,
AutoVue highlights the markup entity in the workspace (AutoVue navigates to
markup entity if on a different page) and maintains the current zoom level.

4.4.3 Measuring in PDF Files
When measuring vector-based PDFs, AutoVue allows you to snap to certain entities to
take measurements. You can snap to the end-points or mid-points of an entity.
AutoVue also allows you to snap to shapes (closed entities) for area measurements.
This option also applies when adding a Markup Measure entity to the PDF file.

For Angle and Arc entities, only 3-point snapping is available.
See Measuring in 2D Files.

4.4.4 Text Search
You can perform a text search in vector-based PDF files where the scanner performs
Optical Character Recognition (OCR). AutoVue highlights the text search result in the
workspace and maintains the current document zoom level. If the text is very small,
AutoVue zooms in to the highlighted text. If the text if outside the visible workspace
area, AutoVue scrolls/pans to display the highlighted text.

See Searching Text.

4.4.5 Text Selection/Copy
You can select and copy text from a vector-based PDF file where the scanner performs
Optical Character Recognition (OCR).

To do so, highlight the text and then select Copy from the Edit menu. You can then
paste the text to the Note markup entity or a third-party application (for example, MS
Word).

Note:



Note the following behaviors when copying text from a PDF
file in AutoVue:

■ It may not be possible to copy text if the PDF file has a security
restriction.

■ When copying text from PDF files, AutoVue displays the text as it
appears in the PDF. That is, AutoVue inserts a line break if text
continues to a next line (word wrapping) in the PDF.

■ In some PDF files, when copying text that includes line spaces,
AutoVue may not insert the spaces. This is because the line spaces
are not saved in the PDF file.

Measuring in 2D Files

Working with 2D Files 4-15

4.5 Measuring in 2D Files
AutoVue provides the ability to perform measurements in 2D files. Measurement
options vary between vector and non-vector files.

■ For vector files, AutoVue provides the option to “snap” to fixed points on the
drawing.

■ For non-vector files, the Snapping Modes option is disabled. However, you can
free snap to any point on the drawing.

AutoVue provides several measure options that you can choose from.You can access
the measure options from Analysis menu and selecting Measure, or from the AutoVue
toolbar, click Measure .

The measure options are as follows:

Table 4–10 Measure Options

4.5.1 2D Vector Snapping Modes
The available snapping modes allow you to click to precise geometrical points on a
drawing. For example, if you select Snap to End-Point and you move the cursor over
an end-point of a line, the end-point will be highlighted by a snap box.

The snapping modes allow you to snap to the mid, center, and end-points of an entity:

Note:

Name Description

Distance Measure the distance between two points.

See Distance in non-Vector Files

See Distance in Vector Files

Area Measure selected area.

See Area in non-Vector Files

See Area in Vector Files

Angle Measure the angle between selected points or between two lines.

See Angle in non-Vector Files

See Angle in Vector Files

Arc Measure an arc-entity

See Arc in non-Vector Files

See Arc in Vector Files



Table 4–11 Snapping Modes

When selecting a snapping mode you also have the option to
select all snapping modes (All On) or to turn off snapping modes (All
Off).
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The Table 4–12 lists snapping locations for certain measurements:

Table 4–12 Snapping Location

4.5.2 Distance in non-Vector Files
Use the Distance option to measure the distance between two specific points.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Distance tab.

3. In the Measure Distance Units list, select a unit of measurement.

If you want to measure the distance along a path, select the Cumulative check box.

4. Click a point on the drawing to define the starting point.

5. Click another point on the drawing to define the end point.

If you selected Cumulative, continue clicking points along the path that you want
to measure.

6. Right-click to complete the measurement.

Click Reset to take another measurement.

The points are joined by a line. The Measured Distance, Delta-X, and Delta-Y
appear in the Measurement dialog.

7. Click Close to close the Measurement dialog.

Button Snap to Description

End-point Geometric snap mode where a snap box appears when moving
the cursor near a linear component’s end point.

Mid-point Geometric snap mode where a snap box appears when moving
the cursor near the halfway point of a linear component.

Center-point Geometric snap mode where a snap box appears when moving
the cursor near the center of an elliptical component.

Free Snap Allow snapping at any point on the drawing.

Note:

Measurement Snapping Location

Area Snaps to a shape on the drawing.

Arc Snaps to an arc on the drawing.

Angle Snap to two non-parallel lines.
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4.5.3 Distance in Vector Files
Use the Distance option to measure the distance between two specific points.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Distance tab.

3. Select the snapping modes that you want to use for measuring.

4. To select all snapping modes click All On. To clear all snapping modes click All
Off.

5. From the Measured Distance Units list, select the units of measurement.

If you want to measure the distance along a path, select Cumulative.

6. Click a point on the drawing to define the starting point.

7. Click another point on the drawing to define the end point.

If you selected Cumulative, continue clicking points along the path that you want
to measure.

8. Right-click to complete the measurement.

Click Reset to take another measurement.

The points are joined by a line. The Measured Distance, Delta-X, and Delta-Y
appear in the Measurement dialog.

9. Click Close to close the Measurement dialog.

4.5.4 Calibrating Distance
Calibrate the distance measurement.

1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.

The Distance Calibration dialog appears displaying the measured distance.

3. From the Units list, select the unit to which you want to calibrate the distance.

4. Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.

The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

4.5.5 Area in non-Vector Files
Use the Area option to measure the area and perimeter of a region.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.
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2. Click the Area tab.

3. In the Area Units list, select a unit of measurement in which to measure the area of
the region.

4. In the Perimeter Units list, select a unit of measurement in which to measure the
perimeter of the region.

In the Net Area Result group, select Add to cumulate a net area result of different
areas, select Subtract to subtract an area from the net area result, and select Clear
to clear the Net Area Result field.

5. Click a point on the drawing to define the starting point.

6. Continue clicking points on the drawing to define the region you want to measure.
Each point is joined by a line. The area and perimeter measurements appear in
their respective fields in the Area tab.

7. Right-click to complete the measurement.

Click Reset to take another measurement.

8. Click Close to close the Measurement dialog.

4.5.6 Area in Vector Files
Use the Area option to measure the area and perimeter of a region.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Area tab.

3. Select Between Points if you want to measure the area between points on a
drawing.

Snapping modes are displayed.

4. Select the snapping modes that you want to use for measuring: See 2D Vector
Snapping Modes for more information.

Table 4–13 Snapping Modes

5. Select Shape if you want to measure the area of a predefined shape on the
drawing.

6. From the Measured Area Units list, select the unit in which you want to measure
the area.

7. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

8. To cumulate a Net Area Result of different areas, click Add.

9. To subtract an area from the Net Area Result, click Subtract.

Select Clear to clear the Net Area Result.

Option Descriptions

All On Select all snapping modes.

All Off Clear all snapping modes.
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10. If you selected Between Points, click points on the drawing to define the area.

Each point is joined by a line. The area and perimeter measurements appear in the
Measurement dialog.

11. Right-click to complete the measurement.

12. If you selected Shape, click the edge of the predefined shape.

The shape is highlighted and the area and perimeter measurements appear in the
Measurement dialog.

13. Click Reset to take another measurement.

14. Click Close to close the Measurement dialog.

4.5.7 Angle in non-Vector Files
Use the Angle option to measure the angle between points on a drawing.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Angle tab.

3. Select a unit of measurement from the Units list.

4. Click points on the drawing to define the angle you want to measure.

Click Reset to take another measurement.

Angle arms appear with an arc connecting them. The angle measurement appears
in the Angle tab.

5. Click Close to close the Measurement dialog.

4.5.8 Angle in Vector Files
Use the Angle option to measure the angle between points on a drawing.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Angle tab.

3. From the Angle Definition section, select one of the following:

■ From 3 Points: Measure the angle between three points.

■ Between 2 Lines: Measure the angle between two non-parallel lines.

4. Select the snapping modes that you want to use for measuring.

5. To select all snapping modes click All On, to deselect all snapping modes click All
Off. See 2D Vector Snapping Modes for more information.

6. Select Between 2 lines if you want to measure the angle between two lines.

7. From the Measured Angle Units list, select the unit.

8. If you selected From 3 Points, click three points on the drawing to define the
angle.
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9. If you selected Between 2 Lines, click two lines on the drawing to define the
angle.

Click Reset to take another measurement.

Angle arms appear with an arc connecting them. The angle measurement appears
in the Measurement dialog.

10. Click Close to close the Measurement dialog.

4.5.9 Arc in non-Vector Files
Use the Arc option to define an arc in the drawing and calculate its arc center, radius,
diameter, and arc length.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Arc tab.

3. In the Arc Info section, select a unit of measurement from the Length Units list in
which to measure the length of the arc.

4. In the Measured Angle section, select a unit of measurement from the Sweep Units
list in which to measure the angle of the arc.

5. Click points on the drawing to define the arc.

Click Reset to take another measurement.

The points are joined by an arc. The measurements for center point coordinates,
radius, diameter, arc length, start and end of angle, and sweep appear in the Arc
tab.

6. Click Close to close the Measurement dialog.

4.5.10 Arc in Vector Files
Use the Arc option to define an arc in the drawing and measure its radius, center, arc
length, start and end of angle, sweep, and diameter.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Arc tab.

3. Select From 3 Points if you want to measure the arc between three points.
Snapping modes are displayed.

4. Click the snapping modes that you want to select as the points for the
measurement.

To select all snapping modes click All On. To clear all snapping modes click All
Off. See 2D Vector Snapping Modes for more information.

5. Select Arc Entity if you want to measure a predefined arc.

6. From the Arc Info Unit list, select the unit in which you want to measure the
distance.
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7. From the Measure Angle Units list, select the unit in which you want to measure
the angle.

8. If you selected From 3 Points, click three points on the drawing to define the arc.

The points are joined by an arc. The measurements for center point coordinates,
radius, diameter, arc length, start and end of angle and sweep appear in the
Measurement dialog.

9. If you selected Arc Entity, click the edge of the arc that you want to measure.

To take another measurement click Reset.

The arc is highlighted. The measurements for center point coordinates, radius,
diameter, arc length, start and end of angle and sweep appear in the Measurement
dialog.

10. Click Close to close the Measurement dialog.

4.5.11 Calibrating an Arc
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.

The Radius Calibration dialog appears displaying the measured distance.

3. From the Units list, select a unit of measurement to which you want to calibrate
the distance.

4. Click Calibrate to and enter a value if you want to calibrate to a value.

5. Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.

The calibration results appear in the Arc tab.

7. Click Close to close the Measurement dialog.
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5Working with EDA Files

In addition to all the features that are available for generic 2D files, AutoVue also
provides intelligent querying for EDA files; you can create/modify layer sets, generate
BOM, perform intelligent measurements, analyze nets and components, set enhanced
display options and global transparency, and much more. For information on the
available features for EDA files, refer to the following sections.

5.1 Navigation Panel
The Navigation Panel displays by default on the left-hand side of the AutoVue
workspace when you view a drawing. For example, when viewing an EDA drawing, it
allows you to navigate through a list of component instances, nets, and the associated
pins and net nodes (pins connected to a net) present in the current schematic drawing
or Printed Circuit Board (PCB) design.

To hide or display the Navigation Panel, click .

The columns displayed in the Navigation Panel are determined by the profile of the
entity types in the current schematic drawing or PCB design. Lists can be sorted in
order to group similar component instances.

You can also use the Navigation Panel to select (highlight) single or multiple
components or entities; zoom to a component or entity, and query entity information.

Note:
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Figure 5–1 EDA Navigation Panel

5.1.1 Customizing Columns
In the Navigation Panel, you can sort a column, change column order, or hide/show a
column. To sort a column, click the column heading.

1. To change the column order or to show/hide a column, click Customize.

The Customize Columns dialog appears.

2. Select the check box beside the column or columns you want to display. De-select
the check box beside the column or columns you want to hide.

To show all columns, click Show All. To hide all columns, click Hide All.

3. To change the column order, select the column you want to move, then click Move
Up to move the column up in the list or click Move Down to move the column
down in the list.

4. To save the changes you made to the columns, select Save Column Settings.

The new column settings will be retained the next time the file is opened.

5. Click OK.

The changes appear in the Navigation Panel.

5.2 Components Tab

The Components tab displays only for the EDA pages of a
drawing.

The Components tab lists component instances and the associated pins.The top
portion of the tab lists all the instances of the currently displayed page of the drawing.
The lower portion of the tab lists the associated pins for selected instances.

When you select a component, it appears highlighted on the drawing. To select more
than one component, press the Shift or Control key while selecting. All the selected
components and their associated pins are highlighted.

Note:
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Figure 5–2 Components Tab

5.3 Nets Tab

The Nets tab displays only for EDA drawings.

The Nets tab lists nets and associated net nodes (pins connected to a net). The top
portion of the tab lists all the nets of the drawing’s currently displayed page. The
lower portion of the tab lists the associated net nodes for the selected nets.

All selected nets are highlighted on the drawing. To select more than one net, press the
Shift or Control key while selecting. Alternately, in the Nets panel, you can click and
drag in the Navigation Panel list to select multiple nets. The Nodes on Net panel lists
the associated nodes for the selected nets.

Figure 5–3 Nets Tab

5.4 Bookmarks Tab
The Bookmarks tab lists links to specific views (Draft views, 2D plans, 3D Views of an
EDA design) or pages or bookmarks structure that is saved in files such as PDF.

Navigate between the pages or files or views by clicking the appropriate link.
Bookmarks lead to various views of CAD files such as AutoCAD file Model Space, the
3D model of a file and associated 2D engineering drafts.

If a plus sign appears to the left of a bookmark, click it to expand and view the lower
bookmark levels. If a minus sign appears to the left of the bookmark, click it to
collapse the lower bookmark levels.

To go to a destination specified by a bookmark, click the bookmark text or the page
icon located to the left of the bookmark text.

Note:
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Figure 5–4 Bookmarks Tab

5.5 Selecting Entities
Selecting an entity or entities is often the first step to many of the operations that you
perform with EDA files. The following sections provide information on how to select
entities from the workspace, Navigation Panel, and the Entity Search dialog. To specify
which types of entities you can or cannot select, use the Entity Filter dialog.

See Filtering Entity Types for more information on the Entity Filter dialog.

Once an entity is selected, you can zoom to it in the workspace and perform other
operations with the EDA file.

5.5.1 From the Navigation Panel
To select an entity from the Navigation Panel, perform the following steps:

To select one entity, click the component, net, associated pin, or net node in the
Navigation Pane.

To select multiple entities, press the Shift or Control key while selecting.

The selected entity or entities are highlighted in the workspace. If the selected entity is
small, a flash box appears indicating the location of the highlighted entity in the
workspace.

See Zooming to a Selected Entity.

5.5.2 From the Workspace
To select an entity from the workspace, perform the following steps:

Click an entity in the workspace to select it. To select more than one entity, press the
Shift or Control key while selecting.

The selected entity or entities appear highlighted in the workspace and in the
Navigation Panel. If the selected entity is small, a flash box appears indicating the
location of the highlighted entity in the workspace.

You can also apply selection filters when selecting entities in the workspace.

See Filtering Entity Types.

When you hover the mouse over an entity in the workspace, a tooltip with information
about the entity’s attributes appears. The tooltip displays whether or not you select the
entity.

5.5.3 From the Entity Search Dialog
To select and entity from the Entity Search dialog, perform the following steps:

1. Perform an attribute-based or entity type-based search using the Entity Search
dialog.
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2. Select an entity or entities from the Entity Types list or the Attributes list of the
Entity Search dialog. To select more than one entity, press the Shift or Control key
while selecting.

The selected entity or entities appear highlighted in the workspace and in the
Navigation Panel.

If the selected entity is too small, a flash box appears indicating the location of the
highlighted entity in the workspace.

See Searching Using Entity Search.

5.6 Zooming to a Selected Entity
To zoom to a selected entity, perform the following steps:

1. If you selected an entity from the workspace or Navigation panel, right-click and
select Zoom Selected.

2. If you selected an entity from the Entity Search dialog, right-click and select Zoom
Selected.

AutoVue zooms to the selected entity in the workspace.

5.7 Filtering Entity Types
With the Entity Filter option, you can choose to display certain entity types while
hiding others. You can also limit the types of entities you can select in the workspace.

1. From the Manipulate menu, select Visibility Control, and then select Entity
Filter.

The Entity Filter dialog appears.

2. Under the Visibility column, perform one of the following:

■ Select the check box beside the entity types you want to display in the
workspace.

■ De-select the check box to hide the entity types.

3. Under the Selection column, perform one of the following:

■ Select the check box beside the entity types that you want to be able to select in
the workspace.

■ Deselect the check box beside the entity types that you do not want to select.

To select all entity types, select the column header check box. Deselect the column
header check box to de-select all entity types.

4. Click Apply to apply the changes.

5. Click OK to close the Entity Filter dialog.

Only the selected entity types remain displayed in the workspace.

When you click in the workspace, only the entity types checked in the Entity Filter
dialog will be highlighted.

5.8 Entity Properties
The Entity Properties dialog displays detailed information about any selected entity in
the current schematic drawing or PCB design. To view the Entity Properties dialog,
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first select an entity from the workspace and then from the Analysis menu select Show
Entity Properties.

You can also double-click an entity in the workspace, or
right-click an entity in the workspace, Navigation Panel, or Entity
Search dialog, and then select Show Entity Properties.

Figure 5–5 Entity Properties

On the left side of the Entity Properties dialog, a tree displays all the entities associated
with the entity you selected. The entity you selected is the root of the tree, and all the
associated entities (grouped by their type) are shown as its children.

The attributes of the entity display to the right of the tree, under Entity Info. In the
tree, select any associated entity to display its attributes under Entity Info.

You can also view entity attributes in the workspace. When you hover the mouse over
an entity in the workspace, a tooltip with commonly used entity information appears.
You can turn these tooltips off or on from the Configuration dialog.

See Configuring AutoVue for more information on the Configuration dialog.

5.8.1 Viewing the Properties of an Entity
The Entity Properties dialog displays detailed information about any selected entity in
the current schematic drawing or PCB design.

1. Select the entity in the workspace or from the Navigation Panel or Entity Search
dialog.

2. Right-click and select Show Entity Properties.

You can also double-click the entity in the workspace to view its entity
information.

The Entity Properties dialog displays the selected entity and its associated entity.

3. Select any associated entity in the tree to display its attributes.

4. To view all associated entities for any given entity in the tree, select the entity and
click Expand.

5. Click OK to close the Entity Properties dialog.

Note:
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5.8.1.1 Showing Net Connectivity
You can view the net connectivity of an entity such as a pin, via, or trace with the
Show Net Connectivity option.

Show Net Connectivity is disabled when more than one entity
is selected.

1. Select an entity such as a pin, via, or trace from the workspace or the Navigation
Panel.

The corresponding entity is highlighted in the workspace and in the Navigation
Panel.

2. From the View menu, select Show Net Connectivity.

From the workspace or Navigation Panel, you can also right-click the selected
entity, and then select Show Net Connectivity.

The graphical entities belonging to the connected nets are highlighted.

5.8.1.2 Displaying the Entity Properties of a Net
You can view the properties of a net via the Show Entity Properties option.

The Show Entity Properties is disabled when more than one
net entity is selected.

1. Select an entity such as a pin, via, or trace from the workspace or the Navigation
Panel.

The corresponding net is highlighted in the workspace and in the Navigation
Panel.

2. From the workspace or Navigation Panel, right-click the selected net, and then
select Show Entity Properties.

The Entity Properties dialog appears displaying the properties of the selected net.

3. Click OK to close the Entity Properties dialog.

5.8.1.3 Show Net Instances
You can display the instances of a net in a multi-page file.

1. From the Navigation Panel, click the Nets tab and select the net you want to view.

The net is highlighted in the Navigation Panel and in the workspace.

2. From the View menu, select Go to Net Instances, or right-click the highlighted net
from the Navigation Panel or workspace and select Go to Net Instances.

AutoVue highlights the instance or instances of the selected net. If the selected net
appears on multiple pages the Go to Net Instances dialog appears.

Note:

Note:
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Figure 5–6 Go to Net Instances dialog

3. Select the page on which you want to view the net instance, then click OK.

The selected page is displayed and the instance of the selected net is highlighted.

5.9 Navigating Design Hierarchy
AutoVue supports navigation through the hierarchical structure of a schematic
drawing. A hierarchical block in a schematic is a symbol that refers to a child
schematic.

5.9.1 Navigating using Ascend Hierarchy
With the Ascend Hierarchy option, you can navigate from the child schematic to the
parent page.

On the child page of your schematic’s design hierarchy, select an entity in the
workspace or in the Navigation panel and then from the View menu select Ascend
Hierarchy. AutoVue returns to the parent page.

You can also right-click an entity in the workspace or in the
Navigation panel and select Ascend Hierarchy .

If you select an entity that has multiple parents, the Ascend Hierarchy dialog appears
displaying the parent pages. Select the Parent page you want to go to, then click OK.
AutoVue returns to the selected parent page.

Figure 5–7 Ascend Hierarchy

5.9.2 Navigating using Descend Hierarchy
On the child page of your schematic’s design hierarchy, select an entity in the
workspace or in the Navigation panel and then from the View menu select Descend
Hierarchy. AutoVue opens the page with the selected child schematic.

Note:
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and then select Descend Hierarchy .
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5.10 Layers
When working with EDA files, AutoVue lets you view all the physical layers and
associated logical layers of the EDA drawing; you can view all layer sets for that file,
or create your own. Additionally, from the Layers option, you can manipulate certain
layer attributes, such as visibility, color, polarity, and ordering. To display the Layers
dialog, from the Manipulate menu, select Visibility Control, and then select Layers.
From the AutoVue toolbar, you can also click Layers .

For drawings that do not contain layers, the Layers menu
option and button are disabled.

The Layers dialog has a Physical Layers section and a Logical Layers section.

5.10.1 Physical and Logical Layers Sections
The Logical Layers section displays the layers in the order they display in the
workspace. The Physical Layers section displays the layers in the order they appear in
the layer stackup when manufactured.

The Physical Layers section displays a matrix with a mapping of physical layer names
to entity types. Each row in the matrix corresponds to a physical layer in the board.
Each column in the matrix lets you control the visibility of an entity type, such as pin,
via, or trace. The entity types that display depend on the entities available in the open
file. Select a physical layer to change its visibility, layer order, and color. Select or
de-select the entity type of a physical layer to affect its visibility separately from the
other entities of the layer.

When you select a physical layer from the Physical Layers section, the associated
logical layers are also selected in the Logical Layers section. You can also select
individual logical layers from the Logical Layers section, or press the Shift or Control
key to select multiple logical layers.

One physical layer can be selected at a time.

The Logical Layers section displays a list of logical layers and the layer attribute
options you can modify: visibility, order, color, and polarity.

To modify the attributes for both physical and logical layers, first select the layers you
want to modify, and then use the settings to make the changes you want.

When you select physical layers and modify settings from the Layers dialog, a
message displays at the bottom of the dialog to indicate your last action.

When you are satisfied with the changes, click Apply to make the changes in the
workspace. You can also create layer sets to save your modified layer settings to reuse
them later.

When you open a file, it displays all layer sets for that file. You can choose the layer set
you need, or create your own.

Note:

Note:

Note:
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5.10.2 Changing the Order of Layers
You can change the order in which layers display in the workspace. Specifically, you
can change the z-order of layers.

1. From the Manipulate menu, select Visibility Control, and then select Layers .

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. If the Logical Layers section is not open, click Expand .

3. Select the layer or layers that you want to move. To do so, you can do one of the
following:

■ Select a physical layer from the Physical Layers section. Logical layers
associated with the selected physical layer are also selected. When you make
changes to a selected physical layer, the logical layers associated with it are
also affected.

■ Select one or multiple logical layers from the Logical Layers section. To select
multiple logical layers, press the Shift or Control key while selecting.

4. Click one of the following buttons:

■ Click Bring to Front to move all selected layers to the front in the
workspace. In the Logical Layers section, these layers move to the top of the
list.

■ Click Up to move selected layers up one layer.

■ Click Down to move the selected layers down one layer.

You can also drag and drop selected logical layers in the Logical Layers section.

5. Click Apply to see the changes in the workspace.

The file now displays according to the layer scheme you arranged. Also, logical
layers are renumbered in the Order column of Logical Layers section.

6. You can now save your changes as a user-defined layer set.

7. Click Close to close the Layers dialog.

5.10.3 Modifying Visibility for Physical Layers
Use the Layers dialog to hide or display specific physical layers in the workspace.

1. From the Manipulate menu, select Visibility Control, and then select Layers.

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. In the Physical Layers section, you can show or hide the following:

Table 5–1 Options

Option Description

All physical layers Click the All column header.

One physical layer Select the check box to the left of the layer name. You can also

select a layer and click Visibility .

One entity type for all
physical layers

Click the column header. For example, click the Trace column
header to show or hide all trace entities of all physical layers.
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3. Click Apply to view the changes in the workspace.

4. You can now save your changes as a user-defined layer set.

5. Click Close to close the Layers dialog.

Check boxes for physical layers can have four states: checked, unchecked, gray
checked, and gray unchecked. Check boxes that are checked and gray indicate that
the entities of a physical layer are neither all visible nor all hidden. Gray
unchecked check boxes that you cannot select indicate that there is no entity of
that type for that layer.

5.10.4 Modifying Visibility for Logical Layers
Use the Layers dialog to hide or display specific logical layers in the workspace.

1. From the Manipulate menu, select Visibility Control, and then select Layers.

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. If the Logical Layers section is not open, click Expand .

3. In the Logical layers, you can show or hide the following:

Table 5–2 Options

4. Click Apply to view the changes in the workspace.

5. You can now save your changes as a user-defined layer set.

6. Click Close to close the Layers dialog.

5.10.5 Modifying Polarity
From the Logical Layers section of the Layers dialog, you can invert the polarity of the
selected layer (if polarity exists in the selected file).

1. Select the layer and then click the Polarity icon to toggle the polarity, or
select/de-select the check box in the Polarity column.

■ When positive polarity is selected, the layer appears as is.

■ When negative polarity is selected, the layer image is inverted; the entities in
the layer are displayed as transparent and the remainder of the layer appears
as a solid color.

One entity type for one
physical layer

Click a specific check box.

Option Description

One logical layer Select the check box in the Visibility column.

Multiple logical layers To select more than one layer, press the Shift or Control key

while selecting, and then click Visibility .

Table 5–1 (Cont.) Options

Option Description
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5.10.6 Changing Layer Color
You can modify the color of any physical or logical layer from the Layers dialog.

1. From the Manipulate menu, select Visibility Control, and then select Layers.

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. If necessary, click Expand to open the Logical Layers section.

Select the layer or layers for which you want to change the color. You can select a
physical layer from the Physical Layers section; logical layers associated with the
selected physical layer are also selected. You can also select individual logical
layers from the Logical Layers section, or press the Shift or Control key while
selecting to select multiple layers.

3. After you select a layer, you can do one of the following to modify its color:

■ Click Modify Color and then select a color from the palette. Use this
button if you want to change the color of all logical layers associated with a
selected physical layer, or to change the color of many selected logical layers at
the same time.

■ Double-click a square in the Color column of the Logical Layers section
and then select a color from the palette. Use this option to change the color of
individual logical layers.

The color of all selected layers changes in the Color column.

4. Click Apply to save the changes.

The display updates in the workspace based on the changes you made to the layer
color.

5. You can now save your changes as a user-defined layer set.

6. Click Close to close the Layers dialog.

5.10.7 Sorting Logical Layers
You can sort the list of Logical Layers section by name, visibility, color, or physical
layer.

1. From the Manipulate menu, select Visibility Control, and then select Layers.

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. If the Logical Layers section is not open, click Expand .

3. Click the column header of an attribute.

Layers are sorted according to the attribute header you click.

For example, if you click the Color column header, the logical layers in the section
are grouped according to their color.

To restore the original sort order, click the Order column
header.
Note:
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5.11 Layer Sets
A layer set is comprised of all the physical and logical layers in the drawing. Layer sets
differ in the attributes of the different layers; for example, z-order, visibility, and color.
You can also define your own layer sets to control which layers you can view and
print.

5.11.1 Viewing Layer Sets
AutoVue lists top, bottom, and default layer sets, as well as any layer set that is stored
in the file. You can choose to display any layer set you need. You can also create
user-defined layer sets and display them later. To view a layer set, take the following
steps:

1. From the Manipulate menu, select Visibility Control, and then select Layers .

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. From the Layer Sets list, select the layer set you want to display.

3. Click Apply.

The selected layer set displays in the workspace.

4. To restore the default layer set, from the Layer Sets list, select (Default).

5. Click Close to close the Layers dialog.

You can also view the layer sets from the Layers list beside the Layers button
on the AutoVue toolbar.

5.11.2 Creating User-Defined Layer Sets
You can define a layer set and save it for the duration of the session. The layer set you
defined is added to the Layer Sets list in the Layers dialog and to the Layers list on the
AutoVue toolbar. By default the Top, Bottom and Default layer sets and any other layer
sets belonging to the file are listed in the Layer Sets list.

1. From the Manipulate menu, select Visibility Control, and then select Layers .

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. Click Add. The Add Layer Set dialog appears.

3. Enter the layer set name.

4. Click OK. The new layer sets appear in the Layer Sets list.

5. To modify the attributes of the new layer set, select one or more layers and change
the Visibility, Order, or Color.

6. Click Apply to save the changes and to display the new layer set in the workspace.

7. To define more layers, repeat steps 2 to 6.

8. Click Close to close the Layers dialog.

The new layer set appears in the Layers list beside the Layers Control button on the
AutoVue toolbar.
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5.11.3 Deleting User-Defined Layer Sets
To delete a user-defined layer set, perform the following steps:

1. From the Manipulate menu, select Visibility Control, and then select Layers .

From the AutoVue toolbar, you can also click Layers .

The Layers dialog opens.

2. From the Layer Sets list, select the user-defined layer set you want to delete.

You can only delete user-defined layer sets.

3. Click Delete.

The layer settings of the deleted layer set remain displayed on the screen until you
select another layer set.

4. Click Apply to save the changes.

5. Click Close to close the Layers dialog.

5.11.4 Saving User-Defined Layers Sets with Markups
You can save user-defined layer sets using markup files.

1. Create custom layer sets.

2. From the Markup menu, select New.

From the AutoVue toolbar, you can also click Markup .

3. Create any markup entities that you need.

4. From the Markup menu, select Save As.

The Save Markup File As dialog appears.

5. Enter the markup information and click OK to close the Save Markup File As
dialog.

Enter the markup information and click OK to close the Save Markup File As
dialog.The Layer sets you created are saved with the Markup file. When you reopen
the file during a different session, you can view the Layer sets when you open the
Markup file.

See Markups.

5.12 Manipulating EDA Views
As with any 2D file, with the View options, you can instantly manipulate how the
current active file is displayed. For example, you can rotate a file’s orientation
clockwise or counter-clockwise by 90 degrees.

See 2D Viewing Options for more information on View options.

AutoVue provides several ways to change the view size of a selected area of a file,
display different views, layers and blocks of the current active file. You can also
navigate from one page to another page of a multi-page file.

5.13 3D View
For some ECAD formats, AutoVue supports 3D views of PCB boards.

1. In the Navigation Panel, click the Bookmarks tab.
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2. Select 3D Model from the navigation tree.

The 3D view of the PCB board is displayed in the workspace.

The 3D view can also be accessed from the View menu,
selecting Page, and then selecting Next Page .

5.14 Cross Probing
Cross probing is the ability to select elements in the schematic and have them mapped
to the corresponding components in the layout drawings and vice versa.

The following sections provide information on cross probing between two or more
EDA files, displaying the net connectivity when cross probing, and cross probing
between 2D and 3D views of the same file.

5.14.1 Initiate Cross Probing
In Agile, cross probing feature is initiated from either the business object Attachments
tab or the file folder Files tab rather than from the viewer menus.

Use cross probing to interrogate ECAD schematic and layout files in separate viewer
windows.

The Agile administrator must specify the ECAD file extension
in the Files Types list in Agile Administrator Viewer & Files node in
order for you to view the ECAD files.

You can select both needed files from the same Attachments tab or the same file folder
Files tab from which you launch the Cross Probe action. Or, you can select one file on
the current tab and then search for the remaining file from the attachments of any
other object.

From the View menu, select By Search, and then Cross Probe option allows you to find
other files in the system, which you may want to use to cross probe, without having to
select two files from the same Attachments tab or Files tab; that is, you can search and
select one attached file from Part 234 and another attached file from Part 765.

Alternatively, you can view a single ECAD file and then initiate cross probing within
the viewer by adding another file from your desktop.

AutoVue supports and enables correct viewing of ECAD files.

For example, when an .emp or .emn file is selected for viewing or
markup, AutoVue client displays these files just like MCAD files such
as .asm and .prt files.

The following sections describe how to initiate cross probing in AutoVue.

5.14.1.1 Viewing a File for Cross Probing
To view an appropriate file for cross probing:

1. Display the Attachments tab or the Files tab.

2. Select a file row you want to work with and then choose:

Note:

Note:

Note:
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■ Web Client: From the View menu, select View.

■ Java Client: View File (s)

AutoVue opens and displays the selected file.

3. From the Analysis menu, choose Cross Probe. The File Open dialog appears.

4. Use one of the following File Open dialog options to select a file to overlay:

Table 5–3 Overlay

Browsing Local Directories to Select File
You can browse your local directories to select an attachment file:

1. From the File Open dialog, click Browse.

2. Use the Look in drop-down list to select the directory you want.

3. Select the file you want and click Open.

4. Click OK in the File Open dialog. The Viewer opens the selected file, or, if
appropriate, adds the selected file to the current analysis function.

Using Agile Bookmarks to Select File
You can click Agile Browse to use your Agile Bookmarks to select an attachment file:

1. From the File Open dialog, click Agile Browse. The DMS: File Open dialog
displays your Agile Bookmarks in a tree structure.

If you have not defined any Bookmarks in Agile PLM, Agile
Browse does not appear in the File Open dialog.

2. Click the plus symbol to expand a bookmark and display its item revisions or its
file folder versions.

3. Click a revision or version row to highlight the file you want to view.

4. Click OK in the DMS: File Open dialog. The selected file name appears in the File
Name field of the File Open dialog.

5. Click OK in the File Open dialog. The Viewer opens the selected file, or, if
appropriate, adds the selected file to the current analysis function.

Using Agile Search to Select File
You can use Agile Search to perform a quick search to select an attachment file:

1. From the File Open dialog, click Agile Search. The Search dialog appears.

2. Define your search using the following options and then click Search.

Option Description

Browse Browse your local directories to select and open files from the AutoVue
window.

Agile Browse Use Agile bookmarks to open files from the AutoVue window.

Agile Search Perform an Agile Quick Search to select and open files from the AutoVue
window.

Note:
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3. In the Search Results table, click the plus symbol next to the object number to
expand the list of attachment files for that object.

4. Click a revision row or a version row to select the file you want to view.

5. Click Load File. The selected file name appears in the File Name field of the File
Open dialog.

6. Click OK in the File Open dialog. The Viewer opens the selected file, or, if
appropriate, adds the selected file to the current analysis function.

5.14.2 Cross Probing in Web Client and Java Client
To run cross probing:

1. Display the Attachments tab or the Files tab.

2. Select both file rows you want to work with and choose:

■ 9.2.2.x or 9.2.1.x Web Client: From View, select Cross Probe.

■ 9.3.x Web Client: View.

The file opens in AutoVue. Select Analysis and then Cross Probe.

■ Java Client: From View File(s), select Cross Probe.

Each file is displayed in a separate viewer window.

3. Begin cross probing. Use any of the following search methods:

Table 5–5 Search Methods

Option Description

Class Select an object class, for example, Items.

Search Parameter Enter a text string or a number.

Agile PLM searches the object ID number attribute and the
object Name or Description attribute. A Quick search behaves
like a Contains search for text strings. The search criteria is
treated as a single string and Agile PLM searches for names or
descriptions that contain the search parameter string. In the case
of ID numbers, Agile PLM searches for an exact match, however,
you may use wildcard characters to specify part of an ID
number as a search criteria.

Search Attachment
Content

Set this parameter to Yes to search the contents of the attachment
files as well.

Tab Description

Search Create a simple search or an advanced search. You can also check to search
attachment contents.

Saved Searches Opens to your navigation pane where you can browse in search folders,
select a search, and run it. Again, returned results may be moved to the
Selected Items table, and click OK.

Shortcuts Opens to your navigation pane where you can select objects from My
Bookmarks or Recently Visited. The system displays shortcuts to only those
objects that are appropriate to the operation you are performing.
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4. When the results of your search are returned, select a row in the Results table, and
the related files for that object appear in the Related Files table.

5. In the Related Files table, select and move attachments to the Selected Files table.

6. You can continue to run multiple searches or shortcuts until you are finished
selecting the attachments you want.

7. When you are finished, click OK.

Cross Probing by Search
To cross probing by search:

The files are displayed in a single viewer window, one on top of the other.

1. Display the Attachments tab or the Files tab.

2. Select both file rows you want to work with and choose:

■ 9.2.2.x or 9.2.1.x Web Client: From View, select Cross Probe.

■ 9.3.x Web Client: View.

The file opens in AutoVue. Select Analysis and then Cross Probe.

■ Java Client: From View File(s), select Cross Probe.

Each file is displayed in a separate viewer window.

3. Begin cross probing.

Cross Probing By Search
To run cross probing by search:

1. Display the Attachments tab or the Files tab.

2. Select both file rows you want to work with and choose:

■ 9.2.2.x or 9.2.1.x Web Client: From View, select View By, and then Cross
Probe.

■ Java Client: From View File(s), select By Search, and then Cross Probe.

The Select Files dialog appears, with three Search tabs.

3. The dialog allows you to search for any business object (for example, items or
manufacturer parts) and select the attachments of those objects to use to Cross
Probe. Use any of the following search options:

Note:

Table 5–6 Search Methods

Tab Description

Search Allows you create a simple search or an advanced search. You can also
search attachment contents.

Saved Searches Opens to your navigation pane where you can browse in search folders,
select a search, and run it. Again, returned results may be moved to the
Selected Items table, and click OK.
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4. When the results of your search are returned, select a row in the Results table, and
the related files for that object appear in the Related Files table.

5. In the Related Files table, select and move attachments to the Selected Files table.

6. You can continue to run multiple searches or shortcuts until you are finished
selecting the attachments you want.

7. When you are finished, click OK. Each file is displayed in a separate viewer
window.

8. Begin cross probing.

5.14.3 Cross Probe between Two or More EDA Files
The Cross Probe option lets you select entities in the schematic drawing or the PCB
design to highlight in all the open files.

1. Open an EDA file to cross probe.

2. From the Analysis menu, select Cross Probe.

From the AutoVue toolbar, you can also click Cross Probe .

The Cross Probe dialog appears.

3. Click Add File.

4. In the Open dialog that appears, enter the file name or browse to locate the file you
want to cross probe, then click Open.

To add multiple files to the Cross Probe dialog repeat steps 3 and 4. When adding
multiple files from the same directory, press Shift while making your selection.

5. Click OK.

Each file you select appears in a new window. A dialog appears for each new
window which lets you change the view or page for each file. Each dialog has the
Automatic option selected by default. When the Automatic option is selected for
each dialog, you see different behavior depending on the files you cross probe.

6. If you cross probe a schematic and PCB, one window automatically displays a 2D
PCB and the other window displays a schematic. The same is true if either file
contains a PCB and a schematic. Whereas, if files A and B contain both a schematic
and a PCB and they are cross probed, one of the files displays the schematic page
and the other displays the 2D PCB.

7. If you cross probe two PCBs, one window automatically displays a 2D PCB and
the other window displays a 3D PCB.

Shortcuts Opens to your navigation pane where you can select objects from My
Bookmarks or Recently Visited. The system displays shortcuts to only those
objects that are appropriate to the operation you are performing.

Note:

Table 5–6 (Cont.) Search Methods

Tab Description
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8. If you cross probe two schematics, both are set to schematic.

9. To change the view of a file in a window, do the following:

a. Deselect the Automatic option in the dialog for the window you want to
change.

b. From the Type list, select Schematic, PCB, or PCB 3D View. These options are
available in the Type list only when the views are present in the file.

The view of the file changes in the window.

10. To switch between multiple occurrences of a selected component, do the
following:

a. From the Navigation Panel, select a component in one file that has multiple
component occurrences in the other file.

b. From the dialog of the file with multiple component occurrences, select one of
the components from the Occurrences list or click Next or Previous to switch
between component occurrences.

Figure 5–8 Occurrences

11. Select any entity in the schematic drawing.

The same entity is highlighted in the PCB design.

5.14.4 Cross Probing Between 2D and 3D Views of the same file
The Cross Probe option lets you select entities to highlight in the 2D and 3D views of
the same file.

1. From the Analysis menu, select Cross Probe.

From the AutoVue toolbar, you can also click Cross Probe .

The Cross Probe dialog appears.

2. Click Add File.

3. In the Open dialog that appears, select the same file, then click Open.

4. In the Cross Probe dialog, click OK.

The file appears in a new AutoVue window. The views that display in each
window depend on the contents of file you are cross probing.

5. If the file does not contain a schematic, one window shows the 2-dimensional view
of the PCB and the other shows the 3-dimensional view of the PCB.

6. If the file contains a schematic as well as a PCB, the schematic view displays in one
window and the 2D PCB view displays in the other window. In this case, take the
following steps to see the 2D and 3D views of the PCB:

a. In the window’s dialog, de-select the Automatic option.
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b. Select a different view from the Type list. For example, you can switch
between Schematic and PCB 3D View.

7. Select an entity in the 3D view.

The same entity is highlighted in the 2D view of this file.

You can select entities in the 2D view or 3D view of the file.
The selected entities are highlighted in both open views of this file.

5.14.5 Showing the Net Connectivity when Cross Probing
To display the net connectivity of the design when cross probing, perform the
following steps:

1. Select an entity or entities in any open file.

2. Right-click and select Show Net Connectivity.

The net connectivity for the entity or entities that you selected are highlighted in all the
files.

5.14.6 Zooming when Cross Probing
When you are cross probing files, you can zoom in on the entities you select.

Zoom in on a selected entity or entities:

■ When cross probing between a schematic drawing and a PCB design.

■ When cross probing between the 2D and 3D views of the same file.

1. Select an entity or entities in either one of the open files or views.

If you are cross probing between a schematic drawing or a PCB design, you can
select entities in either file. You can also select entities in any open view when
cross probing the 2D view and 3D view of the same file.

2. Right-click and select Zoom Selected.

AutoVue zooms to the same entities in all the open file or views.

See Also Configuring Zoom Behavior when Cross Probing for more information.

5.15 Comparing a PCB with Artwork
You can visually compare PCB designs with artwork. In Compare mode for EDA files,
EDA options such as Select Entity, Entity Search dialog and Entity Filter are available.

The Compare feature performs a graphical comparison not a
geometrical comparison.

1. Open the PCB file that you want to compare with the artwork.

2. From the Analysis menu, select Compare.

The Open dialog appears.

3. Enter the file name or browse to locate the artwork file you want to compare with
the PCB file.

Note:

Note:
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4. Click Open.

The PCB-Artwork Comparison dialog appears.

5. From the box, select the PCB Physical layer that represents the artwork.

For example, Top or Bottom.

6. Click OK.

AutoVue displays three windows, the first displaying the original PCB drawing,
the second displaying the Artwork drawing, and the third the Comparison Result
window.

7. To exit Compare mode, from the File menu, select Exit Compare.

From the AutoVue toolbar, you can also click Exit Compare .

The original file appears in the AutoVue workspace.

5.16 Generating Bill of Material
For EDA files, you can obtain a list of the components and parts required for
manufacturing the item featured in the schematic drawing or PCB design.

The Bill of Material (BOM) report produces a count of the unique components or parts
needed for manufacturing. It lists the quantity required, component name, reference
designators, value (for resistors and capacitors), size, and descriptions. When
determining the uniqueness of a component, the count considers only the attributes
chosen for inclusion in the report output. It includes only those attributes that provide
the most accurate and unique component quantities.

1. From the Analysis menu, select Generate Bill of Material.

If you are generating a BOM for a schematic with multiple pages, a dialog appears
prompting you to select the BOM scope: Current page or Entire design.

Figure 5–9 Generate BOM

2. Click OK after making your selection.

The Generating BOM dialog appears listing the attributes of the file.

3. Select the attributes that you want to appear in the report.
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Figure 5–10 Generating BOM

4. Click Generate.

To sort a column by alphanumerical or alphabetical order, click on the column
heading.

The Bill of Material dialog appears listing the count for each component or part
possessing the attributes you selected. There are also columns displaying the
values of the attributes you selected.

5. To save the BOM, click Export.

6. Specify the directory where you want to store the file, the file name and extension,
then click Save.

You can specify either .pdx (Product Data Exchange) or .csv (Comma Separated
Values) for the extension.

AutoVue automatically saves the results in a file with the specified extension.

7. Click Close to the Bill of Material dialog.

5.17 Design Verification
Design verifications are operations that check the electrical design of a PCB against a
set of rules defining physical and electrical design constraints. Performing these checks
prevent short circuits and process errors. The types of design rules are as follows:

Table 5–7 Design Rules

5.17.1 Design Rule Checks
For design rule checks that have values, you can set the global unit of measurement.
The available design rule checks are:

Design Rule Type Description

Clearances The minimum spacing (air gaps) allowed between two sets of
entities in the design. These sets can belong to the same type of
entity or to different types.

Electrical Targets certain properties of the nets.

Manufacturing Targets the physical properties of a particular entity.
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Table 5–8 Rule Checks

Type Number Design Rule Check Description

Clearance 1 Minimum Clearance
(Pad > Pad)

Specify the minimum distance
between the pad outline and the
outline of its drill hole on all physical
layers.

Note: The two outlines (geometries)
are part of the pin (pad) entity but on
different logical layers.

2 Minimum Clearance
(Pad > Trace)

Specify the minimum pad to trace
clearance and pads on the same
physical layer.

Note: Only the pad outline is
considered. Does not take into account
traces connected to a pin (pad) on the
same net.

3 Minimum Clearance
(Trace > Trace)

Specify the minimum trace to trace
clearance on the same physical layer.

Note: Does not take into account
directly connected traces.

4 Minimum Clearance
(Component >
Component)

Specify the minimum component to
component clearance on the same
physical layer (component top side or
component bottom side).

Note: Only the logical layer that
defines the actual outline of the
component is considered.

A component entity is usually made
up of geometries on different logical
layers (silkscreen, keepout, and so on.),
but only the logical layer that defines
the actual outline of the component is
considered.

Manufacturing 5 Minimum Annular
Ring

Specify the minimum distance
between the pad outline and the
outline of its drill hole on all physical
layers.

Note: The two outlines (geometries)
are part of the pin (pad) entity but on
different logical layers.

6 Minimum Pad
Diameter

Specify the minimum diameter of a
pad.

Note: Only applicable to rounded
pads.

8 Acute Angle (in
degrees)

Specify the minimum acute angle
between connected traces on the same
physical layer.

Note: Only two traces belonging to the
same net are considered.

9 Minimum Drill Hole
Size

Specify the minimum diameter of the
drill hole size allowed.

Note: Only applicable to rounded
pads.
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5.17.2 Verifying a Design
The following steps describe how to verify a design:

1. From the Analysis menu, select Verify Design. The Verify Design dialog appears.

2. To enable a design rule, select the associated check box in the Design Rules
section.

3. To disable a design rule, deselect the check box. You can sort the design rules by
clicking the column headings for Enabled, Description, or Value.

10 Maximum Drill Hole
Size

Specify the maximum diameter of the
drill hole size allowed.

Note: Only applicable to rounded
pads.

Electrical 7 Maximum Via Count Specify the maximum via count
allowed for a net.

11 Minimum Route
Width

Specify the minimum route (trace)
width allowed in the design.

12 Maximum Route
Width

Specify the maximum route (trace)
width allowed in the design.

13 Minimum Route
Length

Specify the minimum route (trace)
length allowed in the design.

14 Maximum Route
Length

Specify the maximum route (trace)
length allowed in the design.

15 Empty Nets Select this check box if you want to
check for any nets that are not
connected to any pin, via, trace and
power/ground plane.

16 Un-routed Traces Select this check box if you want to
check for any trace segment that is not
connected to another trace segment,
pin, via on either end.

17 Single Connection Select this check box if you want to
check for a net connected to only one
pin.

Note: Power and ground nets are the
exception.

18 Short Circuit Select this check box if you want to
check for intersections (on the same
layer) of traces that belong to different
nets.

Note: Trace entities will be divided
into n sets where n is the number of
nets in the design.

19 Unconnected Pin Select this check box if you want to
check for any pin (pad) that is not
graphically intersected with any traces
on the same physical layer.

Table 5–8 (Cont.) Rule Checks

Type Number Design Rule Check Description



Searching Using Entity Search

5-26 Oracle AutoVue User Manual

4. To add a value to the selected design rule, double-click the corresponding row of
the Value column and enter a value. The selected design rule must be enabled to
be able to add a value.

5. In the Maximum Violations field, enter the maximum number of results you want
to display in the Results list.

6. From the Distance Units list, select the unit you want to use as the unit of measure.

7. Click Verify. The Verify button changes to Stop. To stop the Design Verification
process at any point, click Stop.

When the process is complete, the total number of errors found during the Design
Verification process, up to the maximum number specified in the Maximum
Violations field appear in the Results list.

8. To view the description of a violation result, select the violation from the Results
list. The description appears in the Description field. The description includes
information such as the type of violation, the location where it occurs (x- and
y-coordinates), the component or entity it affects, and the actual value measured.

When you select a violation result, AutoVue zooms to the entity or set of entities
that were affected and highlights them on the drawing.

9. Continue to select violation results to view its description. Click Reset to restart a
new check.

10. Click Close to close the Verify Design dialog.

5.17.2.1 Exporting the Design Verification Results
You can export the design verification results into a text file.

1. Verify the design.

2. In the Verify Design dialog, click Export. The Export Results dialog appears.

3. Navigate and select the directory where you want to export the results.

4. Enter a file name.

5. Click Save. AutoVue saves the design verification results in a .txt (text) or a .csv
(Comma Separated Values) file listing each violation result and its description.

6. Click Close to close the Verify Design dialog.

5.18 Searching Using Entity Search
You can search for an entity in a schematic drawing or a PCB design using the Entity
Search option. To filter entities, apply attribute, or entity type filters as search criteria.
You can select entities from the results list to highlight them in the workspace and the
Navigation Panel. You can also export the search results to a .csv file.

If the selected entity is small, a flash box appears indicating
the location of the highlighted entity in the workspace.

To open the Entity Search dialog, from the Edit menu, select Entity Search. From the
AutoVue toolbar, you can also click Entity Search . If your schematic has multiple
pages, a Defining Scope dialog appears.

Note:
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Figure 5–11 Defining Scope

Select Current Schematic Page to browse through only one page. Select Entire
Schematic Design to browse through all schematic pages.

Click OK after making your selection. The Entity Search dialog appears.

Figure 5–12 Entity Search

5.18.1 Performing an Entity Type-based Search
The following steps describe how to perform an entity type-based search.

1. From the Edit menu, select Entity Search.

From the AutoVue toolbar, you can also click Entity Search .

The Entity Search dialog appears.

2. Click the Entity Types tab.

3. From the Entity Types list, select an entity type.

To sort the list by attribute, click the attribute column heading that you want to
sort by.

A list of attributes for the selected entity type appear.

4. If you want to search by attribute, select an attribute from the Attribute list.

5. If you want to search by value, select a value from the Value list.

6. Click Add Filter. The selected attribute and its corresponding value appear in the
list.

7. Repeat steps 4 and 5 until you have all the filters you want.

8. Click Apply Filter(s).

To remove a filter, select the line in the list containing the attribute and value you
do not want to use as a filter, then click Remove Filter.
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A list of entities matching the search criteria appear showing the column headers
for the entity’s available attributes.

9. To save the results, click Export Result. The Save dialog appears.

10. Specify the file name and the directory where you want to store the file, then click
Save. AutoVue saves the results in a .csv (Comma Separated Values) file.

11. To view the properties of an entity, select the entity from the Entity Types list or
the Attributes list, then right-click and select Show Entity Properties.

The Entities Properties dialog appears and displays the properties for the selected
entity.

12. To show the net connectivity, click the Attributes tab, select the entity from the list,
then right-click and select Show Net Connectivity.

The net connectivity for the selected entity is highlighted in the workspace.

13. Click Close to close the Entity Search dialog.

5.18.2 Performing an Attribute-based Search
The following steps describe how to perform an attribute-based search.

1. From the Edit menu, select Entity Search. The Entity Search dialog appears.

2. Click the Attributes tab.

3. From the Attributes list, select an attribute. To sort the list by Owner, Type, or
Value, click the column heading that you want to sort by.

The Owner, Type, and Value of the selected attribute appear in the list.

4. If you want to search by owner, select an owner from the Owner Filter list.

5. If you want to search by value, select a value from the Value Filter list. You can
also enter an Owner Filter or Value Filter in the text box.

6. Click Apply Filter(s). Select an item in the result list and right-click to access
options like Zoom Selected and Show Entity Properties.

A list of entities matching the search criteria appear displaying the Owner, Type,
and Value columns.

7. To save the results, click Export Result. The Save As dialog appears.

8. Specify the file name and the directory where you want to store the file, then click
Save.

AutoVue saves the results in a .csv (Comma Separated Values) file.

9. Click Close to close the Entity Search dialog.

5.19 Measuring in EDA Files
In EDA files, you can take measurements of distances, areas, arcs, and angles. When
measuring, you have the option to “snap” to geometrical or electrical points on the
drawing.

From the Analysis menu, select Measure to access the Measurement options.

The measure options are as follows:
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5.19.1 EDA Snapping Modes
The snapping modes allow you to click to precise geometrical points on a drawing. For
example, when you select Snap to Pin, move the cursor over the pin you want to select
until the pin is highlighted, then click. Highlight and click a second pin to measure the
distance between them.

The snapping modes allow you to snap to the mid, center, and end-points of an entity
as well as a pin, via, and symbol. The following table outlines the available snapping
modes:

Table 5–10 Snapping Modes

Name Description

Angle Measure the angle between selected points.

Arc Measure an arc-entity

Area Measure a selected area.

Distance Measure the distance between two points.

Minimum
Distance

Measure the minimum distance between two nets.

Note: When measuring Minimum Distance, the finite edge is
selected.

Button Snap to Description

End-point Geometric snap mode where a snap box appears when moving
the cursor near a linear component’s end point.

Mid-point Geometric snap mode where a snap box appears when moving
the cursor near the halfway point of a linear component.

Center-point Geometric snap mode where a snap box appears when moving
the cursor near the center of an elliptical component.

Pin Electrical snap mode where a snap box appears when the cursor
touches a pin.

Via Electrical snap mode where a snap box appears when the cursor
touches a via.

Symbol
origin

Electrical snap mode where a snap box appears when the cursor
touches a component.

Free Snap Allow snapping at any point on the drawing.

Net Allows snapping to net.

Trace Allows snapping to a trace.
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5.19.2 Measuring Distance
Use the Distance option to measure the distance between two specific points.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Distance tab.

3. Select the snapping modes that you want to use for measuring.

■ To select all snapping modes, click All On.

■ To deselect all snapping modes, click All Off.

See EDA Snapping Modes.

4. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

If you want to measure the distance along a path, select the Cumulative check box.

5. Click a point on the drawing to define the starting point.

6. Click another point on the drawing to define the end point.

If you selected Cumulative, continue clicking points along the path that you want
to measure.

7. Right-click to complete the measurement.

Click Reset to take another measurement.

The points are joined by a line. The Measured Distance, Delta-X, and Delta-Y
appear in the Measurement dialog.

8. Click Close to close the Measurement dialog.

5.19.3 Calibrating Distance
Calibrate the distance measurement.

1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.

The Distance Calibration dialog appears displaying the measured distance.

3. From the Units list, select the unit to which you want to calibrate the distance.

4. Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.

The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

5.19.4 Measuring Minimum Distance
Use the Minimum Distance option to measure the minimum distance between two
nets.
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1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Min. Distance tab.

3. To measure the minimum distance between entities that are not on the same
physical layer, select Across Layers. If a physical layer does not exist, this option
determines whether or not the minimum distance should be calculated across
logical layers.

4. Select First Set to select the entities that you want to measure from.

5. Select the snapping modes that you want to select as the entities for the
measurement.

6. Click the first set of entities in the drawing. To clear the last set of entities you
selected, click Clear Set. The entities are highlighted.

7. Select Second Set to select the entities that you want to measure to.

8. Click the second set of entities on the drawing. The entities are highlighted in a
different color.

9. From the Measured Min. Distance Units list, select the unit in which you want to
measure the distance.

10. Select Zoom to Result, if you want to zoom into the measurement on the drawing.

11. Click Compute. AutoVue does not measure the distance between layers
(z-dimension). The minimum distance from the first set of entities to the second set
is represented by a line. The minimum measured distance, Delta X, Delta Y, and
the Manhattan Distance appear in the Measure Min Distance section of the dialog.

12. Click Close to close the Measurement dialog.

5.19.5 Measuring Area
Use the Area option to measure the area and perimeter of a region.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Area tab.

3. Select Between Points if you want to measure the area between points on a
drawing. The snapping modes are displayed.

4. Select the snapping modes that you want to use for measuring.

5. Select Shape if you want to measure the area of a predefined shape on the
drawing; the snapping modes are disabled.

6. From the Measured Area Units list, select the unit in which you want to measure
the area.

7. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

8. In the Net Area Result section of the dialog, select Add to cumulate a net area
result of different areas.
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9. To subtract an area from the Net Area Result, click Subtract.

10. Select Clear to clear the Net Area Result.

11. If you selected Between Points, click points on the drawing to define the area.

Each point is joined by a line. The area and perimeter measurements appear in the
Measurement dialog.

12. If you selected Shape, click the edge of the predefined shape that you want to
measure.

Click Reset to take another measurement.

The shape is highlighted and the area and perimeter measurements appear in the
Measurement dialog.

13. Click Close to close the Measurement dialog.

5.19.6 Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Angle tab.

3. From the Angle Definition section, select one of the following:

■ From 3 Points: Measure the angle between three points.

■ Between 2 Lines: Measure the angle between two non-parallel lines.

4. Select the snapping modes that you want to use for measuring.

5. To select all snapping modes click All On, to deselect all snapping modes click All
Off.

See EDA Snapping Modes for more information.

6. Select Between 2 lines if you want to measure the angle between two lines.

7. From the Measured Angle Units list, select the unit.

8. If you selected From 3 Points, click three points to define the angle.

9. If you selected Between 2 Lines, click two lines to define the angle.

Click Reset to take another measurement.

Angle arms appear with an arc connecting them. The angle measurement appears
in the Measurement dialog.

10. Click Close to close the Measurement dialog.

5.19.7 Measuring an Arc
Use the Arc option to define an arc in the drawing and measure its radius, center, arc
length, start and end of angle, sweep, and diameter.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can click Measure .

The Measurement dialog appears displaying the measurement options.
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2. Click the Arc tab.

3. Select From 3 Points if you want to measure the arc between three points.
Snapping modes are displayed.

4. Click the snapping modes that you want to select as the points for the
measurement.

To select all snapping modes click All On. To clear all snapping modes click All
Off. See EDA Snapping Modes for more information.

5. Select Arc Entity if you want to measure a predefined arc.

6. From the Arc Information section, select the unit in which you want to measure
the distance of the arc.

7. From the Measure Angle Units list, select the unit in which you want to measure
the angle.

8. If you selected From 3 Points, click three points to define the arc.

The points are joined by an arc. The measurements for center point coordinates,
radius, diameter, arc length, start and end of angle and sweep appear in the
Measurement dialog.

9. If you selected Arc Entity, click the edge of the arc that you want to measure.

To take another measurement click Reset.

The arc is highlighted. The measurements for center point coordinates, radius,
diameter, arc length, start and end of angle and sweep appear in the Measurement
dialog.

10. Click Close to close the Measurement dialog.

5.19.8 Calibrating an Arc
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.

The Radius Calibration dialog appears displaying the measured distance.

3. From the Units list, select a unit of measurement to which you want to calibrate
the distance.

4. Click Calibrate to and enter a value if you want to calibrate to a value.

5. Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.

The calibration results appear in the Arc tab.

7. Click Close to close the Measurement dialog.
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6Working with 3D Files

From AutoVue’s 3D mode, you have many ways in which to manipulate the model.
For example, you can select model parts to transform independently from the rest of
the model, as well as modify the selected model part’s visibility and attributes. The 3D
mode also gives you the ability to perform an entity search and compute mass
properties, and it allows you to import 3D models into the current window and export
files to other formats. Additionally, the Global Axes inform you of where the X, Y and
Z axes are positioned throughout all the operations you perform in AutoVue.

The Perspective option shows objects in three dimension with distances, planes and
curved surfaces adjusted to give a sense of depth. You have lighting options where
you can adjust the overall lighting surrounding a model or just its source light.

You can also customize operations to suit your needs. For example, you can create and
save your own views. Define cross sections and cut-through of 3D models.

There are also features like Bill of Material (BOM), and Product and Manufacturing
Information (PMI) Filtering.

6.1 Understanding 3D Basics

The section only applies to AutoVue for Agile PLM.

The 3D CAD assemblies are made up of many files dependent on each other. The 3D
files are used primarily in manufacturing departments for designing purposes. The 3D
files may be added to the Files tab in one or multiple file folder objects:

■ One file folder

All files in one CAD assembly are added to the Files tab of one file folder. When
you view the assembly, Agile prompts you to identify the top file in the assembly
and the complete assembly is displayed in AutoVue.

■ One Design

Assembly Files are added to the Files tab and parts files can be referenced from the
Design added to the Structure tab.

■ Multiple File Folders

The assembly file is added to the Files tab in one file folder object, and parts files
can be referenced

by adding other file folder objects containing the files as relationships with no
rules to the Relationships tab of the assembly's file folder object.

Note:
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3D files can be redlined both through a change order (Redline Attachments) and on
the Files tab of the file folder object.

6.1.1 Viewing 3D CAD Assemblies in Multiple-file File Folder from the 9.3x Web Client
To view a CAD assembly from Web Client, Attachments tab:

1. Go to the Attachments tab of the business object that references the assembly.

2. Click the multiple-file attachment row that references the CAD assembly. A
multiple-file attachment row is indicated by a file folder icon in the Filename field,
followed by the filenames of all the files in the file folder.

3. Alternately, from the Attachments tab, do the following: On the business object
Attachments tab, click to select the multiple-file attachment row. Click the View
button's drop-down arrow and then select View.

To view a CAD assembly from Web Client, Files tab:

1. Go to the Files tab of a file folder object containing the CAD files for the assembly
that you want to view.

2. Click to select the row for the top or starting file of the assembly.

3. Click the View button's drop-down arrow and then select View.

6.1.2 Viewing 3D CAD Assemblies in a Multiple-file File Folder from Java Client
To view a CAD assembly from Java Client, Attachments tab:

1. Go to the Attachment tab of the business object that references the assembly.

2. Double-click the multiple-file attachment row that references the CAD assembly. A
multiple-file attachment row is indicated by a file folder icon in the Filename field,
followed by the filenames of all the files in the file folder. The Select Files window
appears.

3. Alternately, from the Attachment tab View File(s) button: On the business object
Attachments tab, click to select the multiple-file attachment row. Click the View
File(s) button's drop-down arrow and then select View.

4. In the Select Files window, click the radio button to select the option View all files
as an assembly, starting from the selected file.

5. Click to select the file row of the assembly file that indicates the top or starting file
of the assembly.

6. Click OK.

To view a CAD assembly from Java Client, Files tab:

1. Go to the Files tab of a file folder object containing the CAD files for the assembly
that you want to view.

2. Click to select the row for the top or starting file of the assembly.

3. Click the View File(s) button's drop-down arrow and then select View.

6.2 Models Tab and Model Tree
The Models tab displays the Model Tree. The tree displays the model’s hierarchy,
inter-relation of different parts, assemblies, and bodies. The tree also indicates if a
required external reference (XRef) is missing. With the tree, you can select different
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parts and modify their attributes such as color, visibility, render mode or
transformation.

See Displaying XREFs for more information on XRefs.

The Models tab displays only for 3D drawings.

Figure 6–1 Models Tab

6.3 Views Tab
The Views tab lists the defaults, standard, native, and user-defined views. You can
switch to a standard, native, or user-defined view, as well as add or delete
user-defined views.

The Views tab displays only for 3D drawings.

Figure 6–2 Views Tab

6.4 Bookmarks Tab
The Bookmarks tab lists links to specific views (Draft views, 2D plans, 3D Views of an
EDA design) or pages or bookmarks structure that is saved in files such as PDF.

Figure 6–3 Bookmarks Tab

Note:

Note:
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Navigate between the pages or files or views by clicking the appropriate link.
Bookmarks lead to various views of CAD files such as AutoCAD file Model Space, the
3D model of a file and associated 2D engineering drafts.

If a plus sign appears to the left of a bookmark, click it to expand and view the lower
bookmark levels. If a minus sign appears to the left of the bookmark, click it to
collapse the lower bookmark levels.

To go to a destination specified by a bookmark, click the bookmark text or the page
icon located to the left of the bookmark text.

6.5 Global Axes
By default, there is a three-axis representation in the lower left corner of the
workspace. The X-axis is red, the Y-axis is green and the Z-axis is blue. When
transforming a model or defining a viewpoint, all operations are applied with respect
to these axes.

6.6 Selecting Model Parts
You can select model parts from the Model Tree or from the workspace to highlight
them in the Model Tree and on the model. You can also select a model part and have
all its identical parts appear highlighted on the model and in the Model Tree.

You can also configure the Selection Highlight.

6.6.1 Select Model Parts from the Workspace
1. Select a part or parts on the model in the workspace. To select more than one

model part, press the Shift or Control key while selecting.

2. To select the parent entities of a selected part, press the Shift key and select the
part again.

A pop-up appears listing the parent entities of the selected part. Select an entity
from the pop-up list. The selected part or parts appear highlighted on the model
and in the Model Tree.

3. To select a group of parts, from the Edit menu, select Select, then click and drag
the mouse around the parts.

The entities within the box are selected and highlighted in the Model Tree. If the
selected entity is hidden in the Model Tree, the Model Tree expands to display the
selected entity.

6.6.2 Selecting All Identical Parts of a Model
Select a model part in the workspace or from the Model Tree.

Right-click and select Select Identical Parts.

All identical parts are highlighted on the model and in the Model Tree. If there are no
identical parts found, a message appears indicating “No identical parts found”. You
can also select sub-assemblies and Select Identical Parts to display all identical
sub-assemblies.
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6.7 Re-Centering
The Re-Center option repositions the model back to the center of the View window.
You can use a model part as a central reference point to reposition a model. You can
select several model parts to use as one collective central reference point.

6.7.1 Re-Centering a Model to a Selected Model Part
1. Select the model part or parts that you want to re-center.

2. From the View menu, select Re-Center, and then select Selected.

The model is repositioned using the selected model part or parts as the central
reference point. The Selected option is only available when one or more model parts
are selected.

6.7.2 Re-Center All
The Re-Center All option repositions the entire model back to the center of the
AutoVue workspace.

1. From the View menu, select Re-Center, and then Select All. The model is
repositioned to the center of the workspace.

6.7.3 Entity Reference
You can use an entity as a central reference point to reposition a model. The entities are
as follows:

Table 6–1 Entities

6.7.4 Re-Centering a Model to an Entity
To re-center a model to an entity, perform the following:

1. From the View menu, select Re-Center, and then select Entity. The Re-Center
dialog appears.

2. Select the entity that you want to use as the central reference point. All instances of
the entity are highlighted.

Entity Description

Vertex All vertices are highlighted. Select a vertex to use as the central reference
point.

A snap box appears when moving the mouse over a vertex.

Edge All edges are highlighted. Select an edge to use as the central reference
point.

A snap box appears when moving the mouse over an edge.

Midedge Highlight all edges in the model. Select a mid-edge to use as the central
reference point.

Arc Center Highlight all arcs and ellipses in the model. Select an arc center to use as the
central reference point.

A snap box appears when moving the mouse over an arc or ellipses,
indicating the center of the arc.

Face Select a face to use as the central reference point.

When moving the cursor along a model face, the face is highlighted.
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3. Click an instance of the entity. The model is repositioned using the selected entity
as the central reference point.

4. Close the Re-Center dialog.

6.8 Model Tree
The Model Tree displays the model’s hierarchy, inter-relation of different parts,
assemblies, bodies, and missing XRef notifications. With the tree, you can select
different parts and modify their attributes such as color, visibility, render mode or
transformation.

6.8.1 Expanding/Collapsing a Model Tree
You can expand the Model Tree to display child entities of a selected node or nodes.

You can also configure the level you want to expand the Model Tree.

1. Click the Models tab.

2. From the Model Tree, select the node or nodes that you want to expand, then
right-click and select Expand All Children. To select more than one node, press
the Shift or Control key while selecting.

The selected entities are highlighted. The Model Tree expands displaying the child
entities of the selected nodes.

3. To collapse a node, select the node, then right-click and select Collapse All
Children.

The Model Tree collapses the selected node.

6.8.2 Viewing Missing XRef Notification Icon
If the loaded drawing is missing XRefs, the Missing XRef Notification icon appears
in the Model Tree to the left of the missing XRef. To view XRefs that are missing, do
the following:

See also Displaying Details About Resources.

1. From the Status bar, click the Missing Resources icon .

The Properties dialog appears. You can also view the missing XRef from the File
menu, and then selecting Properties.

2. Click the Resource Information tab.

Any missing XRefs appear in the External Reference File Reference File Resources
section of the dialog.

3. Click OK to close the dialog.

6.8.3 Selecting Model Parts from Model Tree
1. Click the Models tab.

2. Select the part or parts from the Model tree. To select more than one model part,
press the Shift or Control key while selecting.

The selected part or parts appear highlighted on the model and in the Model Tree.
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6.8.4 Hiding Model Parts
You can hide specific parts of a model or display specific parts and hide the rest of the
model.

1. Select the part or parts on the model or from the Model Tree. To select more than
one model part, press the Shift or Control key while selecting.

The selected part or parts appear highlighted on the model and in the Model Tree.

2. To hide the selected part or parts, right-click a selected part on the model or from
the Model Tree and select Hide Part.

The selected part or parts are hidden on the model.

3. To display the selected part or parts and hide the rest of the model, right-click a
selected part on the model or from the Model Tree and select Hide Rest.

The selected parts are displayed in the workspace and the rest of the model is
hidden.

6.9 Manipulating Display of a 3D Model
AutoVue provides the flexibility to manipulate the display of a 3D model. You can
rotate, scale, or translate a model or any selection of model parts. You can also
navigate from one page to another page of a multi-page file.

You can access these options from the View menu. The options are:

Table 6–2 Options in View Menu

Menu Sub-Menu Description

Zoom Zoom Box Click and drag to draw a box around an object that
you want to enlarge to fill the window.

From the Autovue toolbar, you can click the icon
or right-click in work-space and select from the
menu.

Zoom In Zoom in by a factor of 2.

From the AutoVue toolbar, you can click the .

Zoom Out Zoom out by a factor of 2.

From the AutoVue toolbar, you can click the

Previous Reverts to the previous zoom level.

From the Autovue toolbar, you can also click or
right-click in workspace and then select from the
menu.

Selected Resize the object so that the objects selected fill the
window.

Dynamic Zoom Click and drag the cursor up to zoom in or down to
zoom out.

From the Autovue toolbar, you can also click .
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Zoom Fit Resize object to fit window.

From the Autovue toolbar, you can also click or
right-click the workspace and select from the menu.

Pan Click and drag to reposition the model, then release
the mouse button.

From the Autovue toolbar, you can also click or
right-click in the workspace and then select from the
menu.

Rotate Click and drag to rotate the model on all three axes,
then release the mouse button.

From the AutoVue toolbar, you can also click or
right-click in the workspace and then select from the
menu.

Spin Click and drag the object in the direction you want
the object to spin continuously, then release the
mouse button. To stop the object from spinning, click
once anywhere in the workspace.

The spin velocity is determined by the speed at
which you drag the mouse.

From the AutoVue toolbar, click .

Re-Center All Reposition the entire model back to the center of the
AutoVue workspace.

See Re-Centering

Selected Only available when one or more model parts are
selected. The selected part or parts are considered as
the central reference point by which the model is
repositioned.

See Re-Centering

Entity Select a model part or entity as a central reference
point to reposition a model.

See Re-Centering

Default View Displays view of the model when it is initially
loaded. You can also right-click in the workspace and
then select from the menu.

See 3D Views

Camera View Displays different views of 3D models: Isometric,
Top, Bottom, Front, Back, Left, Right, and View
Points.

You can also right-click in the workspace and then
select from the menu.

See 3D Views

Views Access native views of the model or access and
create your own views.

You can also right-click in the workspace and then
select from the menu.

See 3D Views

Table 6–2 (Cont.) Options in View Menu

Menu Sub-Menu Description
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6.10 Display Attributes
AutoVue provides several different render methods to display a 3D CAD model. You
can also adjust the degree of transparency, change color, or visibility to suit your
preferences.

6.10.1 Render Modes
The choice of render mode varies between the level of detail and the render speed of
the model. For example, a shaded model is three-dimensional and highly detailed but
requires more time to render. The different render modes are as follows:

Table 6–3 Render Modes

6.10.1.1 Changing the Render Mode
To change the render mode of the selected model or model parts, perform the
following:

1. From the Manipulate menu, select Visual Effects, and then select Rendering.

From the AutoVue toolbar, you can also click Render Mode .

The Render mode options are listed.

Page Next Page Go to the next page of the multi-page file.

From the AutoVue toolbar, you can also click

Previous Page Go to the previous page of the multi-page file.

From the AutoVue toolbar, you can also click

Page Number Go to the specified page of the multi-page file.

From the AutoVue toolbar, you can also click

Method Description

Wireframe A skeletal model constructed using lines and curves that represent the
model's “true” edges. All internal lines are visible.

Shaded A solid model constructed of planes and surfaces. These surfaces are
shaded to increase the illusion of three dimensions.

Hidden Line A wireframe constructed with all internal lines hidden

Silhouette A wireframe constructed with all internal lines visible but including
additional silhouette edges. These are not “true” edges but help to
visualize the model.

Wire Polygons A skeletal model constructed of unfilled polygons.

Shaded Wire An outlined solid model constructed of planes and surfaces. The outline
is a solid line and the model's surfaces are shaded to increase the illusion
of three dimensions.

Reflective A solid model constructed of planes and surfaces. These surfaces are
rendered as reflective sheet to accentuate the model’s shadows.

Reflective Wire An outlined solid model constructed of planes and surfaces. The outline
is a solid line and the model's surfaces add a reflective sheet to the
model’s shadows.

Table 6–2 (Cont.) Options in View Menu

Menu Sub-Menu Description
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2. Select a render mode from the list. The selected render mode is highlighted. The
model or selected model parts change to the selected render mode.

6.10.2 Changing the Visibility
You can choose to show or hide selected parts; this can be done from either the Model
Tree or the workspace.

From the Model Tree, deselect the check box beside the model part or parts that you
want to hide.

Conversely, select the check box beside the model parts that you want to set
visible.The selected model parts appear or disappear from the model.

You can also hide model parts by selecting them on the model
or from the Model Tree, then right-clicking and selecting Hide Part.
Selecting Hide Rest displays the selected model parts and hides the
rest of the model.

6.10.3 Changing Model Color
You can change the color of a specific model part or selected model parts.

1. Select the model or model parts whose color you want to change.

If no part is selected, the change is applied to the entire model.

2. From the Manipulate menu, select Visual Effects, and then select Color.

From the AutoVue toolbar, you can also click Color .

The Color dialog appears.

3. Select the desired color.

4. Click Apply. The selected part or parts change to the selected color.

To set the model color to its default color, repeat steps 1 to 2
and click Reset in the Color dialog.

6.10.4 Adjusting the Transparency
You can adjust the degree of transparency of a model. This function applies to shaded
and shaded wire models as well as reflective and reflective wire.

1. Select the model or model parts whose transparency you want to adjust.

2. From the Manipulate menu, select Visual Effects, and then select Transparency
.

The Set Transparency dialog appears.

3. To adjust the transparency, move the slider left or right.

4. Select Apply Dynamically if you want the transparency to dynamically change
with the movement of the slider.

Alternatively, to adjust the transparency level, you can enter in the Value field a
value from 0 to 1. Where 0 renders the model opaque (default state) and 1 renders
it transparent.

5. Click Close to apply the changes and close the Set Transparency dialog.

Note:

Note:
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6.11 Light Settings
The default light setting consists of a white light at the 10 o’clock position with respect
to the model. In the Lighting dialog, it appears as a grey ball of white light at the 10
o’clock position along the circumference of the larger sphere.

Ambient lighting is the overall lighting that surrounds an object. It provides constant
illumination to every surface of the model. This type of lighting is particularly
effective as a fill-light for surfaces not directly illuminated by a directional light source.
You can set the intensity or source position; too high a setting tends to saturate the
image and reduce its clarity.

Using the Directional lighting option, you can adjust the position of the light source on
an object.

You can make the following modifications via the Lighting dialog:

■ Set the intensity and source position of the ambient light.

■ Set the direction of light.

■ Add and remove a light source.

■ Change light color, brightness, and the capability of reflecting light like a mirror.

6.11.1 Setting Ambient Lighting
To set the ambient lighting, do the following:

1. From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog appears.

2. Click and drag the Ambient Light sliding bar until you achieve the desired
lighting.

The lighting automatically changes with the movement of the sliding bar. The
Custom option is selected when you modify the ambient light.

3. To set the ambient lighting to its default setting, select Default.

4. Click Close to close the Lighting dialog.

6.11.2 Setting Directional Lighting
Setting the directional lighting adjusts the position of the light source on the model.
You can also add a new light source.:

1. From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog appears.

2. To change the direction of the light, click and drag the small ball until you achieve
the desired lighting.

You can also drag the white ball outside of the large ball.

The direction of the light that is reflected on the 3D model automatically changes
with the movement of the white ball. The Custom option is selected when you
adjust the position of the light.

3. To set the light direction to its default setting, select Default.

4. Click Close to close the Lighting dialog.
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6.11.3 Adding a New Light Source
1. From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog appears.

2. Select the Two Lights option. A new light source appears as a black ball in the 5
o’clock position.

3. To add more light sources, right-click inside the square surrounding the ball and
select Create New Light Source from the pop-up menu. The Custom option is
selected and the new light source appears as a white ball.

4. Click and drag the small ball until you achieve the desired lighting.

5. To restore the light source to its default setting, select Default.

6. Click Close to close the Lighting dialog.

You can have a total of eight light sources at a time.

6.11.4 Changing the Light Properties
1. From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog appears.

2. To change the properties of the light, such as color or brightness, right-click
directly on the small ball and select Light Properties.

The Light Property dialog appears.

3. Select a color from the Color menu.

You can drag the Brightness and Specularity slide bars to modify the brightness of
the source and the brightness of the model’s reflection to light, respectively.

4. Click OK.

5. Click Close to close the Lighting dialog.

6.11.5 Removing a Light Source
1. From the Manipulate menu, select Visual Effects, and then select Lighting.

The Lighting dialog appears.

2. Right-click directly on the small ball that you want to remove and select Remove
Light.

The small ball disappears and the light change is reflected.

3. You can also select Default to restore the lighting properties to its default setting.

4. Click Close to close the Lighting dialog.

6.12 3D Views
You can display different views of 3D Models or create your own views. The following
sections provide information on the default view of the model, the available camera
views, native views, and user-defined views.

Note:
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6.12.1 Default View
The Default View is the view of the model when it is initially loaded; usually it is the
view in which the model was saved. In cases where there is no saved view, AutoVue
loads the isometric view of the model.

To return to the default view of a 3D model, from the View menu, select Default View.

6.12.2 Setting Standard or Camera Views
Rather than entering Rotation mode, you can view various predefined rotations with
the Camera Views option from View and Markup modes.

To do so, from the View menu, select Camera Views, and then select the pre-defined
view you want to display.

The view options are Isometric, Top, Bottom, Front, Back, Left, and Right.

The model changes to the selected view. You can also click the Views tab, then click
the view from the Standard Views tree, or right-click in the workspace and select
Camera Views.

6.12.3 Setting Native Views
AutoVue displays views for a 3D file as saved in its native application. Native views
are present only if the file contains saved views.

From the View menu, select Views, and then select Native Views.

The model re-orients to the selected view. The view options vary depending on the
file. Examples of the view options are Last Saved View, Presentation, Front, Back, Left,
Right, Top, Bottom, Isometric, Trimetric, and Dimetric. You can also click the Views
tab, and then click the view from the Native Views tree, or right-click in the workspace
and select Views, and then select Native Views.

6.12.4 Creating a User-Defined View
You may want to create and save your own views. AutoVue allows you to define a
view and add it to the User Defined Views. You can define a customized view in View
or Markup mode. Any views you apply to displayed models during Markup mode are
saved as part of the Markup file.

1. Apply your own views or transformation to the displayed model.

The view states that you can apply and save for your defined view are Extents,
Rotation, Model Transformation, Explosion, Render Modes, Color, Transparency,
Visibility, Sectioning, Camera Settings and views involving Mockups.

2. From the View menu, select Views, select User Defined Views, and then select
Add View.

You can also right-click in the workspace and select Views, then select User
Defined Views, and then select Add View.

The Add User Defined View dialog appears.

3. Enter a view name for the view that you want to define.

4. Click OK to close the Add User Defined View dialog.

To see the view you defined, click the Views tab and select it from the User
Defined Views tree or select Views, select User Defined Views.
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6.12.5 Deleting a User-Defined View
To delete a user-defined view, do the following:

1. Under the User Defined Views tree, select the view that you want to delete, then
right-click and select Delete.

A confirmation prompt appears.

2. Click Yes. The view disappears from the tree.

6.12.6 Displaying the Perspective Projection of a 3D Model
The Perspective option shows objects in three dimensions with distances, planes and
curved surfaces adjusted to give a sense of depth that reflects the desired perspective
to the eye.

You can use the Perspective option in any of the 3D Views
since it is a projection mode rather than a view point.

From the Manipulate menu, select Visual Effects, and then select Perspective.

The depth of the model changes.

6.12.7 Viewing a Model from a Particular View Point
To view a model from a particular point, you can specify a view point.

1. From the View menu, select Camera Views, and then select View Points.

You can also right-click in the workspace and select Camera Views, and then
select View Points.

The View Point dialog appears

2. Enter the coordinates for X, Y and Z:

a. In the Camera Position fields, enter the coordinates to set the position of the
camera lens.

b. In the Target Position fields, enter the coordinates to set the position of the 3D
model viewed through the camera lens.

c. In the Up Direction fields, change the coordinates to values between 0 and 1
to set the upward orientation.

3. Click OK to close the View Point dialog.

The entity moves to the defined view point. The Global axes and the User Coordinates
System change position to reflect the view point.

6.13 Entity Properties
You can view properties such as visibility, color, transparency, mass properties, and
extents of a model or model parts.

Note:

Note:
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6.13.1 General Attributes
The Attributes tab displays a model’s or model part’s attributes. The list of attributes
varies depending on the model. Some of the viewable General attributes are as
follows:

Table 6–4 General Attributes

If you are displaying the 3D view of an EDA design, AutoVue displays the general
attributes mentioned above. In addition, AutoVue displays attributes specific to the
Printed Circuit Board (PCB), such as component name, board side, component class
and device type.

If a 3D file has Product and Manufacturing Information (PMI) and a PMI entity is
selected, the PMI attributes are displayed along with the above general attributes.
Some of the viewable PMI attributes are X-Axis, Y-Axis, font color, text font name, and
tolerance type.

6.13.2 Viewing Attributes
To view attributes, do the following:

1. To view the attributes of specific model parts, select the parts from the model.

2. To view the attributes of the entire 3D model, make sure that no parts are selected.

3. From the Analysis menu, select Show Entity Properties.

You can also right-click in the workspace and select Show Entity Properties, or in
the Model Tree, select the model part or parts, then right-click and select Show
Entity Properties.

The Entity Properties dialog appears.

4. Click the Attributes tab.

The attributes of the selected model parts are displayed in a hierarchical tree.

5. Click Close to close the Entity Properties dialog.

6.13.3 Viewing Mass Properties
The Mass Properties tab displays the precise measurements for mass, volume, area,
center of gravity, moments of inertia, and inertia tensor for any model or selection.

Attribute Description

Color Color of the selected model part

Density The density of the model or the selected model parts

Name The model part name or the displayed page name of the model.

Render Mode The dynamic rendering used for displaying model or model part. For
example, Shaded, Shaded Wire and Wireframe

Transparency The value between 0 and 1 representing the model or model part’s degree
of transparency.

0 = opaque

1 = transparent

Visibility The value True (visible) or False (invisible) for a model or model part.
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1. Select the part or parts for which you want to calculate the mass properties. To
select multiple parts, press the Shift or Control key while selecting.

2. To view the mass properties of the entire 3D model, make sure no parts are
selected.

You can also make your selection after you open the Entity Properties dialog.

3. From the Analysis menu, select Show Entity Properties.

You can also right-click in the workspace and select Show Entity Properties, or in
the Model Tree, select the model part or parts, then right-click and select Show
Entity Properties.

The Entity Properties dialog appears.

4. Click the Mass Properties tab to view the properties of the selected part or
component.

When a mass property cannot be calculated, “N/A” displays in red for that
property. When this is the case, you can also click Error Report for a list of mass
properties that could not be calculated.

5. To change the density, change measurement units, or configure computation o
inertia tensor, click Options.

The Options dialog appears.

6. Click OK to close the Options dialog.

7. Click Close the close the Entities Properties dialog.

6.13.4 Configuring Mass Properties
From the Mass Properties tab, you can change the density, the measurement units or
configure the reference point of inertia tensor.

1. From the Analysis menu, select Show Entity Properties.

You can also right-click in the workspace and select Show Entity Properties, or in
the Model Tree, select the model part or parts, then right-click and select Show
Entity Properties.

The Entity Properties dialog appears.

2. Click the Mass Properties tab.

3. Click Options. The Options dialog appears.

4. To change the density, enter a value in the Density field.

5. To change the density units, select the unit for Mass and Length from their
respective lists in the Units section.

6. To apply the density to model parts with unknown density, select Use Only for
Parts with Unknown Density.

7. To apply the density to all model parts, select Use for All Parts.

8. To change the display units, select the unit for Mass and Length from their
respective lists in the Display Units section.

9. To compute the inertia tensor based on output coordinate system, select Output
Coordinate System Origin.

10. To compute the inertia tensor based on the center of gravity, select Center of
Gravity.
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11. Click OK to close the Options dialog.

Mass properties are instantly calculated and displayed in the Mass Properties tab.
When a mass property cannot be calculated, “N/A” displays for that property.
When this is the case, you can also click Error Report for a list of mass properties
that could not be calculated.

12. To save the changes, click Save As.

The Save Mass Properties As dialog appears.

13. Specify the path where you want to store the file and enter the file name, then click
Save. AutoVue saves the results in a .txt file.

14. Click OK to close the Entity Properties dialog.

6.13.5 Viewing Extents
The Extents tab displays the orientation coordinates and center coordinates of the X, Y,
and Z axes, as well as the width, height, and depth measurements for any model or
selection.

1. Select the part or parts for which you want to view Extents. To select multiple
parts, press the Shift or Control key while selecting.

2. To view the Extents of the entire 3D model, make sure no parts are selected. You
can also make your selection after you open the Entity Properties dialog.

3. From the Analysis menu, select Show Entity Properties.

You can also right-click in the workspace and select Show Entity Properties, or in
the Model Tree, select the model part or parts, then right-click and select Show
Entity Properties.

The Show Entity Properties dialog appears.

4. Click the Extents tab.

5. You have three extents options:

a. Select Transformed if you want to view the extents after you have
transformed the model.

b. Select Untransformed if you want to view the extents of the model without
transformation.

c. Select Orient if you want to view the X,Y, and Z co-ordinates of the re-oriented
model or selection.

6. Click Close to close the Entity Properties dialog.

6.14 PMI Entities
A 3D file's Product and Manufacturing Information (PMI) is composed of annotations
that are included in design files. These annotations indicate the limits and constraints
that must be observed during the manufacturing of the object displayed in the 3D
model.

At the highest level, PMI provides information about dimensions, feature control
frames, weld specifications, and surface finishes. This information is based upon key
design features which are specified through datum targets, measurement points,
reference geometry (for example, construction lines, surfaces, and objects), or the
geometry inherent in the object.
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The following terms can be used interchangeably with the term PMI:

■ Datums Cosmetics

■ Dimensioning Cosmetics

■ Geometric Tolerances (GTOLs)

■ Geometric Dimensioning and Tolerance (GDT or GD&T)

■ Functional Tolerance Annotation (FTA or FTA&A)

6.14.1 PMI Filtering
Use PMI Filtering to select which types of product and manufacturing information to
display.

1. From the Manipulate menu, select Visibility Control, and then select PMI
Filtering.

From the AutoVue toolbar, you can also click PMI Filtering .

The PMI Filtering dialog appears and displays all PMI types.

2. In the Tree column, select the check box beside the items that you want to display
in the Model Tree.

3. In the View column, select the check box beside the items that you want to display
on the 3D model.

4. Deselect the check box beside the items that you want to hide. Click All to show
all items, or click None to hide all items.

5. Click OK to close the PMI Filtering dialog. Only items selected in the Tree column
are displayed in the Model Tree. Only items selected in the View column are
visible on the 3D model. Visibility settings are saved and will be restored the next
time you open the PMI filtering dialog.

AutoVue supports default PMI visibility as saved in the file. To
restore default PMI visibility, click Default in the PMI Filtering dialog.

6.14.2 Aligning to a PMI Entity
From the Model Tree, right-click the PMI item that you want to align to and select
Align To. AutoVue aligns to the selected PMI item.

6.14.3 Go to a Displayed PMI Entity
From the Model Tree, right-click the PMI item that you want to go to on the model and
select Go To. AutoVue zooms to the selected PMI item.

6.14.4 PMI Configuration Entities
The Views, Captures, Reference/Grouping entities refer to specific configurations of
the model. These PMI configuration entities are listed in the Model Tree and are
activated by right-clicking the entity and then selecting Activate.

6.14.4.1 Views
The View configuration entity displays predefined views, and highlights associated
PMI entities.

Note:



Manipulating a 3D Model

Working with 3D Files 6-19

1. Expand the Views tree to display the defined views.

2. Right-click the selected view, and then select Activate. The model and PMI entities
display in the workspace as defined in the selected view. The PMI entities are also
highlighted in the Model Tree.

6.14.4.2 Captures
The Captures configuration entity displays predefined views.

1. Expand the Captures tree to display the defined captures.

2. Right-click the selected captures, and then select Activate. The model and PMI
entities display in the workspace as defined in the selected capture.

6.14.4.3 Reference Frames
The Reference Frames configuration entity highlights the grouped PMI entities.

1. Expand the Reference Frames tree to display the predefined reference frames.

2. Right-click the selected reference frames, and then select Activate. The grouped
PMI entities are highlighted in the Model Tree.

6.15 Manipulating a 3D Model
You can rotate 3D CAD models along a specific axis. You can scale a model part up
and down, as well as translate the model.

In Manipulate Mode, you can resize, translate, and/or rotate selected parts of the
model. When you select one or more model parts, AutoVue displays a model-size
representation of the Global Axes going through the selected part or parts of the 3D
model.

6.15.1 Panning a Model Along the X, Y and Z-Axis
To pan a model along the X, Y, and Z-axis, do the following:

1. From the Manipulate menu, select Manipulate.

From the AutoVue toolbar, you can also click Manipulate .

You are now in Manipulate mode.

2. Select the model part or parts that you want to pan.

To select more than one part, press the Shift or Control key while selecting.

A model-size representation of the Global Axes appears through the model part or
parts and are encased by a three-dimensional box.

3. Click and hold the mouse button on the arrow at the end of the axis that you want
to pan.

4. Drag the mouse to where you want to move the part or parts.

5. To exit Manipulate mode, click Manipulate or from the Manipulate menu,
select Manipulate.

To restore the default state of a part of the model, from the Manipulate menu,
select Transform, and then select Reset Selected. To restore the default state for
the whole model, select Reset All.
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6.15.2 Rotating a Model Along the X, Y and Z-Axis
To rotate a model along the X, Y, and Z-axis, do the following:

1. From the Manipulate menu, select Manipulate.

From the AutoVue toolbar, you can also click Manipulate .

You are now in Manipulate mode.

2. Select the model part or parts that you want to rotate.

To select more than one part, press the Shift or Control key while selecting.

A model-size representation of the Global Axes appears through the model part or
parts and are encased by a three-dimensional box.

3. Click and hold the mouse button on the arrow at the end of the axis that you want
to rotate.

The initial mouse movement determines which of the two axes will mark the site
of rotation. If the axis you selected does not rotate around the right axis for the
rotation that you want to make, click the sphere again and move the mouse in a
different direction.

4. Clicking on an axis sphere allows rotation around one of the other two axes.

5. Move the mouse to rotate the model by the selected axis.

If you want to rotate the selection freely, as done in Rotate Mode, press the Control
key during rotation.

6. To exit Manipulate mode, click Manipulate or from the Manipulate menu,
select Manipulate.

To restore the default state of a part of the model, from the Manipulate menu,
select Transform, and then select Reset Selected. To restore the default state for
the whole model, select Reset All.

6.15.3 Scaling a Model Along the X, Y and Z-Axis
To scale a model along the X, Y, and Z-axis, do the following:

1. From the Manipulate menu, select Manipulate.

From the AutoVue toolbar, you can also click Manipulate .

You are now in Manipulate mode.

2. Select the model part or parts that you want to scale.

To select more than one part, press the Shift or Control key while selecting.

A model-size representation of the Global Axes appears through the model part or
parts and are encased by a three-dimensional box.

3. Click and drag a corner cube of the box up or down to scale the selected model
part.

4. To exit Manipulate mode, click Manipulate or from the Manipulate menu,
select Manipulate.

To restore the default state of a part of the model, from the Manipulate menu,
select Transform, and then select Reset Selected. To restore the default state for
the whole model, select Reset All.
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6.16 Transforming a 3D Model
Using the illustrated transformation buttons or by entering X, Y or Z values, you can
rotate, scale, or translate a model or any selection of model parts.

From the Manipulate menu, select Transform, and then select Define.

The Transformation dialog appears as follows:

Figure 6–4 Transformation

From the AutoVue toolbar, you can also click Transform .

In the Transformation dialog, the buttons on the left correspond to a rotational
movement along the three axes, and the buttons on the right correspond to a
translational movement along the three axes and the scaling up and down.

6.16.1 Transforming a Model Using Illustration Buttons
To transform a model using illustration buttons, do the following:

1. From the Manipulate menu, select Transform, and then select Define.

From the AutoVue toolbar, you can also select Transform .

The Transformation dialog appears.

2. Select the model part or parts that you want to rotate, translate, or scale. To select
more than one model part, press the Shift or Control key while selecting. If no
part is selected, transformation is applied to the entire model.

3. Use the rotate or translate buttons to transform the model.

4. To set the translate, rotate and scale increments, click Options.

When you click a rotation, translation or scale button, the model transforms in
increments of the values entered in the Options dialog.

The Options dialog appears.

5. Enter the Translate Increment value in inches.

6. Enter the Rotate Increment value in degrees.

7. Enter the Scale Increment value.

Note:
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8. Click OK to close the Options dialog.

9. Click Reset to set the model to its original transformation.

10. Click Close to close the Transformation dialog. The transformation state remains
displayed.

11. To restore the default state of a part of the model, from the Manipulate menu,
select Transform, and then select Reset Selected. To restore the default state for
the whole model, select Reset All.

6.16.2 Resetting the Transformation of a 3D Model
You can reset a model or selected parts to their original transformation.

1. View the transformed 3D Model.

2. To reset the entire model to its original transformation, from the Manipulate
menu, select Transform, and then select Reset All.

3. To reset selected model parts to their original transformation, from the
Manipulate menu, select Transform, and then select Reset Selected.

You can also reset selected model parts. To do so, from the Model Tree, deselect the
check box beside the parts in the Transformation column .

The model or selected parts are reverted back to their original transformation.

6.16.3 Transforming a Model by Setting Values
To transform a model by setting values, do the following:

1. From the Manipulate menu, select Transform, and then select Define.

From the AutoVue toolbar, you can also select Transform .

The Transformation dialog appears.

2. Select the model part or parts that you want to rotate, translate or scale.

To select more than one model part, press the Shift or Control key while selecting.

3. To rotate the model by set values, enter the X, Y and Z value.

4. To translate the model by set values, enter the X, Y and Z value.

5. To view a mirror image, in the Mirror section of the dialog, select a check box.

6. To scale the model by a factor, enter a scale factor in the Factor field.

7. Click Apply.

8. To apply absolute transformation instead of incremental, select the Absolute check
box.

9. Click Apply.

10. To repeat a transformation, deselect Absolute, then continue clicking Apply.

To set the model to its original transformation click Reset.

11. Click Close to close the Transformation dialog.

The transformation state remains displayed.

To restore the default state of a part of the model, from the Manipulate menu, select
Transform, and then select Reset Selected. To restore the default state for the whole
model, select Reset All.
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6.17 Sectioning
With the Sectioning feature, you can view the cross-section and cut-through of 3D
models. In the Define Section dialog, you can define the section plane position, section
plane orientation, and the cut-through.

6.17.1 Section Plane Options
In the Define Section dialog, you can use the following options to define the
orientation of the section plane:

Table 6–5 Orientation Options

6.17.2 Cut Options
In the Define Section dialog, you can use the following cut options to define the
cut-through of an object:

Table 6–6 Cut Options

6.17.3 Defining the Section Plane and Cut-through
To define the section plane, do the following:

1. From the Manipulate menu, select Section, and then select Define.

From the AutoVue toolbar, you can also click Sectioning .

The Define Section dialog appears.

2. From the Section Plane list, select the orientation for the section plane.

3. From the Cut Options list, select the cut option that you want.

4. To define the plane position, click and drag the Plane Position slider to the
position you want.

Option Description

XY Plane Section plane is oriented along the XY plane.

YZ Plane Section plane is oriented along the YZ plane.

XZ Plane Section plane is oriented along the XZ plane.

From 3 Vertices Select three vertices on the object to define the orientation of the
section plane.

From Face Normal Select a face on the object to define the orientation of the section
plane perpendicular to the face.

From Edge Tangent Select an edge on the object to define the orientation of the
section plane perpendicular to the edge’s tangent.

Define a Plane Define X, Y and Z coordinates to orient the section plane.

Option Description

Don’t Cut Display the object without a cut.

Cut Object displayed is cut along the section plane.

Invert Reverse the selection, display the other part of the object.

Show Both Restore the cut part of the object.

Edges Only Display only the edges of the object along the section plane.
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5. Select Dynamic, if you want the plane to move simultaneously with the slider.

6. Select Show Plane, if you want the section plane visible.

7. Select Fill, if you want the section plane filled. The fill color can also be set from
the Configuration dialog.

The section plane is displayed as filled and the Section Area is calculated.

8. From the Measured Units list, select the unit in which you want to measure the
section surface.

9. Click Close to close the Define Section dialog. Once you have defined the section
plane and closed the Define Section dialog, among other options, you can choose
whether to enable, remove, or invert a defined section from the Section menu.

6.18 Exploding
You can use the Explode option to better understand the structure of an assembly and
to analyze the dismount capability. You can also save the exploded view, as well as
obtain a printed document of the exploded product for further analysis.

6.18.1 Explode Options
From the Explode dialog, you can define how the explosion is to be performed and to
visually explode or implode a model.

The options that you can set are:

Table 6–7 Explode Options

■ Whole model - the number of available levels depends on how many
levels that can be exploded exist in the model. For example, if there
are four levels, with level 2 being the first level under the main
assembly, then level 3 and level 4 are added to the list.

■ Selected parts - the number of available levels to be added to the list
depends on the selected virtual tree.

6.18.2 Exploding a 3D Model
To explode a 3D model, do the following:

1. From the Manipulate menu, select Explode.

Option Description

Maximum Depth Define up to which level you want to explode. All entities from the root
level to the specified level are exploded. All entities on the other levels
will not be exploded.

If you are exploding:

Animated When selected, animation is shown while exploding or imploding the
model.

Show Arrows When selected, arrows are displayed in an explosion assembly. The arrow
starts from an exploded entity and points to the center point of its parent.

Scroll Explode Dragging the slider gradually displays the progression of the explosion to
show the explosion dynamics.

Explode - pressing brings the explosion level to the (n-1) level if current
explosion level is between n-1 (inclusive) and n level (exclusive).

Implode - pressing brings the explosion level to the n level if current
explosion level is between n-1 (exclusive) and n level (inclusive).
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From the AutoVue toolbar, you can also select Explode .

The Explode dialog appears.

2. Select the parts that you want to explode. To select more than one model part,
press the Shift or Control key while selecting. To explode the entire model, ensure
that no parts are selected.

3. From the Maximum Depth list, select the level to which you want the model to
explode.

4. Select Animated if you want to see an animated view of the explosion. This option
is selected by default.

5. Select Show Arrows if you want to display the arrows.

6. To explode the model, click Explode. The whole model or the select model parts
explode.

7. To implode the model, click Implode. To manually change the explosion state,
click and drag the scroll bar.

8. Click OK to close the Explode dialog.

The explode state remains displayed, and the Transformation column in the Model
Tree is updated indicating the exploded parts.

See Resetting the Transformation of a 3D Model.

6.18.3 Saving an Exploded View of a 3D Model
From the Explode dialog, you can save the exploded view of the 3D model.

1. Explode a 3D Model.

2. Click Save View in the Explode dialog.

The Add User Defined View dialog appears.

3. Enter a View Name.

4. Click OK.

The view is saved and appears in the Views tab under the User Defined Views
tree.

5. Click OK to close the Explode dialog.

The exploded state is saved.

See Resetting the Transformation of a 3D Model

6.19 Comparing 3D Files
When comparing 3D files in a non-integrated environment we recommend that you
use Universal Naming Convention (UNC) file names or the server protocol so as to
ensure that all required sub-assemblies and parts are retrieved from correct paths. For
information on UNC file names and the server protocol, refer to the Installation and
Configuration Guide.

AutoVue provides the ability to compare two 3D files or two sets of entities from the
same file or different files and display color-coded comparative data. Generally when
comparing two files, you should first open the newer version of the document and
then compare it with the older version.
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When comparing files, AutoVue displays three windows:

■ The right window displays the newer version of the document.

■ The left window displays the older version of the document.

■ The bottom window displays the comparison results.

By default, the result windows display added, deleted, and unchanged entities.

The Compare Tree displays the model’s hierarchy with a State column displaying
different icons representing the results of the file comparison. The icons indicate if an
model part has been added, modified, moved, or deleted.

In the Comparison Result window you can specify whether you want to display only
the additions, deletions or unchanged, or any combination of the three. To access these
options, right-click in any window and select an option from the pop-up menu. By
default, the Comparison Result window displays the unchanged, deleted, and added
information.

The Compare feature performs a graphical comparison not a
geometrical comparison.

In the Comparison Result window, results are displayed in different colors to
differentiate the results of the file comparison. The comparison options and
corresponding colors are:

Table 6–8 Comparison Options and Colors

6.20 Comparing 3D Files
The following steps describe how to compare files:

1. View the newer file.

2. From the Analysis menu, select Compare. The Open dialog appears.

3. Enter the file name or browse to locate the file you want to compare with the
newer file.

4. Click Open.

AutoVue displays the Compare Tree and three windows. The first window
displays the newer file, the second displays the older file, and the third displays
the comparison results.

5. To view the properties of a modified or moved entity in the newer file and in the
older file, select the modified or moved entity from the tree, then right-click and
select Entity 1 Properties.

The Entity Properties dialog appears displaying the properties of the entity in the
base file

Note:

Option Color Description

View Additions Green Displays parts that are present in the newer file but
not in the older file.

View Deletions Red Displays parts that are missing in the newer file but
present in the older file.

View Unchanged Blue Indicates that there is no change between the newer
file and older file.
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6. Select the entity again, then right-click and select Entity 2 Properties.

The Entity Properties dialog appears displaying the properties of the entity in the
compare file.

7. To compare the results of the entity in the newer file to the older file, select the
entity from tree, then right-click and select Compare Results.

The Compare Results dialog appears.

8. To view the attribute differences, click Attributes.

9. To view the transformation difference, click Transformation.

If there are no attribute or transformation differences, the buttons are disabled.

10. Click OK to close the Compare Results dialog.

11. To exit Compare mode, from the File menu, select Exit Compare. The newer file
appears in the workspace.

6.20.1 Comparing Entity Sets
From the file comparison, you can compare a set of entities from one file against a set
of entities from the another file. You can also compare sets of entities from the same
file.

1. Select the files you want to compare.

2. From the Analysis menu, select Compare Sets.

The Compare Sets dialog appears.

Figure 6–5 Compare Sets

3. Click Set 1.

4. Select the entities from either the tree on the left or the tree on the right.

The tree on the left is the base file and the tree on the right is the compare file.

The selected entities appear in the Set 1 list.

5. Click Set 2.

6. Select the entities from the other tree that you did not select for Set 1.

To compare entities from the same file, select the entities for Set 1 and Set 2 from
either the base file or the compare file.
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The selected entities appear in the Set 2 list.

7. Click OK.

The Compare Tree and the three windows are updated with the set comparison
results.

8. To restore the comparison files, from the Analysis menu, select Compare Files.
The files appear in the three windows.

6.21 Generating a Bill of Material
For 3D files, you can obtain a list with a count of the parts required for manufacturing
the item featured in the file. To generate a Bill of Material (BOM):

1. From the Analysis menu, select Generate Bill of Material.

The Bill of Material dialog appears.

Figure 6–6 Bill of Material

2. To sort the list numerically, click the Count column header.

3. To sort the list alphabetically, click the Part Name column header.

4. To view a part or parts on the model, select the parts from the Part Name column.

To select more than one part, press the Shift or Control key while selecting.

The parts are highlighted on the model and in the Model Tree.

5. To save the Bill of Material, click Export.

The Save As dialog appears.

6. Enter a file name or browse to locate the directory where you want to store the file,
then click Save.

AutoVue saves the results in a.csv (Comma Separated Values) or.xml file.

7. Click Close to close the Bill of Materials dialog.

6.22 Entity Search
AutoVue allows you to search for entities in a 3D model using the Entity Search dialog.
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Figure 6–7 Entity Search

You can search the whole model or selected entities on the model, perform a 3D text
search, apply attributes, entity type or PMI filters as search criteria to filter entities.
You can also search for entities by the size of an entity and location, or select entities
from the results list and have them appear highlighted in the workspace and in the
Model Tree.

The Search Options are:

Table 6–9 Search Options

Where Option Description

3D Search tab Selection Specify if you want to search the entire model or
selected parts or parts that are not selected.

Type Specify the type of entity you want to search. For
example, part, body, assembly or PMI.

Show PMI parent
entity in results

When selected, displays only the parent entity of a
PMI entity that matches search criteria.

If cleared, displays PMI entities that match search
criteria in the Results dialog.

Option is enabled if Type is set to PMI or All and file
has PMI entities.

PMI Filter Filters the entities that have PMI information.

Option is enabled if Type is set to PMI or All.

PMI Type Specify the specific PMI attribute you want to search.

Option is disabled if PMI Filter is set to All.

Containing Text Specify a text string that you want to search.
AutoVue searches for a specified string in attribute
names and attribute values.

Attribute Filters Specify attributes to search for in 3D model.

See Performing an Attribute-based Search.
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6.22.1 Performing a Search
The following steps describe how to perform an entity type-based search.

1. From the Edit menu, select Entity Search.

The Entity Search dialog appears.

2. Click the 3D Search tab.

3. From the Selection list, specify what parts of the model that you want to search.

■ To search the entire model, select All.

■ To search specific parts of a model, select Selected and then select the parts on
the model.

■ To search the model parts that are not selected, select Not selected.

4. From the Type list, select the type of entity that you want to search.

For 3D Models that have PMI information, the PMI search features are enabled.

5. Select the Show PMI parent entity in Results check box if you only want the
parent entity of the selected PMI entity or entities to appear in the Results list.

Attribute
Filter dialog

Name Specify the specific attribute you want to search.
Some of the available attributes:

Color

Density

Display_Mode

Filepath

Layer_ID

Name

Translucency

Visibility

Note: The attributes vary depending on the file being
viewed.

See Performing an Attribute-based Search.

Any Value When selected, AutoVue searches for any value of
the selected attribute.

The attribute value options are disabled.

If cleared, specify the values for the selected attribute
you want to search.

The attribute value options correspond to the
selected attribute.

Advanced 3D
Search tab

Volume Specify the size of an entity, the minimum and
maximum dimensions. The dimensions of an entity
boundary box must be between the specified
dimensions to meet the search criteria.

Location Specify an axes aligned boundary box. The boundary
box of an entity must be inside it to meet the search
criteria.

Table 6–9 (Cont.) Search Options

Where Option Description
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6. Deselect the check box if you want all PMI entities to appear in the Results list. The
option is enabled if PMI or All are selected from the Type list and the file has PMI
entities.

7. From the PMI Filter list, select the type of entities that you want to search.

■ To search all entities, select All.

■ To search entities with PMI, select With PMI.

■ To search without entities, select Without PMI.

8. From the PMI Type list, select the type of entity that you want to search.

The PMI Type list is disabled if All is selected from the PMI Filter list.

9. Click Search to perform the entity search. The search results appear in the Results
list.

6.22.2 Performing a 3D Text Search
From the Containing Text field of the Entity Search dialog you can search for a text
string in the 3D model.

By default, AutoVue searches the attribute name and attribute value for the entered
text.

Enter the text you want to search for in the Containing Text field and then click Search.

6.22.3 Performing an Attribute-based Search
From the Entity Search dialog, you can search for entities by their attributes, such as
color, density, shading, and so on.

1. From the Edit menu, select Entity Search. The Entity Search dialog appears.

2. Click the 3D Search tab.

3. Select the search criteria that you want to use for your search.

4. Click Add. The Attribute Filter dialog appears.

Figure 6–8 Attribute Filter

5. From the Name list, select the attribute that you want to search.

The Value list appears corresponding to the selected attribute.

6. Select the Any Value check box if you want to search by any value; the associated
value options are disabled.
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7. Deselect the Any Value check box if you want to search by a specific value; from
the Condition set condition for the search, and from the Values list select the
values that you want to search.

8. Click OK.

To add more than one Attribute Filter, repeat steps 4 to 8.

9. To edit an Attribute Filter, select the filter and click Edit.

The Attribute Filter dialog appears allowing you to edit the filter.

10. To disable an Attribute Filter, deselect the check box beside the filter or filters that
you want to disable.

11. To enable an Attribute Filter, select the check box beside the filter or filters.

12. To remove an Attribute Filter, in the Entity Search dialog, select the filter and click
Remove.

The Attribute Filter disappears from the list.

13. In the Entity Search dialog, click Search.

A list of entities matching the search criteria appear in the Results list displaying
the name and type of the entities.

14. Click Close to close the Entity Search dialog.

6.22.4 Performing an Advanced 3D Search
From the Entity Search dialog, you can search for entities using volume or location
filters. Volume specifies the size of the entity: you can specify the minimum and
maximum dimensions an entity must be between. Location specifies an axes aligned
boundary box: you can specify the dimensions for an axes aligned boundary box that
an entity must be inside.

1. From the Entity Search dialog, click the Advanced 3D Search tab.

Figure 6–9 Advanced 3D Search

2. To search for entities by Volume, select the Enabled check box.

If you want to search for entities that match all three dimensions, select the
Completely contained check box. If the check box is deselected, then an entity only
has to match one dimension in order to appear in the Results list.
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3. Enter the minimum and maximum dimensions in their respective fields.

4. From the Units list, select the unit you want to set for the Volume dimensions.

5. To search for entities by location, select the Enabled check box.

If you want to search for entities that match all three dimensions, select the Fits
completely check box. If the check box is deselected, then an entity only has to
match one dimension to appear in the Results list.

6. From the Units list, select the unit you want to set for the Location dimensions.

7. Enter the dimensions for Point 1 and Point 2.

8. Click the 3D Search tab.

9. Click Search.

A list of entities matching the search criteria appears in the Results list.

10. Click Close to close the Entity Search dialog.

6.22.4.1 Saving Search Results
1. Perform a 3D entity search.

2. Click Search.

A list of entities matching the search criteria appear in the Results list displaying
the type and name.

3. To save the results, click Export.

The Save As dialog appears.

4. Specify the path where you want to store the file and enter the file name, then click
Save.AutoVue saves the results in .csv (Comma Separated Values) file.

6.23 Measuring in 3D Files
AutoVue provides the ability to perform measurements in 3D files. When measuring,
AutoVue provides the option to “snap” to different entity types on the model.

From the Analysis menu, select Measure to access the Measurement options.

The measure options are as follows:

Table 6–10 Measure Options

Name Description

Angle Measure the precise angle between any three vertices or any two
edges, planes, faces or any combination of these entity types.

Arc Measure the precise radius, length and angle of any arc and
calculate the center point.

Distance Measure the precise distance between any two vertices, edges,
mid-edges, arc centers, faces or any combination of these entity
types.

Minimum
Distance

Measure minimum distance between any two vertices, edges,
mid-edges, arc centers, faces or any combination of these entity
type.

Edge Length Measure the precise length of a edge.

Face Surface Measure the precise surface area.
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6.23.1 3D Snapping Modes
Snapping modes allow you to select or snap to different entity types on a model. For
example, if you select Vertex, all vertices are highlighted and a snap box appears when
you move the cursor over a vertex.

Snapping modes allow you to snap to the following entities:

The behavior of snapping modes change in regards to the
selected measurement option. For example, the behavior of arc center
is not the same for distance and minimum distance.

Table 6–11 3D Snapping Modes

6.23.2 Measuring Distance
Use the Distance option to measure the distance between two vertices, edges, arc axes,
faces or any combination of these entity types.

The following table details how the distance between two entities are measured using
snapping modes:

Vertex
Co-ordinates

Provide the coordinates of each vertex.

Note:

Button Description Behavior

Vertex
Highlights vertices on
the model.

A snap box appears when you hover the mouse
pointer over a vertex.

Edge Line
Highlights edges on
the model.

The edge is highlighted when you hover the
mouse pointer.

Note: When measuring Minimum Distance, the
finite edge is selected. However, when measuring
Distance, the infinite edge is selected.

Edge Middle
Highlights edges on
the model.

The edge is highlighted and a tooltip appears
indicating the middle edge coordinate when you
hover the mouse pointer.

Arc
Highlights arcs on the
model.

The arc is highlighted when you hover the mouse
pointer.

Arc Center
Highlights arcs and
circles on the model.

The arc is highlighted and a tooltip appears
indicating the arc center coordinate of the arc
when you hover the mouse pointer.

Note: When measuring Minimum Distance, the
arc center is selected. However, when measuring
Distance, the infinite arc axis is selected.

Face (Plane)
Highlights faces when
you move the cursor
over a face.

The face is highlighted when you hover the mouse
pointer.

Table 6–10 (Cont.) Measure Options

Name Description
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1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Distance tab.

3. Select the snapping modes you want to use for measuring.

See 3D Snapping Modes for more information.All entities of the selected snapping
modes are highlighted on the model.

4. From the Units list, select a measurement unit.

5. On the model, select an entity as the starting point for the measurement.

If you want to take more than one measurement from the same starting point,
select Fix Position.

6. Select the snapping modes that you want to select as the end point for the
measurement.

All entities of the selected entity types are highlighted on the model.

7. On the model, select the entity you want to measure to.

The distance from the first set of entities to the second set is highlighted by a line. The
measured distance, Delta X, Delta Y and Delta Z appear in the Measurement dialog.
Additionally, the coordinates for the center point of each entity displays in the From

and To fields.

To take another measurement click Reset.

Snapping
Model
Entities Vertex Line Arc Center Plane

Vertex Distance
between two
points.

The shortest
segment connecting
the point and the
line.

The shortest
segment
connecting the
point and the arc.

The shortest
segment connecting
the point and the
plane.

Line Distance between
two lines.

Note: The lines
must be parallel.

The line and axis
must be parallel.
Distance between
the line and arc
axis.

The distance
between the line and
the plane.

Note: The line must
be parallel to the
plane.

Arc Center Distance between
the axes of the arcs.

Note: Arc planes
must be parallel.

Distance between
the arc axis and the
plane.

Note: The plane and
the arc plane must
be perpendicular.

Plane Distance between
the two planes.

Note: The planes
must be parallel.
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6.23.3 Calibrating Distance
Calibrate the distance measurement.

1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.

The Distance Calibration dialog appears displaying the measured distance.

3. From the Units list, select the unit to which you want to calibrate the distance.

4. Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.

The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

6.23.4 Measuring Minimum Distance
Use the Minimum Distance option to measure the minimum distance between model
parts, as well as any two points from the selection sets: vertices, edges, mid-edges, arc
axes, arc centers, faces or any combination of entity types.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears displaying the measurement options.

2. Click the Min. Distance tab.

3. Click Set 1.

4. From the Snapping Mode section, select one of the following:

■ Select Entity if you want to measure the distance between model parts.
Snapping modes are disabled.

■ Select Geometry if you want to measure the distance between entity types.
Snapping modes are enabled.

5. If you selected Entity, select a part or parts on the model. If you selected Geometry,
select the snapping modes that you want to use for measuring.

To reset a set, click Clear. To clear items from a set, select the items and press the
Delete key. To deselect a part or entity type on the model, press the Control key
and left-click the part or entity type.

The model parts appear in the list under Set 1 and are highlighted on the model
and in the Model Tree. All entities of the selected entity type are highlighted on the
model.

6. Click Set 2.

7. Repeat Step 5. The model part appears in the list under Set 2.

8. From the Units list, select the unit in which you want to measure the distance.

9. Click Compute.
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The minimum distance from the first set of entities to the second set is highlighted
by a line. The measured minimum distance, X, Y, and Z coordinates for Position 1
and X, Y and Z coordinates for Position 2 appear in the Measurement dialog.

10. To take another measurement, click Reset.

11. Click Close to close the Measurement dialog.

6.23.5 Measuring an Angle
Use the Angle option to measure the precise angle between any three vertices or any
two edges, planes, faces or any combination of these entity types.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears.

2. Click the Angle tab.

3. Select the snapping modes that you want to use for measuring.

Entities of the selected types are highlighted on the model.

4. To measure the angle between an entity type and a plane, select the With Plane
check box, and then select the plane from the list.

5. From the Units list, select the unit in which you want to measure the angle.

6. Click two points on the model to define the angle.

Angle arms appear with an arc connecting them.

7. Click again to complete the measurement.

The angle is highlighted and the value of the angle measurement appears in the
dialog.

8. To take another measurement, click Reset.

6.23.6 Measuring an Arc
Use the Arc option to measure the precise radius, length and angles of any arc on the
model. You can also calculate the center point location.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears.

2. Click the Arc tab.

3. Select Arc Entity if you want to measure a predefined arc.

All arc and circles are highlighted on the model. Snapping modes are disabled.

4. Select From 3 Points if you want to measure the arc between three points.
Snapping modes are enabled.

5. Select the snapping modes that you want to use for measuring.

6. From the Units list, select the unit in which you want to measure the arc distance.

7. If you selected From 3 Points, click three points to define the arc.
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The points are joined by an arc. The measurements for center point coordinates,
radius, diameter, arc length, start and end of angle and sweep appear in the
Measurement dialog.

8. If you selected Arc Entity, click the edge of the arc that you want to measure.

To take another measurement click Reset.

The arc is highlighted. The measurements for center point coordinates, radius,
diameter, arc length, start and end of angle and sweep appear in the Measurement
dialog.

9. Click Close to close the Measurement dialog.

6.23.7 Calibrating an Arc
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.

The Radius Calibration dialog appears displaying the measured distance.

3. From the Units list, select a unit of measurement to which you want to calibrate
the distance.

4. Click Calibrate to and enter a value if you want to calibrate to a value.

5. Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.

The calibration results appear in the Arc tab.

7. Click Close to close the Measurement dialog.

6.23.8 Measuring Vertex Coordinates
The Vertex Coordinates option provides the coordinates of vertices on the model.

1. From the Analysis menu, select Measure.

From the AutoVue toolbar, you can also click Measure .

The Measurement dialog appears.

2. Click the Vertex tab. All vertices on the model are highlighted.

3. From the Units list, select the unit in which you want to measure.

4. Move the cursor over the highlighted vertex that you want to measure.

The X, Y and Z coordinates appear in a tooltip.

5. Select the vertex.

To take another measurement click Reset.

The X, Y and Z coordinates appear in the Measurement dialog.

6. Click Close to close the Measurement dialog.

6.23.9 Measuring the Length of the Edge
Use the Edge Length option to measure the length of any edge on the model.

1. From the Analysis menu, select Measure. The Measurement dialog appears.

From the AutoVue toolbar, you can also click Measure .
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2. Click the Edge Length tab.

All edges on the model are highlighted.

3. From the Units list, select the unit in which you want to measure the edge length.

If you want to cumulate the measurement of more than one edge, select
Cumulative.

4. Click the edge that you want to measure.

To take another measurement click Reset.

The edge length measurement appears in the Measurement dialog.

5. Click Close to close the Measurement dialog.

6.23.10 Measuring Face Surface
Use the Surface option to measure the surface area of an entity face or an entire entity
on the model.

1. From the Analysis menu, select Measure. The Measurement dialog appears.

From the AutoVue toolbar, you can also click Measure .

2. Click the Surface tab.

3. Select Face Surface if you want to measure the surface area of a face on an entity.

4. Select Entity Surfaces if you want to measure the surface area of an entire entity.

5. From the Units list, select the unit in which you want to measure the surface.

If you want to cumulate the measurement of more than one surface, click
Cumulative.

6. If you selected Face Surface, move the cursor on the model to highlight a face
surface, then click the face surface that you want to measure.

The face surface is highlighted. The measured surface appears in the Measurement
dialog.

7. If you selected Entity Surface, click the entity that you want to measure.

The entity, as well as all the faces belonging to the body are highlighted. The
measured surface of the body appears in the Measurement dialog.

8. To measure the face surface of the entity, click on the highlighted body.

A list appears displaying the entity and its parents.

9. Select the entity or a parent from the list.

To measure the face surface of a parent, select the parent from the list.

The selected entity is highlighted and the measured surface appears in the
Measurement dialog.

10. To take another measurement, click Reset.

11. Click Close to close the measurement dialog.

6.24 Walkthrough
The Walkthrough feature in AutoVue provides an interactive visualization of 3D
models.
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Figure 6–10 Walkthrough within AutoVue

In Walkthrough mode you can manipulate the view of a 3D model as if you are
walking or flying through the model, take measurements of the model, and change the
camera position and orientation. For example, when viewing a 3D model of house,
you can enter the front door and move between rooms and floors. All the while, you
have a 360 degree view of your surroundings and the ability to add markups.

The Walkthrough feature can also be utilized when using the Collaborate feature in
AutoVue. Observers can view the Controller’s walkthrough of the 3D model in
real-time. See Real-Time Collaboration for more information on the Collaborate
feature.

6.24.1 Walkthrough Dialog
To enter Walkthrough mode, from the View menu, select Walkthrough. The
Walkthrough dialog appears.

Figure 6–11 Walkthrough Dialog



Closing the Walkthrough dialog does not exit Walkthrough
mode. To exit, you must deselect Walkthrough from the View menu.

Walkthrough

Working with 3D Files 6-41

The Instructions panel explains the possible model manipulation options while you
perform the walkthrough. See Walking Through a 3D Model for more information.

From the Speed panel of the Walkthrough dialog, you can adjust the increment speed
of the camera for all walkthrough functions.

By default, the Move through walls option is selected. This feature allows you to walk
through walls when viewing a model. You can deselect the option to enable the
collision detection feature.

The Restore last view option saves the last view of the model before exiting
walkthrough mode. As a result, when you re-enter walkthrough mode, the last view
displays.

Select the Show walkthrough dialog at startup option to display the Walkthrough
dialog when you enter Walkthrough mode. Deselect the option to disable the
Walkthrough dialog on startup.

If you want to re-enable the Walkthrough dialog on startup,
from the Options menu select Configure. From the Configuration
dialog, select Miscellaneous and then select the Show walkthrough
dialog at startup check box. Refer to Configuring AutoVue for 3D
Files for more information.

6.24.2 Walking Through a 3D Model
If you want to position yourself on a surface of the 3D model, press the Alt key and
double-click a point on the surface. For example, to walk through a 3D model of a
house, you can Alt + double-click the landing in front of the door.

Once you are at your desired view point of the 3D model, you can use the arrow keys
or mouse to navigate through the model.

The following table lists the available keyboard/mouse actions and their function:

Note:

Note:

Table 6–13 Keyboard Actions and Functions

Keyboard Action Mouse Action Function

Up arrow, Down arrow Click and drag up, down, or roll the
mouse wheel forward and backward

Move forward, backward

Left arrow, Right arrow Click and drag left, right Turn left, right

Alt + Up arrow, Alt +
Down arrow

Alt + drag up, down

or

Mouse middle button click and drag
up, down

Move up, down
(Elevation)

Alt + Left arrow, Alt +
Right arrow

Alt + drag left, right or Mouse middle
button click and drag left, right

Side step left, right

Ctrl + Up arrow, Ctrl +
Down arrow

Ctrl + click and drag up, down Look up, down

Ctrl + Left arrow, Ctrl +
Right arrow

Ctrl + click and drag left, right Rotate
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6.24.3 Adding Markups in Walkthrough Mode
When walking through a 3D model you can add a Note markup entity.

The Note markup entity is the only markup supported in
Walkthrough mode.

1. From the Markup menu, select New.

From the Markup Properties toolbar, you can also click New Markup .

AutoVue enters Markup mode.

2. Create a Note markup entity. See Adding a Note for more information on how to
create Note markup entities.

You can continue walking through the model while creating new Note markup
entities.

3. Save your new markups. See Saving a New Markup File for more information.

The markups are saved.

4. To exit Markup mode, from the Markup menu, select Close All.

5. To view the 3D model’s associated Markup files, select Open from the Markup
menu. See Opening Markup Files for more information.

The Note markup entities appear in the Markup Entity tree, but not in the
workspace. To view the markups, double-click the Note entities in the Markup
Entity tree.

The markups open and the Note markup icon appears in the workspace.

Alt + double click Places camera
perpendicular to selected
plane

Note:

Table 6–13 (Cont.) Keyboard Actions and Functions

Keyboard Action Mouse Action Function
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Use the configuration options to configure the AutoVue workspace for different
groups of file formats or for all files in general. For example, you can set different
background colors for EDA, 2D, 3D, or Office files. You can also set paths to locate
external resources such as fonts, symbols, or configure measurement options. To access
the configuration options, from the Options menu, select Configure. The
Configuration dialog appears. To implement your changes and to close the
Configuration dialog, click OK.

7.1 General Options
To access the General configuration options, do the following:

1. From the Options menu, select Configure.

The Configuration dialog appears.

Figure 7–1 Configuration Dialog

2. From the Configuration tree, select General. The CAD, Raster, and System
Options appear.

7.1.1 Configuring Options for CAD Files
Configure how you want to display text, dimensions, line styles, and so on for CAD
files.
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7.1.2 Raster Files
Choose how you want the raster file to display:

Select Full Resolution to display raster files at full resolution.

Select Fit to Window to display raster files to fit the current window.

7.1.3 Rendering
When Enable Look Ahead is selected and you zoom into a part of a file, AutoVue
renders adjacent tiles. The advantage to this is improvement in performance when
zooming in on parts of a file. The disadvantage is that if the client machine is idle for at
least one second, Enable Look Ahead is triggered which could slow down current
operations. However, once all tiles are rendered, all zoom operations speed up again.

If Enable Look Ahead is deselected, AutoVue renders the tiles when requested, that is,
only when you zoom in on parts of the file.

7.1.4 Configuring Paths
Configure the paths for fonts. These path settings are read only if Resolve Local
Resources check box is selected.

When working with files that need external resources, such as fonts you may need to
specify the path to these external resources if they do not exist in the same location as
the base file.

Table 7–2 Different Path

Option Description

Text Select to display text entities.

Clear to hide text entities

Dimensions Select to display all dimensional entities.

Clear to hide all dimension entities.

Line Weights Select to display varying line thicknesses.

Clear to make all lines appear equal, with a width of 1 pixel. No line
weights display for the line.

Force to Black Select to force all colors of a drawing to black.

Clear to display the file in color.

Line Style Select to display dotted and dashed lines.

Clear to display all lines as solid.

Filling Select to display filled entities as filled rather than just an outline.

Clear to hide filling for filled entities.

Load External
References

Select to display external references (XRefs) automatically.

Clear to keep external references from displaying automatically.

Path Description

Font The directory paths for fonts required by AutoVue’s vector files.
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7.1.4.1 Configuring Font Paths
Font Paths are the directory paths for fonts required by 2D, 3D, EDA, or PDF files.

1. From the Category tree, expand General, and then select Font Paths.

2. Click Add.

The Add Path dialog appears.

3. Enter the directory path or scroll to locate the directory where the external font
files are located.

To browse all subdirectories below the current path, type two asterisks ** at the
end of the file path.For example, C:\samples\** will result in browsing all
subdirectories below “samples”. To browse one subdirectory below the current
path, type one asterisk * at the end of the file path. For example, C:\samples\* will
result in browsing one subdirectory below “samples”.

4. Click OK. To add more than one path to the list, repeat steps 3 to 5.

The directory path appears.

5. To change the order, select the path you want to move, then click Up or Down to
move the path to where you want it in the list.

6. To remove a path, select the path and click Remove. The selected path disappears
from the list.

7. Click OK to close the Configuration dialog.

7.1.5 Measurement
The Measurement options let you define the default measurement units and the
number of decimal places.

From the Configuration tree, expand General, and then select Measurement to
display the options you need.

The available options are as follows:

Table 7–3 Measurement Options

7.1.6 Configuring the Base Font for Archive and Text Files
The Base Font option lets you define the font properties for archive, text, and
spreadsheet files.

1. From the Category tree, expand General, and then select Base Font.

2. Select a font from the Font list.

3. Select a font size from the Size list.

4. Select the Bold option, Italic option, or both options to change the font style.

You can see a preview of the text in the Sample area.

Option Description

Decimal Digits Lets you specify the number of decimal digits displayed for each
measurement. Enter a number from 1 to 18.

Default File Units Lets you specify the units to use for drawings when the
drawings do not contain units.

Measurement Units Lets you specify the default unit to use for measurements.
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5. Click OK to apply the font change and close the configuration dialog.

7.2 Configuring AutoVue for 2D Files
1. From the Options menu, select Configure.

The Configuration dialog appears.

2. Select 2D in the tree. The 2D options appear.

7.2.1 Snap Settings
In measurement mode, when you move the cursor within a predetermined snap
radius, the snap box appears for the entity to be selected. To change the snap radius,
change the value in the Snap Radius field. The snap radius is configured in pixels.

You must restart the AutoVue client for the configuration to
take effect.

7.2.2 Overlays Extents Settings
When you add overlays, AutoVue automatically tries to scale the overlay extents to
match the base file extents. If you wish to disable this behavior, clear the Match Extents
check box in the Overlays section of the 2D Configure dialog.

7.2.3 Configuring Colors
The Colors settings let you modify colors for 2D files.

From the tree, expand 2D, and then select Colors to display the following options:

Table 7–4 Color Options

7.3 Configuring AutoVue for 3D Files
There are configuration options that you can set to customize the work environment
when working with 3D files.

1. From the Options menu, select Configure.

The Configuration dialog appears.

2. From the Category tree, select 3D. The Rendering, Dynamic Rendering, and
Frame Rate options appear.

7.3.1 Rendering
The Rendering options let you modify the manner in which the model is rendered.

Changing these options affects the level of detailed displayed. The Rendering options
are:

Note:

Option Description

Background Change the color of the background for 2D files.

Measurement Modify the color you want displayed when taking measurements on 2D
files.
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7.3.2 Dynamic Rendering
The Dynamic Rendering options let you select the rendering mode for a model in
motion.

The options you can select are:

Table 7–6 Dynamic Rendering Options

7.3.3 Frame Rate
The Frame Rate slider lets you define the frame rate for rotating and dynamic
zooming on 3D files. Drag the slider to specify the frame rate. Drag the slider to the
left for a lower frame rate and to the right for a higher frame rate.

A higher frame rate results in a lower resolution.

7.3.4 Optimized Rendering
Select the Enable Optimized Rendering option to accelerate the rendering time of
drawings.

You must restart your AutoVue client after selecting or
de-selecting this option to apply the setting.

Option Description

Smooth Shading Set by default. Turning this option off renders curved surfaces of
shaded models as a series of flat surfaces. The level of detail is thus
reduced but render speed is increased.

Only affects shaded models.

Back-Face Removal If selected, instructs AutoVue not to render the back faces of the
model being displayed. This increases the render speed but the
model appears less realistic while in motion.

Only affects shaded models.

Tristrip If selected, enable/disable tristripping of mesh data for display.

Menu Option Description

Fast Frame Model spins or rotates at a fast rate. The level of detail is
reduced, which enables faster rendering when the model is in
motion.

Wire Frame Model is displayed as wire framed during rotation or spinning.

Flat Shading Smooth shading is not performed on curved surfaces while the
model is in motion.

Wire Polygons Render the model in wire polygon mode while in motion.

Vertex Cloud Model is displayed as a skeleton of vertices when in motion.

Bounding Box Model parts are enclosed by bounding boxes when the model is
in motion.

Current Render Mode Model is rendered in the same mode whether moving or static.

Note:
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7.3.5 Model
The Model configuration options let you control the streaming method, the dynamic
load mesh resolution, and the visibility of model parts.

From the Category tree, expand 3D, and then select Model to load the Loading,
Dynamic Load Mesh Resolution, Initial Visibility, and PMI Initial Visibility
options.

7.3.6 Loading
Control the streaming method with the Dynamic Loader option.

When the option is selected, AutoVue loads enough detail to display an accurate
visual representation of the model. The data is loaded based on the level of detail that
is necessary at that point in time.

When the option is deselected, AutoVue requests data in 10% chunks until it reaches
full resolution for the file. You would see the model initially at coarse resolution, but
continuously refining.

7.3.7 Dynamic Load Mesh Resolution
Control the initial resolution with the Dynamic Load Mesh Resolution slider.

When you select Dynamic Loader, you can control the initial resolution by setting the
Dynamic Load Mesh Resolution. When you set the Dynamic Load Mesh Resolution
to High, the file displays at a higher resolution when you zoom, resulting in a
smoother look.

For more information, refer to the Installation and Configuration Guide.

7.3.8 Initial Visibility
With the Initial Visibility options, you can specify the visibility of model parts when
first opening a 3D file.

Table 7–7 Visibility Options

7.3.9 PMI Initial Visibility
With the PMI Initial Visibility option, you have the option to set a threshold for the
number of PMIs to display for large models. To do, select the Don’t display PMI for
large models check box, and then enter the number of PMIs to display in the PMI
Threshold field.

7.3.10 PMI Filtering
From the tree, expand 3D, and then select PMI to display the PMI options.

The PMI Filtering options let you configure which types of product and
manufacturing information to display. The check boxes in the Tree column let you

Option Description

Default Visibility Load model with default visibility options.

All Visible Force all parts On in the display.

All Invisible Force all parts Off in the display.To display model parts, select
the part(s) from the Model Tree.
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select which PMI entity types display in the 3D model tree. The check boxes in the
View column let you select which PMI entity types display in the workspace.

The following PMI Text Rendering Style options let you define the style for the PMI
text:

Table 7–8 PMI Filtering Options

7.3.11 Configuring Color
With the Color options, you can configure the color to allow easier viewing of 3D file
details.

From the Configuration tree, expand 3D, and then select Colors to view the available
Color options. They are grouped under Common, Section Highlight, and Geometry
Highlight, as follows:

7.3.11.1 Common

Table 7–9 Common Options

7.3.11.2 Section Highlight

Table 7–10 Section Highlight Options

7.3.11.3 Geometry Highlight

Table 7–11 Geometry Highlight Options

Option Description

Native Setting (from file) PMI text displays with the default setting

3D PMI text displays in 3-dimensions. It may not always face you.

Flat-to-screen PMI text always faces you.

Option Description

Background Set the background color for 3D view.

Selection Set the color when selecting a model or model parts.

Min Distance Set 1 Set the color of the first set-point when measuring minimum
distance.

Min Distance Set 2 Set the color of the second set-point when measuring minimum
distance.

Option Description

Edges Set the color for the section edges when defining Section Cut Options.

Fill Set the fill color when defining Section Cut Options.

Option Description

Vertex Set the color for vertices when highlighted during measurement and
markup.

Face Set the color for faces when highlighted during measurement and markup.

Edge Set the color for edges when highlighted during measurement and markup.
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7.3.12 Configuring Background
With the Background options, you can select a gradient or an image to display in the
background. From the Configuration tree, expand 3D, and then select Background.
The Background Gradient and Background Images options appear.

7.3.12.1 For the Background Gradient option
Select either Plain, Directional Gradient, or Radial Gradient. The background is
previewed to the rights of the options.

7.3.12.2 For the Background Images option
This feature adds a single or multiple background images to the workspace.

1. Click Add. The Background Image dialog appears.

2. Click on the ellipses to the right of the Image File field to browse to the image file.

You can only select .bmp, .jpeg, or .img files.

3. From the Stretch Type list, select whether to leave the image as is, Stretch to fill,
Zoom to fit, or Zoom to fill.

4. From the Position in the Background list, select where to position the image and
then click OK.

5. To add multiple background images, repeat steps 1 through 4.

6. You can change the order of the background images. To do so, select a file from the
Background Images list and then click Up to move an image to the front and
Down to send an image to the back.

7. To edit the background image, select the file from the Background Images list and
then click Edit.

The Background Image dialog appears. Edit as required.

8. To remove a background image, from the Background Images list, select the file
and then click Remove.

9. Click OK when done. The selected background image is implemented.

7.3.13 Miscellaneous
From the Configuration tree, expand 3D, and then select Miscellaneous to display the
Miscellaneous options:

7.3.13.1 Display
The Show Global Axes option is active by default. Disable this option to remove the
axes that display in the bottom-right corner of the workspace.

You can change the size of the global axes by moving the Size of Axes slider. Move the
slider to the left to minimize the axes and to right to maximize

7.3.13.2 Model Tree
Enter a value in the Expand Level field to define the level at which you want the
Model Tree to display when opening a 3D file. The default level is 3.

Alternately, select Expand On Demand to the collapse the whole tree.
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7.3.13.3 Manipulator
Enable the Align with current UCS option to automatically align the manipulators
with the current User-defined Coordinate System.

7.3.13.4 Selection
The following Selection options let you define how AutoVue indicates that an object is
selected:

Table 7–12 Selection Options

7.3.13.5 Walkthrough
The following Walkthrough options let you configure the view to use when you enter
walkthrough mode and to control whether or not you want to see the Walkthrough
dialog at startup:

Table 7–13 Walkthrough Options

7.4 Configuring AutoVue for EDA Files
There are configuration options that allow you to customize your work environment
when working with EDA files. To access the EDA configuration options, from the
Options menu, select Configure. In the Configuration dialog that appears, select EDA
in the tree.

7.4.1 Customizing Selections
Configure how you want selected components to be highlighted. From the
Configuration tree, select EDA. There are two selection options: Highlight Entity and
Dim Unselected.

7.4.1.1 Highlight Entity
Activate this option to highlight all entities that you select. This option is enabled by
default.

The default highlight color is yellow.

See also Modifying Colors

Option Description

Highlight Bounding Box Selection is enclosed in a wireframe box.

Highlight Entity Selection is indicated by changing color.

Option Description

Restore Last View Select this option to save the last view of the model before
exiting walkthrough mode. As a result, when you re-enter
walkthrough mode, the last view displays.

Show Walkthrough dialog
on startup

Select this option if you want the Walkthrough dialog to display
when you start walkthrough mode. Clear this option if you do
not want to see the Walkthrough dialog on startup.

Note:
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7.4.1.2 Dim Unselected
Activate this option to dim all the entities that are not selected. Selected entities retain
their original entity color.

From the AutoVue toolbar, you can also click Dim Unselected .

When you select Dim Unselected, you can set the dimness level for entities that are
not selected. Drag the slider to the right to increase the dimness level and to the left to
decrease the dimness level. The icon to the right of the dimness settings in the
Configuration dialog lets you preview the dimness level.

Additionally, with Dim Unselected, you can select the Thicken Highlighted Entity
check box. This option makes the selected entity appear more pronounced. De-select
the check box to return the entity to its default thickness.

7.4.2 Displaying Tooltips
When you hover the mouse over an entity, a tooltip appears to show you information
about the entity. You can disable or enable these tooltips. When the option is selected,
AutoVue automatically retrieves the entity information from the server. Clear this
option if you do not want this behavior every time your mouse hovers over an entity.

1. From the tree, select EDA.

2. Under the Mouse Hover heading, select or de-select the Show Entity Information
Tooltip option.

3. Click OK.

7.4.3 Modifying 3D View
You can configure the board thickness and component height for the 3D PCB view of
EDA files. Note that these Board Thickness and Component Height values are used
only if the underlying EDA file does not contain board thickness and component
height information.

1. From the Configuration tree, select EDA.

2. Enter a value in the Default Board Thickness field to change the board’s
thickness.

The Default Board Thickness option only affects boards that have no board
thickness defined in the design. If a board has a defined thickness, this option does
not affect that board.

3. Enter a value in the Default Component Height field to change the component
height.

The Default Component Height option affects components that do not have height
defined in the design. If a component has a defined height, this option does not
affect that component.

4. To work with a different unit of measurement, select another unit from the Default
Units list. This is the unit of measurement used for values set in the Default Board
Thickness and Default Component Height fields.

5. Reload the file to see your changes.
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7.4.4 Synchronizing Layers when Comparing Files
When you compare files, you can synchronize all layer settings. When the layer
settings are synchronized, changing one setting changes the same setting for both files
you are comparing.

This option is selected by default and is only applicable for
PCB drawings.

1. From the tree, expand EDA, and then select Analysis.

2. Select the Layer Settings option to synchronize all layer settings when comparing
files.

7.4.5 Configuring Zoom Behavior when Cross Probing
You can configure the zoom options when you cross probe files.

1. From the tree, expand EDA, and then select Analysis.

2. Select one of the following Cross Probe Action options:

a. Select Keep Current Zoom Level. When this option is active, the view of the
target files remains the same while you cross probe.

b. Select Zoom Selected to automatically zoom in on selected entities while you
cross probe. This option is enabled by default.

c. Select Zoom Fit to automatically adjust the contents of a file along the
horizontal and vertical axis to fully display within the current window.

7.4.6 Modifying Colors
You can configure the colors for EDA files.

From the tree, expand EDA, and then select Colors.

In the Color Options dialog, the options that you can configure are grouped under
Common, PCB, and 3D View as follows:

7.4.6.1 Common

Table 7–14 Common Options

7.4.6.2 PCB

Note:

Option Description

Background Set the background color for 3D view.

Selection Set the color when selecting a model or model parts.

Table 7–15 PCB Options

Option Description

Min Distance Set 1 Set the color of the first minimum distance set.

Min Distance Set 2 Set the color of the second minimum distance set.
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7.4.6.3 3D View

Table 7–16 3D View Options

7.4.7 Enhanced Display Options
You can configure the following enhanced display options for EDA files:

Table 7–17 Display Options

7.5 Configuring Background Colors for Graphic Files
Specify background colors for mono raster files and color raster files.

1. From the Options menu, select Configure.

The Configuration dialog that appears.

2. Select Graphics in the tree.

Plated Drill Hole Set color for plated drill holes. The default color is black.To
override the native color, select Override Native Color.

Note: Applicable to Cadence Allegro format only.

Non-Plated Drill Hole Set color for non-plated drill holes. The default color is black.To
override the native color, select Override Native Color.

Note: Applicable to Cadence Allegro format only.

Option Description

Default Board Color Configure the color of the board in 3D view.

Default Component Color Configure the component color in 3D view.

Main Menu Option Description

Display Options Plated Hole Visibility Select whether to use the native settings or
turn on /off the plated hole visibility.

Note: Applicable to Cadence Allegro format
only.

Non-plated Hole
Visibility

Select whether to use the native settings or
turn on /off the non-plated hole visibility.

Note: Applicable to Cadence Allegro format
only.

Pad Filling Select whether to use the native settings or
turn on /off the pad filling.

Note: Applicable to Cadence Allegro format
only.

Line Caps/Joins Select whether to use the native settings or
turn on /off the line caps/joins.

Note: Applicable to Cadence Allegro format
only.

Global Transparency Move slider to select global transparency
level.

Table 7–15 (Cont.) PCB Options

Option Description
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3. From their respective Background lists, select colors for monochrome raster files
and color raster files.

7.6 Configuring Background Colors for Desktop Office
Specify background colors for the following types of Desktop Office files: Document,
Spreadsheet, Database and Archive.

1. From the Options menu, select Configure.

The Configuration dialog appears.

2. Select Desktop Office in the tree.

3. Select a background color for each Desktop Office file type.
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AutoVue has the ability to view many file formats and to create markups for all its
readable file formats without the document's authoring application.

Marking up refers to drawing and writing on an electronic document. When you
create a markup for a file, the markup is created on top of the original file. Markups
entities are saved in Markup files.

If a document has existing Markup files, the Markup Indicator icon appears in the
status bar at the bottom of the AutoVue workspace. Clicking the Markup Indicator
opens the Markup Files dialog and allows you to select the Markup files to display.

Figure 8–1 Markup Files Dialog

When you open a Markup file, AutoVue layers the markup over the original file.

In Markup mode you can:

■ Create entities such as text, arcs, boxes, circles, clouds, lines, arrows, and polygons.
Note that AutoVue exits markup creation mode after you create a markup entity.
In previous releases of AutoVue, you were able to continue adding markups until
you right-click the workspace.

■ Add a stamp or information to an entity by adding a text or a note.

■ Create, name, and color layers to organize your work.

■ Create a new Markup file that combines copies of selected layers of different
Markup files.

■ Create measurement markup entities that can be moved or resized. Note that
measurements made in Markup mode have up to a 1% margin of error.

■ Navigate markups through a hierarchy tree, view markup properties, and sort the
tree according to each property.
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■ View markup layers individually or in combination.

■ When in Markup mode, you can press Shift+Left Mouse button to select multiple
markups entities in order to drag or copy and paste to a new location.

■ Press Esc at any point to cancel the markup creation.

8.1 Markup Navigation Tree
When you are in Markup mode, a Markup Navigation Tree appears below the
workspace. If the tree does not appear, from the Options menu, select Show Panel, and
then select Markup Panel.

Figure 8–2 Markup Navigation Tree

The tree displays a hierarchy of markups or comments created by users. You can
navigate through the markups. A set of properties is generated for each markup. You
can sort the markups in the tree according to each property by clicking the column
headers. These properties are:

Table 8–1 Properties

When a markup entity is created, it appears in the tree and the information is recorded
and saved in the Markup file.

Hover your mouse over an entity to display its author and
date properties.

8.2 Filtering Markups
When viewing markups, you have the option to filter the Markup files or entities that
are displayed based on their metadata information.

To do so, from the Markup menu, select Filter and then select one of the following
options: By Author, By Entity Types, By Last Modified, By Page, and By Layer. The
Filter Markup Visibility dialog appears.

■ To display markups created by a specific author, click the Author tab and select
the check box next to the author’s name. To remove an author’s markup from the

Property Description

Markup Entity Type of markup entity created.

Author The name of the user who created the markup entity.

Last Modified The date and time the markup entity was last modified.

Page Page number of the original document on which the markup
entity is created.

Layer Markup layer on which the markup entity is created.

Note:
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filter, de-select the associated check box. In the Markup Navigation Tree, a filter
icon appears in the Author column header.

■ To display markups by entity type, click the Markup Entity tab and select the
check box next to the markup entity or entities. To remove a markup entity from
the filter, de-select the associated check box. In the Markup Navigation Tree, a
filter icon appears in the Markup Entity column header.

■ To display markups based on when they were last modified, click the Last
Modified tab. From the list, select one of the following options:

Table 8–2 Options

In the Markup Navigation Tree, a filter icon appears in the Last Modified column
header.

■ To display markups by page location, click the Page tab and select one of the
following:

Table 8–3 Page Options

■ To display markups by layers, click the Layer tab and select the check box next to
the layer or layers. To remove a layer from the filter, de-select the associated check
box. In the Markup Navigation Tree, a filter icon appears in the Layer column
header.

To remove the filters, from the Markup menu, select Filter, and
then select Show All.

8.3 Ad Hoc Markups

This section only applies to AutoVue for Agile PLM.

Ad hoc markups are only available if the file folders are made
available to end users.

Option Description

Anytime Displays all markup entities.

Before Displays all markup entities modified before the selected date.

After Displays all markup entities modified after the selected date.

On Displays all markup entities modified on the selected date.

Between Displays all markup entities modified between the selected dates.

Option Description

All Pages Displays markup entities on all the pages.

Current page Displays markup entities on the currently selected page.

Page range Displays markup entities on the selected page range.

Note:

Note:

Note:
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Ad hoc 2D, 3D, and EDA markups can be done from the Files tab in the file folder
object. Change order controlled 2D, 3D, and EDA markups can be done from the
Redline Attachments tab in the ECO. When you view a markup file, the original
document, also known as the base file, opens too.

Change order-controlled and ad hoc markups are independent
from each other.

To view change order-controlled markups, open the redlined file from the appropriate
revision of the item Attachments tab or from the change order Redline Attachments
tab.

8.3.1 Guidelines for Marking Up or Redlining Attachments

This section only applies to AutoVue for Agile PLM.

With appropriate privileges, you can redline Microsoft Office documents, 2D, 3D, and
EDA files on the Files tab of a file folder object and redline 2D, 3D, and EDA files on
the Redline Attachments tab, accessible from the Affected Items tab of an ECO.

You can create and edit file markups only through the Affected
Items tab of an ECO or the Files tab of a file folder object. Your Agile
administrator must give you privileges that allow you to mark up or
redline attachments. For more information about ECOs and file folder
objects, refer to the Getting Started with Agile PLM Guide.

The following sections provide information on how to markup files from an ECO in
Web and Java clients.

8.3.2 Web Client ECO Markups for Agile PLM 9.3.x

If the item has already been redlined, then the Has been
redlined icon is displayed for that item row in the Affected Items
table. An icon appears on the Redline Attachments tab to indicate that
the attachment in that row has been redlined. To initiate redlining,
select the attachment row you want to redline and click Redline.

To markup or redline an attachment file from an ECO in the Web Client:

1. If you have not already done so, add an item with an attachment to the Affected
Items tab of an unreleased ECO. The item now has a pending revision associated
with the unreleased ECO.

When redlining an attachment through an ECO, the pending revision attachment
Folder Version must be set to a specific version number; if the Folder Version is set
to LATEST-x, you will not be able to create redline markups. However, you can
edit the Folder Version on the Attachments tab of the pending revision so that it
refers to a specific Folder Version.

Note:

Note:

Note:

Note:
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For example, if the pending revision of the item refers to Folder Version LATEST-7
of the file folder, select that row on the Attachments tab, double-click the Versions
field to edit it and then select 7. Click Save to complete the edit process. You can
now create redline markups for that attachment. On the Affected Items tab, in the
redline Attachment tab, select the row and click Redline.

2. On the Affected Items tab, select the row of the Item you want to redline. The
redline tabs for the selected item appear in the lower section of the Affected Items
tab.

3. On the Redline Attachments tab, select one or more rows and click Redline (this
button is only active when markups are allowed).

4. Add your markups to the attachment.

ECO markups are saved against and associated with the pending revision of the
item. If the ECO is released without first replacing the file, the markups appear
against the released revision of the item.

To ad hoc markup or redline an attachment file from a File Folder object in the Web
Client:

1. On the Files tab of a file folder object, select one or more rows and click Redline
(this button appears only when markups are allowed).

2. Add your markups to the attachment.

Ad hoc markups are saved against and associated with the version of the file
folder object.

8.3.3 Java Client ECO Markups
To markup or redline an attachment file from an ECO in Java Client:

1. If you have not already done so, add an item with an attachment to the Affected
Items tab of an unreleased ECO. The item now has a pending revision associated
with the unreleased ECO.

When redlining an attachment through an ECO, the pending revision attachment
Folder Version must be set to a specific version number; if the Folder Version is set
to LATEST-x, you will not be able to create redline markups. However, you can
edit the Folder Version on the Attachments tab of the pending revision so that it
refers to a specific Folder Version.

For example, if the pending revision of the item refers to Folder Version LATEST-7
of the file folder, select that row on the Attachments tab, double-click the Versions
field to edit it and then select 7. Click OK to complete the edit process. You can
now create redline markups for that attachment. Select the added item on the
Affected Items tab of the ECO.

2. On the Redline Attachments tab, select the row containing the file you want to
redline and click the Do Redlining icon in that row.

3. When AutoVue opens, click Markup. (This button is available only when markups
are allowed.)

4. Add your markups to the attachment.

ECO markups are saved against and associated with the pending revision of the
item. If the ECO is released without first replacing the file, the markups appear
against the released revision of the item.

To ad hoc markup or redline an attachment file from a File Folder object in Java Client:
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1. Double-click the row containing the file you want to redline.

2. When AutoVue opens, click Markup. (This button is available only when markups
are allowed.)

3. Add your markups to the attachment.

Ad hoc markups are saved against and associated with the version of the file
folder object.

8.3.4 Redlining Markups for Change Orders
The change order redlines of 2D, 3D, and EDA files are based on the pending revision
of the item. The markup changes are visible from either the change order's Redline
Attachments tab or from the pending revision item Attachments tab.

AutoVue 3D features and access to 3D files are available only
with AutoVue applications that support 3D files. AutoVue features for
schematic and PCB files, also referred to as EDA files, are available
only with AutoVue applications that support those files. For more
information about purchasing or installing AutoVue, contact Oracle
Consulting - Agile Practice.

8.3.4.1 Viewing ECO Redlines from the Attachments Tab of the Item Pending
Revision
You can view the change order markup redlines of the pending revision by displaying
the Attachments tab of the item pending revision. For example, revision (C)
ECO000453.

■ In Web Client, click the Has been redlined icon (for versions 9.2.2.x and 9.2.1.x, for
version 9.3.x) n the row of the file you want to view.

■ In Java Client, select the redlined file you want to view and click the Has been
redlined icon.

If you have checked out the redlined file and checked in a new version from the
Attachments tab, the Has been redlined icon does not appear on the Attachments
table.

To view the redlines of previous versions in Web Client:

1. For 9.2.2.x/9.2.1.x, from the Attachments tab of the pending revision, click the
Show Versions icon in the row you want to view.

For 9.3.x, select View Versions from the Actions menu.

The Versions dialog appears.

2. On the version row for which you want to view redlines, click the Has been
redlined icon (for versions 9.2.2.x and 9.2.1.x, for version 9.3.x).

If you need to determine which file folder version is associated with the change
order redlines, refer to the change order History tab.

To view the redlines of previous versions in Java Client:

■ On the Attachments tab of the pending revision, select the row you want to view.

■ Click Show Versions. The Versions dialog appears.

■ On the version row for which you want to view redlines, double click Has been
redlined.

Note:
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If you do not replace the attachment file on the pending revision item prior to the
change order release, you can access the redlines only from the released revision of
the item. The following diagram shows an example of the change order
attachment redlining process.

See also Product Collaboration User Guide and Getting Started with Agile PLM
User Guide.

The following is an example of the change order attachment redlining process.

Figure 8–3 Process to change order attachment redlining
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8.3.5 Markup Promotion

This section is only applicable for AutoVue for Agile PLM.

Markup promotion is the ability to bring forward, or promote:

■ Change markup promotion between versions within the same pending revision of
the change order.

■ Ad-Hoc markups from older file folder versions to the newer versions.

This allows you to re-validate older markups against a new design.

8.3.5.1 Markup Promotion for Change-Based Markups
To promote change-based markups in Web Client:

1. Open the change order and display the Affected Items tab.

2. On the Affected Items tab, select the row of the item you want to redline. The
redline tabs for the selected item appear in the lower section of the Affected Items
tab.

3. On the redline Attachments tab, select one or more rows and click Redline. (This
button is active only when markups are allowed).

4. When AutoVue opens, create a new markup. From the AutoVue Markup menu,
select New.

5. From the AutoVue menu, select Open.

The Markup Files dialog appears.

6. Click the All Revisions check mark.

AutoVue displays all valid markups. The available markups are associated to files
that have the same file extension as the file you are viewing.

7. Select the markup files you want to promote to the current markup.

8. Click OK.

The promoted markups display in the file you are currently viewing.

9. To save the promoted markups with the change order revision, save the markups
before exiting the viewer. From the AutoVue Markup menu, choose one of the
Save commands.

To promote change-based markups in Java Client:

1. Open the change order and display the Affected Items tab.

2. On the Redline Attachments tab, click the Do Redlining icon in the row
containing the file you want to redline.

3. When AutoVue opens, create a new markup. In the AutoVue Markup menu,
choose the New command.

4. In the AutoVue Markup menu, choose the Open command.

5. Click the All Revisions check mark.

AutoVue displays all valid markups. The available markups are associated to files
that have the same file extension as the file you are viewing.

6. Select the markup files you want to promote to the current markup.

Note:
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7. Click OK.

The promoted markups display in the file you are currently viewing.

8. To save the promoted markups with the change order revision, save the markups
before exiting the viewer. From the AutoVue menu, choose one of the Save
commands.

8.3.5.2 Markup Promotion for Ad-hoc Markups
To promote file folder ad hoc mark ups in Web Client:

1. Open the file folder object and display the Files tab.

2. To initiate redlining, select the Files table row you want to redline and then click
Redline.

3. When AutoVue opens, create a new markup. In the viewer Markup menu, select
New.

4. In the AutoVue Markup menu, select Open.

The Markup Files dialog appears.

5. Click the All Revisions check mark.

AutoVue displays all valid markups. The available markups are associated to files
that have the same file extension as the file you are viewing.

6. Select the markup files you want to promote to the current markup.

7. Click OK.

The promoted markups display in the file you are currently viewing.

8. To save the promoted markups with the change order revision, save the markups
before exiting the viewer. From the AutoVue Markup menu, choose one of the
Save commands.

To promote change-based markups in Java Client:

1. Open the file folder object and display the Files tab.

2. Click the Do Redlining (or Has been redlined) icon on the row of the file you want
to redline. (This button is available only when markups are allowed.)

3. When AutoVue opens, create a new markup. In the viewer Markup menu, select
New.

4. In the AutoVue Markup menu, choose the Open command. The Markup Files
dialog appears.

5. Click the All Revisions check mark.

AutoVue displays all valid markups. The available markups are associated to files
that have the same file extension as the file you are viewing.

6. Select the markup files you want to promote to the current markup.

7. Click OK.

The promoted markups display in the file you are currently viewing.

8. To save the promoted markups with the change order revision, save the markups
before exiting the viewer. From the AutoVue menu, choose one of the Save
commands.
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8.4 Working with Markup Files
Markups can be saved as separate Markup files while working with the same
document. You have the option to add user information to the Markup file, save and
create separate Markup files with different markup IDs, import and export Markup
files, or change the active Markup file.

8.4.1 Saved States
When you create and save a Markup file, with the exception of PDF files, the view
state of the file is also saved. View states include zoom level (extents), rotation settings,
transformation, section plane, and visibility. When creating markups for 3D files
containing imported models, the imported design becomes part of the view state. For
EDA files, you can save user-defined layers sets with markups.

See Creating a User-Defined View.

State information is also saved with each markup entity. For instance, if you were at a
certain zoom level when you created a markup entity, AutoVue saves the information
with the markup entity. To “Go To” the state you were at when you created or
modified the markup entity, from the Markup tree, right-click the markup entity and
then select Go To.

When selecting Go To feature when viewing PDF files,
AutoVue highlights the markup entity and preserves the current zoom
level.

8.4.2 Creating a Markup File
To create a markup file, do the following:

1. View a file that you want to markup.

From the Markup menu, select New.

2. From the Markup Properties toolbar, you can also click New Markup .

AutoVue enters Markup mode and a new Markup file appears in the Markup
Navigation Tree.

See Also Creating a Markup Layer.

8.4.3 Entering Markup Information
When creating a markup you can provide user information that you can save with the
markup.

From the Markup menu, select Properties. The Markup Information dialog appears.

Enter a user name, department, company name, company location, and telephone
number. Click OK to save your markup information and to close the dialog.

8.4.4 Saving a New Markup File
To save a new markup file, do the following:

1. From the Markup menu, select Save.

From the Markup Properties toolbar, you can also click Save Markup .

Note:
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The Save Markup File As dialog appears displaying the Markup Information that
you entered when creating the markup.

Figure 8–4 Save As

2. In the Markup ID field, enter an ID consisting of any combination of characters or
numbers.

3. Click OK.

The Markup file is saved. The markups and the Markup file remain displayed in the
workspace and in the Markup Navigation tree.

8.4.5 Opening Markup Files
To open the markup files, do the following:

1. View a file that has existing markups.

2. From the Markup menu, select Open.

From the AutoVue toolbar, you can also click Open Markup(s), or from the
bottom-left corner of the status bar, you can click Markup Indicator, From the
bottom-left corner of the status bar, you can click Markup Indicator.

If the Markup Indicator icon does not display, then the file you opened has no
existing markups associated to it.

The Markup Files dialog appears.

3. From the Markup list, select the check box next to Markup file you want to open.

If you select more than one Markup file, the Active Markup menu lets you select
which one of them is initially active. See Setting the Active Markup File for more
information.

4. Click OK. The selected markup or markups appear in the workspace on top of the
original file.

When you select more than one Markup file, the markups
display simultaneously.

8.4.6 Saving an Existing Markup File
To save a modified existing Markup file, from the Markup menu, select Save.

From the Markup Properties toolbar, you can also click Save
Markup.

Note:

Note:
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If you have multiple markups open that you have modified and want to save them all,
from the Markup menu, select Save All.

To save an existing markup as a new markup, from the Markup menu, select Save As.

8.4.7 Importing a Markup File
To import a Markup file on top of the original file:

1. From the Markup menu, select Open.

From the AutoVue toolbar, you can also click Open Markup(s).

The Markup Files dialog appears.

2. Click Import. The Select Markup File to Import dialog appears.

3. Navigate to the markup file that you want to import and select it.

4. Click Open. The imported Markup file appears in the workspace on top of the
original file.

8.4.8 Exporting a Markup File
To export a Markup file on top of the original file:

1. From the Markup menu, select Save As.

For a new Markup file, you can also click Save Markup.

The Save Markup Files dialog appears.

2. Click Export. The Save As dialog appears.

3. Navigate to the markup file that you want to export the markup file.

4. Enter filename.

5. Click Save. The Markup file is exported to the selected directory.

The default format saved is Markup Files (*.*), but you can select another one. In the
Save as Type list, there are six formats to choose from:

■ Markup Files (*.*)

■ DXF Output (*.dfx)

■ AutoCAD DWG (*.dwg)

■ Microstation DGN Output (*.dgn)

8.4.9 Setting the Active Markup File
A file can have several Markup files. When you open several Markup files
simultaneously, you can set one as the active Markup file. Any changes you make is
applied to the current active markup.

1. From the Markup menu, select Open.

From the AutoVue toolbar, you can also click Open Markup(s) , or from the
bottom-left corner of the status bar, you can click Markup Indicator .

If the Markup Indicator icon does not display, the file you opened has no existing
markups associated to it.

The Markup Files dialog appears.
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2. From the Markup list, select the markup or markups you want to open.

3. From the Active Markup list, select the markup you want to make active.

An active markup displays in bold in the Markup Navigation Tree.

4. Click OK. The selected markups appear in the AutoVue workspace.

8.4.10 Changing the Active Markup File
When you have multiple Markup files open, you can change the active markup.

An active markup displays in bold in the Markup Navigation
Tree.

Take one of the following steps:

■ In the tree, right-click the name of the Markup file you want to make active, then
select Set Active.

■ From the Markup toolbar, you can set the active markup by selecting a markup
from the list on the Markup Properties toolbar.

■ Take the following steps:

From the Markup menu, select Set Active. The Set Active Markup dialog appears.
From the Select Active Markup list, select the markup you want to make active. Click
OK to make the selected Markup file active.

8.5 Working with Markup Layers
Markup files can be divided into layers with each layer having its own unique name.
You can create, name, and color layers to organize your work. For example, different
colors can indicate time priorities and each layer can contain markups with a common
purpose.

When working with markup layers, you can view layers individually or in
combination, add, rename, or delete layers. You can also specify a different color for
each layer.

The default layer color is red.

See Also Moving a Markup Entity to Another Layer.

8.5.1 Creating a Markup Layer
From the Markup Layers dialog, you can create a markup layer.

1. From the Markup menu, select Markup Layers.

The Markup Layers dialog appears.

Note:

Note:
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Figure 8–5 Markup Layers

2. Click New. The New Markup Layer dialog appears.

3. Enter a name for the markup layer.

4. Click OK. The new markup layer is added to the list in the Markup Layers dialog.

5. To change the color of the new layer, click Color.

The Layer Color dialog appears. The default layer color is red.

6. Select a color and click OK.

7. Click OK to close the Markup Layers dialog.

8.5.2 Setting the Active Markup Layer
A markup can have several layers and you can set a layer as the active markup layer.
When a markup layer is active, all modifications you make are applied to that markup
layer. There are two ways in which to set a layer as active:

1. From the Markup menu, select Markup Layers.

The Markup Layers dialog appears.

2. You can perform one of the following:

■ From the Markup Layers list, select the layer you want to make active, and
click Set Active.

■ From the Currently Active Layer list, select the layer you want to make active.

3. Click OK.

8.5.3 Changing the Color of a Markup Layer
After you create a markup layer, you have the option to change the color of its markup
entities.

1. From the Markup menu, select Markup Layers. The Markup Layers dialog
appears.

2. From the Markup Layers list, select the markup layer whose color you want to
change.

3. Click Color.

The Layer Color dialog appears.

4. Select a Color.
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5. Click OK.

Only the entities that were created with the Bylayer color defined in the
Markup Layers dialog will change color. Any entities that were created using the
color options from the Markup Properties toolbar, will override the Bylayer
color and will not change.

6. Click OK to close the Markup Layers dialog.

8.5.4 Renaming a Markup Layer
After you create a markup layer, you have the option to rename the layer.

1. From the Markup menu, select Markup Layers.

The Markup Layers dialog appears.

2. From the Markup Layers list, select the markup layer you want to rename.

3. Click Rename.

The New Markup Layer dialog appears.

4. Enter the new layer name.

5. Click OK. The markup layer is assigned the new name.

6. Click OK to close the Markup Layers dialog.

8.5.5 Toggling between Markup Layers
From the Markup Layers dialog, you can choose to show or hide a layer and its
associated markup entities.

1. From the Markup menu, select Markup Layers. The Markup Layers dialog
appears.

2. To show/hide a layer or layers, perform one of the following:

a. Select a layer and click Toggle. The layer’s check box will switch between
selected and deselected. To view all the markup layers, click All On. To hide
all markup layers click All Off.

b. From the Markup Layers list, select the check box next to the layer or layers
you want visible, and de-select the check box next to the layer or layers you
want to hide.

3. Click OK.

The markup entities belonging to the selected layer or layers appear in the workspace
on top of the original file.

8.5.6 Deleting a Markup Layer
From the Markup Layers dialog, you can choose to delete a selected layer and its
associated markup entities.

1. From the Markup menu, select Markup Layers.

The Markup Layers dialog appears.

2. From the Markup Layers list, select the markup layer you want to delete.

3. Click Delete.

4. Click OK.
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The layer or layers are deleted along their associated entities.

8.5.7 Moving a Markup Entity to Another Layer
Once you create a markup entity, it is possible to assign it to a pre-existing markup
layer.

1. Select the markup entity or entities that you want to move.

2. From the Markup menu, select Format, and then select Move to Layer.

You can also right-click the markup entity, select Format, and then select Move to
Layer.

The Move to Layer dialog appears.

3. From the Layers list, select the destination layer.

4. Click OK.

The selected markup entity or entities are moved to the selected layer. Only markup
entities using the ByLayer color will change to the new layer’s color.

See Also Working with Markup Entities.

8.6 Consolidating Markup Files
The Consolidate option allows you to create a new Markup file that combines copies
of selected layers of different Markup files. During the review cycle, consolidation
simplifies document revisions by providing the author with one combined Markup file
instead of several Markup files. Note that the Consolidate option is only active when
more than one Markup file is opened.

1. Open the Markup files that you want to consolidate.

2. From the Markup menu, select Consolidate. The Consolidate Markups dialog
appears.

3. Select the markup layers that you want to consolidate into one file. To select
multiple layers, press the Shift or Control key while selecting.

To select all the layers click Select All, and to de-select all the layers click UnSelect
All.

4. In the Markup ID field, enter an ID for the new Markup file.

5. If you want to open the newly consolidated markup as the active markup, select
the Open as Active Markup check box.

6. Click OK.

The consolidated Markup file is saved. If you selected Open as Active Markup, the
consolidated markup opens and is set as the active markup.

8.7 Marking up 2D and 3D Files
AutoVue provides a number of markup options that display the same behavior when
marking up 2D or 3D files. You can add markup entities such as attachments,
hyperlinks, signoffs, and stamps.

See 2D-Specific Markups for information on markup entities that are specific to 2D
files.
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See 3D-Specific Markups for information on markup entities that are specific to 3D
files.

When you are creating a markup entity, you can press the
Escape key to cancel the action.

The following tables lists common markup entities for 2D and 3D files.

Table 8–4 Markup Entities

8.7.1 Adding an Attachment
In AutoVue, you can attach a file of any type (for example, text, audio, or video) as a
markup entity. The attachment is embedded into the markup entity and displays as an
icon the display.

1. From the Markup menu, select Add Entity, and then select Attachment.

From the Markup Entity toolbar, you can also click Attachment .

2. Click on the drawing where you want to add an attachment. The Attach File
dialog appears.

3. In the Link Name field, enter a name for the attachment. Optionally, you can also
provide a brief description of the attachment in the Description box.

4. In the URL field, enter the path to the file or click Browse.The File Open dialog
appears.

5. Select the file or click Browse and click OK. You can attach any local file or any
DMS file.

6. From the Open In list, select one the following:

■ A new applet window: Opens the attachment in a new AutoVue window.

■ Current applet window: Opens the attachment in the current AutoVue
window.

■ Associated application: Opens the attachment in its associated application.

7. Click OK to close the Attach File dialog.

Note:

Option Description

Attachment Add an attachment entity to the markup.

From the Markup Entity toolbar, you can also click Attachment .

See Adding an Attachment.

Signoff Creates an approval stamp containing information about the markup
author, date and time of creation.

From the Markup Entity toolbar, you can also click Signoff .

See Adding Signoff Entities.

Symbol Adds a symbol markup to the document.

From the Markup Entity toolbar, you can also click Symbol .

See Adding a Symbol.
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The attachment appears on the markup workspace and in the Markup Navigation
Tree.

8. Right-click in the workspace to complete the attachment.

8.7.2 Opening an Attachment
To open an attachment, do one of the following:

■ Double-click or the attachment icon in the workspace or Markup Navigation Tree.

– If A new applet window was selected while attaching the file, it will open the
attachment in a new AutoVue window.

– If Current applet window was selected while attaching the file, it will open in
the current AutoVue window.

– If Associated application was selected while attaching the file, it will open in
its associated application.

■ In the tree, right-click the attachment entity in the tree, select Attachment, and
then select one of the following:

– Open: The attachment opens in AutoVue.

– If A new applet window was selected while attaching the file, it will open in a
new AutoVue window.

– If Current applet window was selected while attaching the file, it will open in
the current AutoVue window.

– Open With: You have the option to open the attachment with AutoVue or its
Associated Application.

8.7.3 Editing an Attachment
1. In the Markup Navigation Tree, right-click the attachment and select Edit, or

double-click the markup entity.

The Attach File dialog appears.

2. Make your changes and click OK.

The dialog closes and modifications are implemented.

8.7.4 Adding a Hyperlink
A hyperlink is a link between the current file and a new file, a third-party software
application, or a Web page URL. You can create hyperlinks in your current file so that
your outside files, software applications, and Web pages only a click away. The main
benefit of adding hyperlinks is that the files are accessible from one location but the
information is referenced, not duplicated. This ensures a manageable file size when
loading. If changes need to be made to a linked file, they need to be done in one
location—the linked file itself.

8.7.4.1 Creating a Hyperlink
1. From the Markup menu, select Add Entity, and then select Hyperlink. From the

Markup Entity toolbar, you can also click Hyperlink .

2. Click a point on the document where you want to place the hyperlink. The
Establish Hyperlink dialog appears.
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Figure 8–6 Establish Hyperlink

3. Enter a Link Name.

4. Optionally, enter a Description.

5. Type the URL or click Browse to locate the file that you want to link to. Make sure
to include the http:// protocol in the URL. If the protocol is not included, or if no
value is entered in the URL field, then an error message is thrown when the
Hyperlink markup entity is opened.

6. From the Open In list, select where you want the hyperlink to open.

Table 8–5 Hyperlink Options

If you are creating a hyperlink to a Web page URL, then you must select A new
browser window.

7. Click OK.

8. Right-click to exit hyperlink creation mode. The hyperlink appears on the Markup.

8.7.4.2 Opening a Hyperlink
To open a hyperlink, double-click on it from the workspace.

The hyperlink file opens in the window you selected in the Establish Hyperlink dialog.

8.7.4.3 Editing a Hyperlink
1. In the Markup Navigation Tree or from the workspace, select the hyperlink that

you want to edit.

2. From the Markup menu, select Format and then select Edit Hyperlink. You can
also right-click the hyperlink and select Format, and then select Edit Hyperlink.
The Establish Hyperlink dialog appears.

3. Edit the information that you want.

Open In Description

A new window Opens the file in another AutoVue window.

Current window Opens the file in the current AutoVue window.

A new browser window Opens the file in the default browser window.

A current browser window Opens the file in the current browser window.
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4. Click OK to close the Establish Hyperlink dialog. The changes are saved.

8.7.4.4 Deleting a Hyperlink
1. In the Markup Navigation Tree or from the workspace, select the hyperlink that

you want to delete.

2. From the Markup menu, select Format, and then select Remove Hyperlink. You
can also right-click the hyperlink and select Format, and then select Remove
Hyperlink. You can also delete the hyperlink by selecting the hyperlink and
pressing the Delete key on your keyboard.

The hyperlink is deleted.

8.7.5 Adding Signoff Entities
The Signoff entity is an approval stamp containing information about the markup
author, date, and time of creation. You create a signoff entity when the Markup file is
finalized.

If a markup is modified after a signoff is created, the signoff
disappears (is rescinded) from the workspace but remains in the
Markup Navigation tree. Double-click on the signoff entity in the tree
to view the signoff history—the person who rescinded the signoff, the
creation date, and the drop date.

1. From the Markup menu, select Add Entity, and then select Signoff.

From the Markup Entity toolbar, you can also click Signoff .

2. Click and drag to create a box on the drawing where you want the signoff. The
Signoff dialog appears displaying details of the signoff.

3. Click OK.

The signoff entity appears on the drawing and in the tree, and displays the author,
creation date, and approval date.

8.7.6 Rescinding the Signoff
You can rescind a signoff on a drawing.

1. In the Markup Navigation tree or in the workspace, double-click the signoff
markup entity.

From the Markup Entity toolbar, you can also click Signoff .

The Signoff dialog appears.

2. Click Rescind.

The signoff disappears from the drawing but remains in the Markup Navigation Tree.

8.7.7 Re-Approving a Signoff
To re-approve the signoff that has been rescinded:

1. In the tree, double-click the signoff markup entity. The Signoff dialog appears.

2. Click Approve. The signoff entity re-appears on the drawing and the tree.

Note:
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8.7.8 Viewing the History of a Signoff
1. From the Markup menu, select Add Entity, and then select Signoff.

From the Markup Entity toolbar, you can also click Signoff .

2. Click History. The Signoff History dialog appears displaying the author, date and
time the signoff was created.

3. Click Cancel to close the Signoff dialog.

8.7.9 Adding a Symbol
A Symbol is a graphical entity, such as a company logo. Before a graphic entity can be
used as a Symbol, it must be added to a Symbol Library.

You can create a Symbol Library and add Symbols to it. You can also add or remove
Symbols from existing libraries.

When a Symbol is created, the graphic entity is converted to a
Windows Metafile Format (WMF). As a result, the resulting graphic in
the Symbol may differ from the original image as it has been
converted to another format. In order to avoid these discrepancies in
the output, it is recommended to use AutoCAD formats as the
graphical entity. However, you may still use any 2D/raster image as
the graphical entity, but differences between the Symbol and native
file should be expected.

1. From the Markup menu, select Add Entity, and then select Symbol.

From the Markup Entity toolbar, you can also click Symbol .

The Symbols dialog appears.

Figure 8–7 Symbols

2. Click the Symbols tab.

3. From the Symbol Library list, select the library from which you want to select a
Symbol. The Symbols appear for the selected library.

Note:
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4. Click Isotropic if you want to scale the Symbol proportionately.

5. Click Anisotropic if you want to scale the Symbol disproportionately.

6. Drag the Symbol onto the workspace. To add more Symbols, repeat steps 3 to 5.

The Symbol appears on the drawing and in the Markup Navigation Tree.

7. Close the Symbols dialog.

8.7.10 Creating a New Symbol Library

Once a Symbol library is created, the existing library should
not be modified. If it is modified, it will not be possible to add or
remove existing symbols.

1. From the Markup menu, select Add Entity, and then select Symbol.The Symbols
dialog appears.

From the Markup Entity toolbar, you can also click Symbol .

2. Click the Libraries tab.

3. Click Create.

The Symbol Library dialog appears.

4. Enter the library name, description, author, and keywords in their respective
fields.

5. To add a symbol to the library, click Add. The Open dialog appears.

6. Browse to locate the symbol you want to add, and then click Open.

To add more symbol, repeat steps 4 to 6. To remove a symbol, select the symbol
and click Remove.

The file appears in the Symbol Files list.

7. Close the Symbol dialog.

8.7.11 Deleting a Symbol Library
1. From the Markup menu, select Add Entity, and then select Symbol. The Symbols

dialog appears.

From the Markup Entity toolbar, you can also click Symbol .

Note:
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2. Click the Libraries tab. From the Symbol Libraries list, select the library that you
want to delete.

3. Click Delete. The library disappears from the list and from the Symbol Library list
under the Symbols tab.

4. Close the Symbols dialog.

8.8 2D-Specific Markups
AutoVue provides a variety of user-friendly markup options that you can use when
marking up 2D files. You can create entities such as arcs, boxes, circles, clouds, lines,
and polygons. You can draw a leader with multi-line segments and add text to it.

When you are creating a markup entity, you can press the
Escape key to cancel.

8.8.1 2D Markup Entities
You can create many different types of 2D markup entities. To access the markup
entities, from the Markup menu, select Add Entity. The available 2D markup entities
are listed in the following table.

Note:

Table 8–6 2D Markup Entities

Markup Entity Entity Information

Arc Click and drag the mouse to draw an Arc.

From the Markup Entity toolbar, you can also click Arc .

Box Click and drag to draw a rectangle.

From the Markup Entity toolbar, you can also click Box .

To draw a square instead of a rectangle, press and hold the Shift
key while you click and drag.

Cloud Click and drag to draw a Cloud.

From the Markup Entity toolbar, you can also click Cloud .

Circle Click and drag to draw a circle.

From the Markup Entity toolbar, you can also click Circle .

To draw a circle instead of an ellipse, press and hold the Shift
key while you click and drag.

Freestyle Create freestyle entities

From the Markup Entity toolbar, you can also click Freestyle

.

See Adding a Freestyle Entity.

Highlight Click and drag to highlight a boxed area.

From the Markup Entity toolbar, you can also click

Highlight.

The highlighted box will be filled with a transparent color.
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8.8.2 Adding a Freestyle Entity
You can create a freestyle markup entity. You have the option of making the entity
non-contiguous or contiguous.

Leader Click and drag to draw a line.

From the Markup Entity toolbar, you can also click Leader .

See Adding a Leader

Line Click and drag to draw a line.

From the Markup Entity toolbar, you can also click Line .

To draw a line and force it to be aligned to the closer axis,
horizontal or vertical, press and hold the Shift key while you
click and drag.

See Aligning a Line Segment to the Vertical or Horizontal Axes

Measurement Create markup measure entities.

From the Markup Entity toolbar, you can also click Distance

, Area , Angle , Arc , or Minimum Distance

.See Creating 2D non-Vector Markup Measure Entities

See Creating 2D Vector Markup Measure Entities

See Creating EDA Markup Measure Entities

Note Add a note to the markup.

From the Markup Entity toolbar, you can also click Note .

See Adding a Note

Polygon Click and drag to draw a polygon.

From the Markup Entity tollbar, you can also click Polygon .

Polyline Click and drag to draw a polyline.

From the Markup Entity toolbar, you can also click Polyline .

To force a line segment in a Polyline entity to be aligned to the
closer axis, horizontal or vertical, press and hold the Shift key
while you click and drag for that line segment.

See Aligning a Line Segment to the Vertical or Horizontal Axes

Stamp Adds a Stamp to a document that includes specific document
and user information (metadata) pulled directly from the
DMS/ERP/PLM/UCM system.

From the Markup Entity toolbar, you can also click Stamp .

See Creating a Stamp

Text Add text to the markup.

From the Markup Entity toolbar, you can also click Text

See Adding Text

Table 8–6 (Cont.) 2D Markup Entities

Markup Entity Entity Information
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8.8.2.1 Creating a Contiguous Freestyle Entity
1. From the Markup menu, select Add Entity, and then select Freestyle.

From the Markup Entity toolbar, you can also click Freestyle .

2. Click a point on the drawing where you want to start the Freestyle entity.

3. Move the cursor to create the Freestyle entity.

4. Right-click to end the Freestyle entity.

8.8.2.2 Creating a Non-Contiguous Freestyle Entity
1. From the Markup menu, select Add Entity, and then select Freestyle.

From the Markup Entity toolbar, you can also click Freestyle .

2. Click a point on the drawing where you want to start the Freestyle entity.

3. Move the cursor to create the Freestyle entity.

4. Click a point on the drawing where you want to interrupt the Freestyle entity.

5. Click another point on the drawing where you want to restart the Freestyle entity.

You can interrupt the Freestyle entity as many times as you like by repeating steps
4 and 5.

6. Right-click to end the Freestyle entity.

8.8.3 Aligning a Line Segment to the Vertical or Horizontal Axes
A line segment drawn with the Free Snap snapping mod can be forced to align with
the closer horizontal or vertical axis. You can also take an existing line segment and
have it align with the closer axis. The types of line segments that you can align are
lines, line segments of leaders and polylines, and measure entities.

See 2D Vector Snapping Modes for more information Free Snap.

1. To draw and force a line segment, press and hold the Shift key while you click and
drag for that line segment.

2. To force an existing line segment, click and hold the left mouse button on the line
segment, then press and hold the Shift key.

3. When you see that the line segment is horizontal or vertical, release the left mouse
button, then release the Shift key.

8.8.4 Adding a Leader
To add a leader, do the following:

1. From the Markup menu, select Add Entity, and then select Leader.

From the Markup Entity toolbar, you can also click Leader .

2. Click a point on the document where define the Leader anchor point.

3. Move the cursor to draw the Leader.

To draw a Leader segment and force it to be aligned to the closest axis, vertical or
horizontal, hold the Shift key while moving the cursor.

4. To draw a Leader with multiple line segments, repeat steps 2 and 3 as often as you
like. You can click, then drag as often as you like.
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5. Right-click to end the Leader. A text box appears at the end of the Leader.

6. In the text box, enter the text you want to attach to the Leader.

The height of the text box will resize to fit the entered text.

7. To change text box font properties, from the Markup menu, select Format, and
then select Font.

From the respective font property lists on the Markup Properties toolbar, you can
also modify the font type, style, and size.

The Font dialog appears allowing you to change the font type, style, and size.

8. Click OK to implement the font changes and to close the Font dialog.

9. To change the line properties or fill color of the Leader, select the Leader, then from
the Markup menu, select Format, and then select the property or properties you
want to change.

From the respective line property lists on the Markup Properties toolbar, you can
also modify the line style, line thickness, fill types, and fill colors.

10. Right-click outside the text area to complete the modification.

To edit the Leader text, double-click the Leader in the tree or in the workspace.

The text appears on the drawing and in the Markup Navigation Tree.

8.8.5 Creating 2D non-Vector Markup Measure Entities
When marking up 2D non-vector files, in addition to all the markup options available
for 2D files, you can create markup measure entities. The measure options in Markup
mode work a bit differently than in View mode.

See 2D-Specific Markups

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, or deleted. You can also modify the font of a measure entity, align a “free
snap” measure entity to the horizontal or vertical axis, as well as add units of measure
and symbols to a measurement and have them appear on the drawing.

When you are creating a markup entity, you can press the
Escape key to cancel.

Measure options vary between vector and non-vector files. For vector files, AutoVue
provides the option to “snap” to fixed points on the drawing. For non-vector files, you
can only “free snap”.

In Markup mode, you can choose from several measure options to create markup
measure entities. From the Markup menu, select Add Entity, and then select
Measurement to access the following measure options:

Note:

Table 8–7 Measure Options

Option Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle .
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8.8.5.1 Measuring Distance
Use the Distance option to measure the distance between two specific points.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Distance. The Measurement Entities dialog appears.

From the Markup Entity toolbar, you can also click Distance .

2. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

3. Click a point on the drawing to define the starting point.

4. Click another point on the drawing to define the end point. The measured line
path appears as an entity on the current active markup.

5. Move the cursor and click a location on the drawing to display the measure
distance.

The measurement and unit appear in a value box entity on the current active
markup layer. The measured distance, Delta-X, and Delta-Y appear in the
Measurement Entities dialog.

6. To resize the value box, select it and then click and drag the frame handles.

7. You can click and drag the text box anywhere on the drawing. To make another
measurement, click Reset.

8. Click Close to close the Measurement Entities dialog.

8.8.5.2 Measuring Cumulative Distance
1. From the Markup menu, select Add Entity, select Measurement, and then select

Distance.

From the Markup Entity toolbar, you can also click Distance .

The Measurement Entities dialog appears.

2. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

3. Select Cumulative.

4. Click a point on the drawing to define the starting point.

5. Continue clicking points along the path that you want to measure. Each point is
joined by a line.

Arc Measure an arc entity

From the Markup Entity toolbar, you can also click Arc .

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area .

Distance Measure the distance between two points.

From the Markup Entity toolbar, you can also click Distance

.

Table 8–7 (Cont.) Measure Options

Option Description
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6. Right-click to complete the measurement. To make another measurement, click
Reset.

The measured line path, cumulated measurement and unit appear in a value box
entity on the current active markup layer. The cumulated measured distance,
Delta-X, and Delta-Y appear in the Measurement Entities dialog.

7. Click Close to close the Measurement Entities dialog.

8.8.5.3 Calibrating Distance
Calibrate the distance measurement.

1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.

The Distance Calibration dialog appears displaying the measured distance.

3. From the Units list, select the unit to which you want to calibrate the distance.

4. Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.

The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

8.8.5.4 Measuring Area
Use the Area option to measure the area and perimeter of a region.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Area.

From the Markup Entity toolbar, you can also click Area .

The Measurement Entities dialog appears.

2. From the Measured Area Units list, select the unit in which you want to measure
the area.

3. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

4. To cumulate a Net Area Result of different areas, select Add.

5. To subtract an area from the Net Area Result, select Subtract.

6. Select Clear to clear the Net Area Result field.

7. Click a point on the drawing to define the starting point.

8. Continue clicking points on the drawing to define the area you want to measure.
Each point is joined by a line.

9. Right click to complete the measurement.

To make another measurement, click Reset.

The measured line path, measurement and unit appear in a value box entity on the
current active markup layer. The area and perimeter measurements appear in the
Measurement Entities dialog.

10. Click Close to close the Measurement Entities dialog.
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8.8.5.5 Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Angle.

From the Markup Entity toolbar, you can also click Angle .

The Measurement Entities dialog appears.

2. From the Measured Angle Units list, select the unit in which you want to measure
the angle.

3. Click points on the drawing to define the angle you want to measure:

a. The first click defines the starting point of the angle measurement

b. The second click defines the vertex of the angle measurement

c. The third click defines the endpoint of the angle measurement

d. The points are joined by angle arms with an arc connecting them.

4. Move the cursor to increase or decrease the radial and arc length.

5. Click again to complete the measurement.

The measured line path, angle measurement and unit appear in a value box entity
on the current active markup layer. The measured angle also appears in the
Measurement Entities dialog.

6. To resize the value box, select it and then click and drag the frame handles.

7. You can click and drag the value box anywhere on the drawing.

To make another measurement, click Reset.

8. Click Close to close the Measurement Entities dialog.

8.8.5.6 Measuring an Arc
Use the Arc option to define an arc in the drawing and measure its radius, center and
diameter.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Arc.

From the Markup Entity toolbar, you can also click Arc .

The Measurement Entities dialog appears.

2. From the Arc Info Length list, select the unit in which you want to measure the
arc.

3. From the Measured Angle Units list, select the unit in which you want to measure
the angle. The options are degrees or radians.

4. Select Add Radius if you want to measure the radius of the arc.

5. Select Add Diameter if you want to measure the diameter of the arc.

6. Click three points on the drawing to define the arc you want to measure. The
points are joined by an arc.

7. Click again to complete the measurement.

The measured line path, arc measurement and unit appear in a value box entity on
the current active markup layer and in the Measurement Entities dialog.
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8. To resize the value box, select it and then click and drag the frame handles.

9. You can click and drag the text box anywhere on the drawing.

To make another measurement, click Reset.

10. Click Close to close the Measurement Entities dialog.

8.8.5.7 Calibrating an Arc
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.

The Radius Calibration dialog appears displaying the measured distance.

3. From the Units list, select a unit of measurement to which you want to calibrate
the distance.

4. Click Calibrate to and enter a value if you want to calibrate to a value.

5. Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.

The calibration results appear in the Arc tab.

7. Click Close to close the Measurement dialog.

8.8.6 Creating a Stamp

In previous releases of AutoVue, Stamp markup entities were
called Intellistamp.

The Stamp markup entity lets you create a stamp that includes document and user
information (metadata) pulled directly from the back-end DMS/ERP/PLM/UCM
system.

The Stamp is only available if a system administrator has
defined and configured the Stamp.

A Stamp can retrieve a document’s attributes directly from the back-end system. They
can also update attributes from the Stamp to the document in the back-end system.

Back-end system attributes that the Stamp can read and write to can be simple values
or a list of values. When lists are constrained, you can only select from the pre-defined
list. When lists are non-constrained, you can enter a value that is not in the drop-down
list. When an attribute is a multi-valued attribute, AutoVue lets you select multiple
values from the drop-down list. In this case, values are separated by a semi-colon (;).

As of AutoVue 20.2.1, Stamps are disabled for 3D files.
Existing stamps that were defined in previous releases of AutoVue can
still be viewed but cannot be modified.

8.8.6.1 Adding a Stamp
To add a Stamp markup entity to a document, do the following:

Note:

Note:

Note:
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1. Enter Markup mode.

2. From the Markup menu, select Add Entity, and then select Stamp.

From the Markup Entity toolbar, you can also click Stamp .

The Stamp dialog appears.

3. From the Choose Stamp box, select the desired Stamp and then click OK.

If the Enable Resizing check box is selected then the Stamp can be resized in the
workspace. If the check box is grayed out, then the Stamp is not re-sizable and has
a set size.

4. In the workspace, click and drag a box to the desired Stamp size.

The Stamp dialog closes and the Stamp appears in workspace and in the Markup
Entity Tree.

8.8.6.2 Manipulating a Stamp
Depending on how the Stamp is configured, it may appear as a fixed size in the
workspace or it may be re-sizable. If it is re-sizable, you can select the stamp outline,
and drag it to the desired size. If the isotropic option is selected on the stamp, it resizes
proportionally in all directions. To resize the stamp non-proportionally, your system
administrator must update the Stamp definition.

Depending the format of the background image, when resizing the Stamp, attributes
and/or text may not align properly with the background image. To avoid this issue,
Enhanced Metafiles (EMF) should be used as the background image. Refer to the
Oracle AutoVue Client/Server Deployment Installation and Configuration Guide for
more information.

If the Stamp is configured to retrieve back-end system attributes, then the values of
these attributes are displayed on the Stamp in the workspace.

To modify the text font on the Stamp, select the required font and style from the
Markup toolbar.

The Copy/Paste feature for Stamps is not supported. If you copy a group of entities
that has a Stamp, the Stamp is excluded from the Copy/Paste function.

8.8.6.3 Viewing/Modifying Stamp Attributes
The section describes how to view and modify Stamp attributes.

If your Stamp is configured to read back-end attributes, then the Stamp entity displays
these back-end attributes. Reading values from the back-end can be done once during
Stamp creation (the attribute is configured with the ReadOnce permission by the
system administrator) or the back-end values can be read when requested (the
attribute is configured with the Read permission by the system administrator). The
following describes each attribute.

■ If an attribute is configured with the Edit permission, then you can modify the
value of the attribute on the Stamp.

■ If an attribute is configured with the Write permission, then you can save the value
on the Stamp to back-end system.

Provided that you have permissions to update the attribute on
the back-end system.
Note:
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■ If an attribute is configured with the Hidden permission, then you cannot see the
attribute on the Stamp. However, you can view the attribute in the Edit dialog and
when editing the Stamp.

■ If an attribute is configured with the current date or user name default values,
then these values are displayed on the Stamp (only if no value is retrieved from
the back-end system).

1. You can view the attributes of a Stamp by double-clicking the Stamp markup
entity. The DMS Attributes dialog appears and lists all attributes of the Stamp.

Figure 8–8 DMS Attributes

All attributes tagged as Hidden during Stamp design also display in the DMS
Attributes dialog.

The dialog contains three columns that include attribute values defined in the
design stage:

■ The Name column displays the attribute name as defined in the design stage.
It either displays the back-end DMS/ERP/PLM/UCM system-defined
attribute name or the user-defined name.

■ The Value column displays the value that is currently on the Stamp.

■ The Value from DMS column displays the value assigned from the back-end
system.

2. To modify any value of the Stamp, double-click the Value cell corresponding to the
attribute.

■ If the attribute does not have Edit permissions, the value cannot be modified.

■ If the attribute is defined as Hidden, then the attribute is displayed in the DMS
Attributes dialog. You may edit the value of a Hidden attribute, but it does not
display in the workspace.

■ If the attribute is a non-constrained list, then you may either select a value
from the list or enter your own value. If the attribute is a constrained list, you
may only select from the list.

■ If the attribute is a multi-valued list, then you may select a value from the list.
AutoVue appends this value to any pre-existing values using a semi-colon (;)
as a separator.

■ If an attribute is defined with Hidden permissions, then the value from the
DMS column reflects the value read during Stamp creation. It does not reflect
the current value in the DMS.

After a change is made to a value cell, you must press Tab or Enter to finalize the
changes.
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3. To commit changes to values for back-end system attributes, click Commit
Changes.

4. To reset changes and revert to back-end system values, click Reset.

5. When you are done modifying the attributes, click OK to finalize your changes
and to close the DMS Attributes dialog. The Stamp is updated to reflect any
changes you made.

8.9 Creating 2D Vector Markup Measure Entities
When marking up 2D vector files, in addition to all the markup options available for
2D files, you can create markup measure entities. The measure options in Markup
mode work slightly different than in View mode.

Measure options vary between vector and non-vector files. For vector files, AutoVue
provides the option to “snap” to fixed points on the drawing. For non-vector files, you
can only “free snap”.

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, hidden or deleted. You can also modify the font of a measure entity, align a
“free snap” measure entity to the horizontal or vertical axis, as well as add units of
measure and symbols to a measurement and have them appear on the drawing.

When you are creating a markup entity, you can press the
Escape key to cancel.

In Markup mode, you can choose from several measure options to create markup
measure entities. From the Markup menu, select Add Entity, and then select
Measurement to access the following measure options:

Table 8–8 Measure Options

8.9.1 2D Vector Snapping Modes
The available snapping modes allow you to click to precise geometrical points on a
drawing. For example, if you select Snap to End-Point and you move the cursor over
an end-point of a line, the end-point will be highlighted by a snap box.

Note:

Option Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle .

Arc Measure an arc entity

From the Markup Entity toolbar, you can also click Arc .

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area .

Distance Measure the distance between two points.

From the Markup Entity toolbar, you can also click Distance

.
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The snapping modes allow you to snap to the mid, center, and end-points of an entity:

Table 8–9 Snapping Modes

When selecting a snapping mode you also have the option to
select all snapping modes (All On) or to turn off snapping modes (All
Off)

The below table lists snapping locations for certain measurements:

Table 8–10 Measure Options

8.9.2 Measuring Distance
Use the Distance option to measure the distance between two specific points.

1. From the Markup menu, select Add entity, select Measurement, and then select
Distance.

From the Markup Entity toolbar, you can also click Distance .

The Measurement Entities dialog appears

2. Select the snapping modes that you want to use for measuring.

■ To select all snapping modes, click All On.

■ To de-select all snapping modes, click All Off.

See Snapping Modes.

3. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

4. Click a point on the drawing to define the starting point.

5. Click another point on the drawing to define the end point.

If you selected Cumulative, continue clicking points along the path that you want
to measure.

Button Snap to Description

End-point Geometric snap mode where a snap box appears when moving
the cursor near a linear component’s end point.

Mid-point Geometric snap mode where a snap box appears when moving
the cursor near the halfway point of a linear component.

Center-point Geometric snap mode where a snap box appears when moving
the cursor near the center of an elliptical component.

Free Snap Allow snapping at any point on the drawing.

Note:

Option Description

Angle Snap to two non-parallel lines.

Arc Snaps to an arc on the drawing.

Area Snaps to a shape on the drawing.
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The measured line path appears as an entity on the current active markup.

6. Move the cursor and click a location on the drawing to display the measure
distance.

The measurement and unit appear in a value box entity on the current active
markup layer. The measured distance, Delta-X, and Delta-Y appear in the
Measurement Entities dialog.

7. To resize the value box, select it and then click and drag the frame handles.

8. You can click and drag the text box anywhere on the drawing.

To make another measurement, click Reset.

9. Click Close to close the Measurement dialog.

8.9.3 Measuring Cumulative Distance
Use the Cumulative Distance option to measure the distance along a path of
multi-faceted (adjoining) points.

1. From the Markup menu, select Add entity, select Measurement, and then select
Distance.

From the Markup Entity toolbar, you can also click Distance .

The Measurement Entities dialog appears

2. Select the snapping modes that you want to use for measuring.

■ To select all snapping modes, click All On.

■ To de-select all snapping modes, click All Off.

See Snapping Modes.

3. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

4. Select Cumulative.

5. Click the first entity to define the starting point.

6. Continue clicking points along the path that you want to measure.

Each point is joined by a line.

7. Move the cursor and click a location on the drawing to display the measure
distance.

The measurement and unit appear in a value box entity on the current active
markup layer. The measured distance, Delta-X, and Delta-Y appear in the
Measurement Entities dialog.

8. Right-click to complete the measurement.

Click Reset to take another measurement.

The measured line path, measurement and unit appear in a value box entity on the
current active markup layer. The measured distance, Delta-X, Delta-Y and the
“Manhattan Distance” appear in the Measurement Entities dialog.

9. Click Close to close the Measurement dialog.



Creating 2D Vector Markup Measure Entities

8-36 Oracle AutoVue User Manual

8.9.4 Calibrating Distance
Calibrate the distance measurement.

1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.

The Distance Calibration dialog appears displaying the measured distance.

3. From the Units list, select the unit to which you want to calibrate the distance.

4. Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.

The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

8.9.5 Measuring Area
Use the Area option to measure the area and perimeter of a region.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Area.

From the Markup Entity toolbar, you can also click Area .

The Measurement Entities dialog appears.

2. Select Between Points if you want to measure the area between points on a
drawing. The snapping modes are displayed.

3. From the Measured Area Units list, select the unit in which you want to measure
the area.

4. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

5. To cumulate a Net Area Result of different areas, select Add.

6. To subtract an area from the Net Area Result, click Subtract.

7. Select Clear to clear the Net Area Result.

8. Click a point on the drawing to define the starting point.

9. Continue clicking points on the drawing to define the area you want to measure.

Each point is joined by a line.

10. Right click to complete the measurement. To make another measurement, click
Reset.

11. Click Close to close the Measurement dialog.

8.9.6 Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.

1. From the Markup menu, select Add Entity, and then select Angle.

From the Markup Entity toolbar, you can also click Angle .

The Measurement Entities dialog appears.
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2. Select From 3 Points if you want to measure the angle between three points. The
snapping modes are displayed.

The snapping modes are displayed.

3. Select the snapping modes that you want to use for measuring.

4. Select Between 2 lines if you want to measure the angle between two lines.

5. From the Measured Angle Units list, select the unit you want to measure the
angle.

6. If you selected From 3 Points, click three points on the drawing to define the
angle.

7. If you selected Between 2 Lines, click two lines on the drawing to define the
angle.

Angle arms appear with an arc connecting them.

8. Click again to complete the measurement.

The measured line path, measurement and unit appear in a value box entity on the
current active markup layer. The measurement appears in the Measurement
Entities dialog.

9. To change the size of the angle, click and drag it to the desired size.

10. To move the value box, click and drag it to anywhere on the markup.

11. To resize the value box, select it and then click and drag the frame handles.

Click Reset to take another measurement

12. Click Close to close the Measurement dialog.

8.9.7 Measuring an Arc
Use the Arc option to measure the precise radius, length and angles of any arc on the
model. It also calculates the center point location.

1. From the Markup menu, select Add Entity, Measurement, and then Arc.

From the Markup Entity toolbar, you can also click Arc .

The Measurement Entities dialog appears.

2. Select Arc Entity if you want to measure a predefined arc.

All arc and circles are highlighted on the model. Snapping modes are disabled.

3. Select From 3 Points if you want to measure the arc between three points.
Snapping modes are displayed.

4. Select the snapping modes that you want to use for measuring.

All entities of the selected entity types are highlighted on the model.

5. From the Dist. Units list, select the unit in which you want to measure the arc
distance.

6. From the Angles Units list, select the unit in which you want to measure the
angle.

7. If you selected From 3 Points, click three points to define the arc.

The points are joined by an arc.

8. If you selected Arc Entity, click the edge of an arc.
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The arc is highlighted.

9. Click to complete the measurement.

The measured line path, measurement and unit appear in a value box entity on the
current active markup layer. The measurements for arc center coordinates, radius,
diameter, ratio, arc length, start and end of angle and sweep appear in the
Measurement Entities dialog.

10. To move the value box, click and drag it to anywhere on the markup.

11. To resize the value box, select it and then click and drag the frame handles. Click
Reset to take another measurement.

12. Click Close to close the Measurement Entities dialog.

8.9.8 Calibrating an Arc
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.

The Radius Calibration dialog appears displaying the measured distance.

3. From the Units list, select a unit of measurement to which you want to calibrate
the distance.

4. Click Calibrate to and enter a value if you want to calibrate to a value.

5. Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.

The calibration results appear in the Arc tab.

7. Click Close to close the Measurement dialog.

8.10 Creating EDA Markup Measure Entities
When marking up EDA files, in addition to all the markup options available for 2D
files, you can create markup measure entities. The measure options in Markup mode
work slightly different than in View mode.

See 2D-Specific Markups

When you are creating a markup entity, you can press the
Escape key to cancel.

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, or deleted. You can also modify the font of a measure entity, align a “free
snap” measure entity to the horizontal or vertical axis, as well as add units of measure
and symbols to a measurement and have them appear on the drawing.

AutoVue provides the option to “snap” to geometrical or electrical points on the
drawing.

In Markup mode, you can choose from several measure options to create markup
measure entities. From the Markup menu, select Add Entity, and then select
Measurement to access the following measure options:

Note:
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8.10.1 EDA Snapping Modes
The snapping modes allow you to click to precise geometrical points or electrical
points. For example, when you select Snap to Pin, move the cursor over the pin you
want to select until the pin is highlighted, then click. Highlight and click a second pin
to measure the distance between them.

The snapping modes allow you to snap to the mid, center, and end-points of an entity
as well as a pin, via, and symbol. The following table outlines the available snapping
modes:

Name Description

Angle Measure the angle between selected points.

From the Markup Entity toolbar, you can also click Angle .

Arc Measure an arc-entity

From the Markup Entity toolbar, you can also click Arc .

Area Measure a selected area.

From the Markup Entity toolbar, you can also click Area .

Distance Measure the distance between two points.

From the Markup Entity toolbar, you can also click Distance

.

Minimum
Distance

Measure the minimum distance between two entities.

From the Markup Entity toolbar, you can also click Minimum

Distance .

Note: This option is only available for PCB files.

Table 8–12 Snapping Modes

Button Snap to Description

End-point Geometric snap mode where a snap box appears when moving
the cursor near the entity’s end point.

Mid-point Geometric snap mode where a snap box appears when moving
the cursor near the halfway point of a linear entity.

Center-point Geometric snap mode where a snap box appears when moving
the cursor near the center of an entity.

Pin Electrical snap mode where a snap box appears when the cursor
touches a pin.

Via Electrical snap mode where a snap box appears when the cursor
touches a via.

Symbol
origin

Electrical snap mode where a snap box appears when the cursor
touches a component.
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8.10.2 Measuring Distance
Use the Distance option to measure the distance between two specific points.

1. From the Markup menu, select Add entity, select Measurement, and then select
Distance.

From the Markup Entity toolbar, you can also click Distance .

The Measurement Entities dialog appears.

2. Select the snapping modes that you want to use for measuring.

■ To select all snapping modes, click All On.

■ To de-select all snapping modes, click All Off.

3. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

4. Click a point on the drawing to define the starting point.

5. Click another point on the drawing to define the end point.

The points are joined by a line. The measured line path appears as an entity on the
current active markup.

6. Drag to move the measured line path.

7. Click on the measured line path.

The measurement and unit appear in a value box entity on the current active
markup layer. The measured distance, Delta-X, Delta-Y and the “Manhattan
Distance” appear in the Measurement Entities dialog.

8. To resize the value box, select it and then click and drag the frame handles.

Click Reset to take another measurement.

9. Click Close to close the Measurement dialog.

8.10.3 Measuring Cumulative Distance
1. From the Markup menu, select Add entity, select Measurement, and then select

Distance.

From the Markup Entity toolbar, you can also click Distance .

The Measurement Entities dialog appears.

2. Select the snapping modes that you want to use for measuring.

■ To select all snapping modes, click All On.

Free Snap Allow snapping at any point on the drawing.

Net Allows snapping to net.

Trace Allows snapping to a trace.

Table 8–12 (Cont.) Snapping Modes

Button Snap to Description
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■ To de-select all snapping modes, click All Off.

3. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

4. Select Cumulative.

5. Click the first entity to define the starting point.

6. Continue clicking points along the path that you want to measure. Each point is
joined by a line

7. Right-click to complete the measurement. To make another measurement, click
Reset.

The measured line path, cumulated measurement and unit appear in a value box
entity on the current active markup layer. The cumulated measured distance,
Delta-X, and Delta-Y appear in the Measurement Entities dialog.

8. Click Close to close the Measurement Entities dialog.

8.10.4 Calibrating Distance
Calibrate the distance measurement.

1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.

The Distance Calibration dialog appears displaying the measured distance.

3. From the Units list, select the unit to which you want to calibrate the distance.

4. Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.

The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

8.10.5 Measuring Area
Use the Area option to measure the area and perimeter of a region.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Area.

From the Markup Entity toolbar, you can also click Area .

The Measurement Entities dialog appears.

2. Select Between Points if you want to measure the area between points on a
drawing. The snapping modes are displayed.

3. Select the snapping modes that you want to use for measuring.

To select all snapping modes, click All On. To de-select all snapping modes, click
All Off.

4. Select Shape if you want to measure the area of a predefined shape on the
drawing.
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5. From the Measured Area Units list, select the unit in which you want to measure
the area.

6. From the Perimeter Units list, select the unit in which you want to measure the
perimeter.

7. To cumulate a Net Area Result of different areas, select Add in the Measurement
Entities dialog.

8. To subtract an area from the Net Area Result, click Subtract.

9. Select Clear to clear the Net Area Result.

10. If you selected Between Points, click points on the drawing to define the area.

Each point is joined by a line. The area and perimeter measurements appear in the
Measurement dialog.

11. If you selected Shape, click the edge of the predefined shape that you want to
measure.

The shape is highlighted.

12. Right-click to complete the measurement.

Click Reset to take another measurement.

The measured line path, measurement and unit appear in a value box entity on the
current active markup layer. The area and perimeter measurements appear in the
Measurement Entities dialog.

13. Click Close to close the Measurement dialog.

8.10.6 Measuring an Angle
Use the Angle option to measure the angle between points on a drawing.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Angle.

From the Markup Entity toolbar, you can also click Angle .

The Measurement Entities dialog appears.

2. Select From 3 Points if you want to measure the angle between three points.
Snapping modes are displayed.

3. Select the snapping modes that you want to use for measuring.

4. To select all snapping modes click All On, to de-select all snapping modes click
All Off.

5. Select Between 2 lines if you want to measure the angle between two lines.

6. From the Measured Angle Units list, select the unit in which you want to measure
the angle.

7. If you selected From 3 Points, click three points to define the angle.

8. If you selected Between 2 Lines, click two lines to define the angle.

Angle arms appear with an arc connecting them.

9. Right-click to complete the measurement.

The measured line path, measurement and unit appear in a value box entity on the
current active markup layer. The measured angle appears in the Measurement
Entities dialog.
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10. To change the size of the arc, click and drag the it to the desired size.

11. To move the value box, click and drag it to anywhere on the drawing.

12. To resize the value box, select it and then click and drag the frame handles.

Click Reset to take another measurement.

13. Click Close to close the Measurement dialog.

8.10.7 Measuring an Arc
Use the Arc option to define an arc in the drawing and measure its radius, center, and
diameter.

1. From the Markup menu, select Add Entity, select Measurement, and then select
Arc.

From the Markup Entity toolbar, you can also click Arc .

The Measurement Entities dialog appears.

2. Select From 3 Points if you want to measure the arc between three points.
Snapping modes are displayed.

3. Select the snapping modes that you want to use for measuring.

To select all snapping modes click All On. To clear all snapping modes click All
Off.

4. Select Arc Entity if you want to measure a predefined arc.

5. From the Arc Info list, select the unit in which you want to measure the distance of
the arc.

6. From the Measured Angle Units list, select the unit in which you want to measure
the angle.

7. Select Add Radius if you want measure the radius.

8. Select Add Diameter if you want to measure the diameter.

9. If you selected From 3 Points, click three points to define the arc.

The points are joined by an arc.

10. If you selected Arc Entity, click an edge of the arc.

The arc is highlighted. The measurements for center point coordinates, radius,
diameter, arc length, start and end of angle and sweep appear in the Measurement
dialog.

11. Click to complete the measurement.

The measured line path, measurement and unit appear in a value box entity on the
current active markup layer.The measurements for center point coordinates,
radius, diameter, arc length, start and end of angle and sweep appear in the
Measurement Entities dialog.

12. To move the value box, click and drag it to anywhere on the drawing.

13. To resize the value box, select it and then click and drag the frame handles.

Click Reset to take another measurement.

14. Click Close to close the Measurement dialog.
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8.10.8 Calibrating an Arc
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.

The Radius Calibration dialog appears displaying the measured distance.

3. From the Units list, select a unit of measurement to which you want to calibrate
the distance.

4. Click Calibrate to and enter a value if you want to calibrate to a value.

5. Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.

The calibration results appear in the Arc tab.

7. Click Close to close the Measurement dialog.

8.10.9 Measuring Minimum Distance
Use the Minimum Distance option to measure the minimum distance between entities.
The available entities for snapping are nets, pins, vias and traces.

To measure the minimum distance between entities on
separate layers, select Across Layers. If a physical layer does not exist,
this option determines whether or not the minimum distance should
be calculated across logical layers.

1. From the Markup menu, select Add entity, select Measurement, and then select
Minimum Distance.

From the Markup Entity toolbar, you can also click Minimum Distance .

The Measurement Entities dialog appears.

2. To measure the minimum distance between entities that are not on the same
physical layer, select Across Layers. If a physical layer does not exist, this option
determines whether or not the minimum distance should be calculated across
logical layers.

3. Click First Set to select the entities that you want to measure from.

4. Select the snapping modes that you want to use for measuring.

If you select Net, you cannot select any other type of entity.

5. Click the first set of entities in the drawing. To clear the last set of entities you
selected, click Clear Set. The entities are highlighted.

6. Click Second Set to select the entities that you want to measure to.

7. Click the second set of entities on the drawing. The entities are highlighted in a
different color.

8. From the Measured Min. Distance Units list, select the unit in which you want to
measure the distance.

9. Select Zoom to Result, if you want to zoom into the measurement on the drawing.

10. Click Compute.

Note:
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The minimum distance from the first set of entities to the second set is highlighted
by a line. The measured line path, measurement and unit appear in a value box
entity on the current active markup layer. The measurement, Delta-X, Delta-Y, and
the Manhattan Distance appear in the Measurement Entities dialog.

11. To move the value box, click and drag it to anywhere on the drawing.

12. To resize the value box, select it and then click and drag the frame handles.

Click Reset to take another measurement.

13. Click Close to close the Measurement dialog.

8.11 Adding Text
With AutoVue, you can add a text box entity to a markup.

1. From the Markup menu, select Add Entity, and then select Text.

2. Click and drag on the drawing to define the dimensions of the text box.

3. Click in the text box and enter the text you want to add.

The height of the text box will adjust to accommodate the text.

4. To change text box font properties, from the Markup menu, select Format, and
then select Font.

From the respective font property lists on the Markup Properties toolbar, you can
also modify the font type, style, and size.

The Font dialog appears allowing you to change the font type, style, and size.

5. Click OK to implement the font changes and to close the Font dialog.

6. To change the line properties or fill color of the text box, select the text box, then
from the Markup menu, select Format, and then select the property or properties
you want to change.

From the respective line property lists on the Markup Properties toolbar, you can
also modify the line style, line thickness, fill types, and fill colors.

7. Right-click outside the text area to complete the modification.

The text appears on the drawing and in the Markup Navigation Tree.

8. To move the text box click and drag it.

9. Click and drag the frame handles of the text box to enlarge it.

To edit the text, double-click the text box in the tree or in the workspace.

8.11.1 Hiding the box surrounding the text
1. Select the text box entity.

2. From the Markup menu, select Format, and then select Markup Entity Attributes.

The Markup Entity Properties dialog appears.

3. From the Text Box Visibility list, select Off.

4. Click OK.

To undo, repeat steps 1 through 4, except select On.

The dialog closes and the text box is hidden.
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8.12 Adding a Note
You can attach longer comments as a markup sticky note on the drawing. A note
displays in the workspace as a standard size graphical symbol. Each note is labeled as
Note<n>—where n represents the numerical order of occurrence of the note (for
example, the first note is labeled as Note 1). To read the note, double-click the entity to
open it or move the mouse over the entity to display the tooltip.

When creating multiple Note entities, it is possible to group
the entities. Once the Note entities are grouped, clicking on the group
opens the last Note created.

1. From the Markup menu, select Add Entity, and then select Note.

2. Click a point on the document where you want to insert the note.

The Note dialog appears.

3. Enter the text that you want in the Note dialog.

4. From the File menu, select Information. The Note Information dialog appears.

5. To change the default font, select Font and the type of font.

6. Close the Note dialog.

The note symbol appears on the drawing and in the Markup Navigation Tree.

7. Right-click outside the note area to complete the modification.

To edit a note, double-click on the note.

8.13 Nesting Markup Entities
You can add a Note or Hyperlink markup entity as a nested child to other markup
entities.

1. Add a markup entity to a file (for example, a Box entity).

2. From the workspace or Markup Tree, select the Box entity.

3. From the Markup menu, select Note or Hyperlink.

From the Markup Entity toolbar, you can also click Note or Hyperlink.

In the Markup Tree, the selected markup entity appears as a child of the Box (parent)
entity.

8.14 3D-Specific Markups
When marking up 3D files, you can attach text or a note, as well as create markup
measure entities. The measure options in Markup mode work slightly different than in
View mode.

When you are creating a markup entity, you can press the
Escape key to cancel.

Note:

Note:
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8.14.1 3D Markup Entities
You can create many different types of markup entities. To access the markup entities,
from the Markup menu, select Add Entity. The markup entities are:

Table 8–13 Markup Entities

8.14.1.1 Creating 3D Markup Measure Entities
When marking up 3D files, you can create markup measure entities. The measure
options in Markup mode work slightly different than in View mode.

When measuring in Markup mode, the specified measurement lines and values are
displayed on the current active markup layer as entities. These entities can be moved,
resized, or deleted.

If you manipulate a part of a model, the measure entity values
do not update accordingly.

AutoVue provides the option to “snap” to different entity types on the model.

In Markup mode, you can choose from several measurement options to create markup
measure entities. From the Markup menu, select Add Entity, and then select
Measurement to access the following measure options:

Option Description

Text Add text to the markup

See Adding Text

Attachment Add an attachment entity to the markup

See Adding an Attachment

Measurement Create markup measure entities.

See Creating 3D Markup Measure Entities

Note Add a note to the markup.

See Adding a Note

Signoff Create an approval stamp containing information about the markup
author, date and time of creation.

See Adding Signoff Entities

Note:

Table 8–14 Measure Options

Name Description

Angle Measure the precise angle between any three vertices or any two
edges, planes, faces or any combination of these entity types.

From the Markup Entity toolbar, you can also click Angle .

Arc Measure the precise radius, length and angle of any arc and
calculate the center point.

From the Markup Entity toolbar, you can also click Arc .
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8.14.1.2 3D Snapping Modes
Snapping modes allow you to select or snap to different entity types on a model. For
example, if you select Vertex, all vertices are highlighted and a snap box appears when
you move the cursor over a vertex.

Snapping modes allow you to snap to the following entities:

The behavior of snapping modes change in regards to the
selected measurement option. For example, the behavior of arc center
is not the same for distance and minimum distance.

Distance Measure the precise distance between any two vertices, edges,
mid-edges, arc centers, faces or any combination of these entity
types.

From the Markup Entity toolbar, you can also click Distance

.

Minimum
Distance

Measure minimum distance between any two vertices, edges,
mid-edges, arc centers, faces or any combination of these entity
type.

From the Markup Entity toolbar, you can also click Minimum

Distance .

Vertex
Co-ordinates

Provide the coordinates of each vertex.

From the Markup Entity toolbar, you can also click Vertex

Co-ordinates

Note:

Table 8–15 3D Snapping Modes

Button Description Behavior

Vertex
Highlights vertices on
the model.

A snap box appears when you hover the mouse
pointer over a vertex.

Edge Line
Highlights edges on
the model.

The edge is highlighted when you hover the mouse
pointer.

Note: When measuring Minimum Distance, the
finite edge is selected. However, when measuring
Distance, the infinite edge is selected.

Edge Middle Highlights edges on
the model.

The edge is highlighted and a tooltip appears
indicating the middle edge coordinate when you
hover the mouse pointer.

Arc
Highlights arcs on the
model.

The arc is highlighted when you hover the mouse
pointer.

Arc Center Highlights arcs and
circles on the model.

The arc is highlighted and a tooltip appears
indicating the arc center coordinate of the arc when
you hover the mouse pointer.

Note: When measuring Minimum Distance, the arc
center is selected. However, when measuring
Distance, the infinite arc axis is selected.

Table 8–14 (Cont.) Measure Options

Name Description
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8.14.1.3 Measuring Distance
Use the Distance option to measure the distance between two vertices, edges, arc axes,
faces or any combination of these entity types.

To revert to the Point to Point distance measurement, set the
SHOW_POINTOPOINT_PAGE INI option. Refer to the Installation
and Configuration Guide for more information.

The following table details how the distance between two entities are measured using
snapping modes:

Table 8–16 Snapping Mode Entities

1. From the Markup menu, select Add Entity, Measurement, and then Distance.

From the Markup Entity toolbar, you can also click Distance .

The Measurement Entities dialog appears.

2. From the Measured Distance Units list, select the unit in which you want to
measure the distance.

3. Select the snapping modes you want to use for measuring.

Face (Plane) Highlights faces when
you move the cursor
over a face.

The face is highlighted when you hover the mouse
pointer.

Note:

Snapping
Model
Entities Vertex Line Arc Center Plane

Vertex Distance
between two
points.

The shortest
segment connecting
the point and the
line.

The shortest
segment
connecting the
point and the arc.

The shortest
segment connecting
the point and the
plane.

Line Distance between
two lines.

Note: The lines
must be parallel.

The line and axis
must be parallel.
Distance between
the line and arc
axis.

The distance
between the line and
the plane.

Note: The line must
be parallel to the
plane.

Arc Center Distance between
the axes of the arcs.

Note: Arc planes
must be parallel.

Distance between
the arc axis and the
plane.

Note: The plane and
the arc plane must
be perpendicular.

Plane Distance between
the two planes.

Note: The planes
must be parallel.

Table 8–15 (Cont.) 3D Snapping Modes

Button Description Behavior
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See 3D Snapping Modes for more information.All entities of the selected snapping
modes are highlighted on the model.

4. On the model, select the entity you want to measure from.

If you want to take more than one measurement from the same starting point,
select the Fix Position check box. The location of the entity appears in the From
field.

5. Click inside the To field to select the entity type that you want to measure to.

6. Select the snapping modes that you want to select as the end point for the
measurement.

All entities of the selected entity types are highlighted on the model.

7. On the model, select the entity you want to measure to.

The location of the entity appears in the To field.

8. Click again to complete the measurement.

The measured line path appears in a value box entity on the current active
markup. The measured distance, Delta X, Delta Y and Delta Z appear in the
Measurement dialog.

9. Drag to move the measured line path.

10. Click on the measured line path.

11. To move the value box, click and drag it to anywhere on the drawing.

12. To resize the value box, select it and then click and drag the frame handles.

To take another measurement click Reset.

13. Click Close to close the Measurement Entities dialog.

8.14.1.4 Calibrating Distance
Calibrate the distance measurement.

1. Measure distance between two points or measure cumulative distance.

2. From the Distance tab, click Calibrate.

The Distance Calibration dialog appears displaying the measured distance.

3. From the Units list, select the unit to which you want to calibrate the distance.

4. Select Calibrate to and enter a value if you want to calibrate the distance to a
value.

5. Select Set Factor and enter a value if you want to calibrate the distance by a factor.

6. Click OK.

The calibration result appears in the Measurement dialog.

7. Click Close to close the Distance tab.

8.14.1.5 Measuring an Angle
Use the Angle option to measure the precise angle between points on a drawing.

1. From the Markup menu, select Add entity, select Measurement, and then select
Angle.

From the Markup Entity toolbar, you can also click Angle .
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The Measurement Entities dialog appears.

2. Click the Angle tab.

3. Select the snapping modes that you want to use for measuring.

Entities of the selected types are highlighted on the model.

4. To measure the angle between an entity type and a plane, select the With Plane
check box, and then select the plane from the list.

5. From the Measured Angle Units list, select the unit in which you want to measure
the angle.

6. Click two points on the model to define the angle.

7. If you selected a Plane, click the vertex, edge or face whose angle you want to
measure between the plane.

To take another measurement click Reset.

Angle arms appears indicating the angle.The measurement appears in the
Measurement dialog

8. Click Close to close the Measurement dialog.

8.14.1.6 Measuring an Arc
Use the Arc option to measure the precise radius, length and angles of any arc on the
model. It also calculates the center point location.

1. From the Markup menu, select Add Entity, Measurement, and then Arc.

From the Markup Entity toolbar, you can also click Arc .

The Measurement Entities dialog appears.

2. Select Arc Entity if you want to measure a predefined arc.

All arc and circles are highlighted on the model. Snapping modes are disabled.

3. Select From 3 Points if you want to measure the arc between three points.
Snapping modes are disabled.

4. Select the snapping modes that you want to use for measuring.

All entities of the selected entity types are highlighted on the model.

5. From the Dist. Units list, select the unit in which you want to measure the arc
distance.

6. From the Angles Units list, select the unit in which you want to measure the
angle.

7. If you selected From 3 Points, click three points to define the arc.

The points are joined by an arc.

8. If you selected Arc Entity, click the edge of the arc.

The arc is highlighted.

9. Click to complete the measurement.

The measurements for arc center point coordinates, radius, diameter, arc length,
start and end of angle and sweep appear in the Measurement Entities dialog.

10. To move the value box, click and drag it to anywhere on the markup.

11. To resize the value box, select it and then click and drag the frame handles.



3D-Specific Markups

8-52 Oracle AutoVue User Manual

12. Click Close to close the Measurement Entities dialog.

Click Reset to take another measurement.

8.14.1.7 Calibrating an Arc
1. Measure an arc in the drawing.

2. From the Arc tab, click Calibrate.

The Radius Calibration dialog appears displaying the measured distance.

3. From the Units list, select a unit of measurement to which you want to calibrate
the distance.

4. Click Calibrate to and enter a value if you want to calibrate to a value.

5. Click Set Factor and enter a value if you want to calibrate by a factor.

6. Click OK.

The calibration results appear in the Arc tab.

7. Click Close to close the Measurement dialog.

8.14.1.8 Measuring Minimum Distance
With the Minimum Distance option to measure the minimum distance between model
parts, as well as any two points from the selection sets: vertices, edges, mid-edges, arc
axes, arc centers, faces or any combination of entity types.

1. From the Markup menu, select Add Entity, Measurement, and then select
Minimum Distance.

From the Markup Entity toolbar, you can also click Minimum Distance .

The Measurement Entities dialog appears.

2. Click Set 1.

3. From the Snapping Mode section, select one of the following:

■ Select Entity if you want to measure the distance between model parts.
Snapping modes are disabled.

■ Select Geometry if you want to measure the distance between entity types.
Snapping modes are enabled.

See 3D Snapping Modes for more information.

4. If you selected Entity, select a part or parts on the model. If you selected
Geometry, select the snapping modes that you want to use for measuring.

To reset a set, click Clear. To clear items from a set, select the items and press the
Delete key. To de-select a part or entity type on the model, press the Control key
and left-click the part or entity type.

The model parts appear in the list under Set 1 and are highlighted on the model
and in the Model Tree. All entities of the selected entity type are highlighted on the
model.

5. Click Set 2.

6. Repeat steps 3 and 4. The model part appears in the list under Set 2.

7. From the Measured Min. Distance Units list, select the unit in which you want to
measure the distance.
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8. Click Compute.

The minimum distance from the first set of entities to the second set is highlighted
by a line. The measured line path, measurement and unit appear in a value box
entity on the current active markup layer. The X, Y, and Z coordinates for Position
1 and X, Y and Z coordinates for Position 2 appear in the Measurement Entities
dialog.

9. Click and drag the value box anywhere on the markup.

10. To resize the value box, select it and then click and drag the frame handles.

Click Reset to take another measurement.

11. Click Close to close the Measurement dialog.

8.14.1.9 Measuring Vertex Coordinates
The Vertex Coordinates option provides the coordinates of vertices on the model.

1. From the Markup menu, select Add Entity, Measurement, and then Vertex
Coordinate.

From the Markup Entity toolbar, you can also click Vertex Coordinate .

The Measurement Entities dialog appears.

2. Scroll over the vertex whose coordinates you want to add to the markup.

The X, Y, and Z coordinates appear in a tooltip.

3. Click the Vertex tab.

The X, Y, an Z coordinates and unit appear a value box entity on the current active
markup layer and in the Measurement Entities dialog.

4. Click and drag the value box anywhere on the markup.

Click Reset to take another measurement.

Click and drag the frame handles to enlarge the value box.

5. To remove the highlighted vertices on the model, click Close to close the
Measurement dialog.

8.14.2 Adding Text
With AutoVue, you can add a 3D text box entity to a markup.

1. From the Markup menu, select Add Entity, and then select Text.

From the Markup Entity toolbar, you can also click 3D Text .

2. The Attach To dialog appears and provides six snapping options:

Table 8–17 Snapping Options

Options Description

None Does not snap to the model.

Vertex Snaps to a vertex on the model.

Edge Snaps to a edge on the model.

Face Snaps to a face on the model.

Mid Edge Snaps to a middle of an edge on the model.
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3. To insert a text box that snaps to a part of the drawing with a leader line, select one
of the snapping modes.

4. Click and drag on the drawing to define the dimensions of the text box.

5. Click in the text box and enter the text you want to add.

The height of the text box will change to accommodate the text.

6. To change text box font properties, from the Markup menu, select Format, and
then select Font.

From the respective font property lists on the Markup Properties toolbar, you can
also modify the font type, style, and size.

The Font dialog appears allowing you to change the font type, style, and size

7. Click OK to implement the font changes and to close the Font dialog.

8. To change the line properties or fill color of the text box, select the text box, then
from the Markup menu, select Format, and then select the property or properties
you want to change.

From the respective line property lists on the Markup Properties toolbar, you can
also modify the line style, line thickness, fill types, and fill colors.

9. Right-click outside the text area to complete the modification.

The text appears on the drawing and in the Markup Navigation Tree

10. To move the text box, click and drag it to anywhere on the drawing.

11. To resize the text box, select it and then click and drag the frame handles.

To edit the text, double-click the text box in the tree or in the workspace.

8.14.3 Adding a Note
You can attach longer comments as a markup sticky note on the drawing. A note
displays in the workspace as a standard size graphical symbol . Each note is
labeled as Note<n>—where n represents the numerical order of occurrence of the note
(for example, the first note is labeled as Note1). To read the note, double-click the
entity to open it or move the mouse over the entity to display the tooltip.

When copying and pasting text from a Rich Text file (RTF) into
the AutoVue workspace, the text gets added to a Markup Note entity.
When copying and pasting text from a plan text file to the AutoVue
workspace, it is added to a Markup Text Box entity.

When creating multiple Note entities, it is possible to group the entities. Once the Note
entities are grouped, clicking on the group opens the last Note created.

1. From the Markup menu, select Add Entity, and then select Note.

From the Markup Entity toolbar, you can also click Note .

The Attach To dialog appears.

Arc Center Snaps to the center point of an arc on the model.

Note:

Table 8–17 (Cont.) Snapping Options

Options Description
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2. In the Attach To dialog, click the entity type that you want to attach the note to.

3. Select the entity on the model that you want to attach a note to.

The Note dialog appears.

4. Enter the text that you want in the dialog.

5. From the File menu, select Information.

The Note Information dialog appears.

6. To change the default font, select Font and the type of font.

7. Close the Note dialog.

The note symbol appears on the entity and in the Markup Navigation Tree.

8. Right-click outside the note area to complete the modification.

To edit a note, double-click on the note.

Whenever an entity is attached to a 3D model, the anchor point (the point at which
the entity is attached) is highlighted by a small square. The square is visible only
when the anchor point is visible. This feature allows you to precisely identify the
location of the anchor point and whether the associated entities are visible or
hidden.

8.14.3.1 Printing a Note
You can get a single Markup Note entity.

1. From the AutoVue Workspace or Markup tree, double-click a Markup Note entity.
The Note dialog appears.

2. From the Note dialog, select File and then Print. The Print dialog appears.

3. Select the a printer and click OK.

8.14.4 Nesting Markup Entities
You can add a Note or Hyperlink markup entity as a nested child to other markup
entities.

1. Add a markup entity to a file (for example, a Box entity).

2. From the workspace or Markup Tree, select the Box entity.

3. From the Markup menu, select Note.

From the Markup Entity toolbar, you can also click Note .

In the Markup Tree, the selected markup entity appears as a child of the Box
(parent) entity.

8.15 Working with Markup Entities
With AutoVue, you can assign a markup entity its own color, the same color as the
current active layer, or a custom color. You also have the option of grouping markup
entities. When you group markup entities, you can manage the group as you would a
single entity.

In Markup mode, there are several options for modifying an entity. You can apply
these options to selected pre-existing entities or to new entities that you add.
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8.15.1 Go To a Markup Entity
The Go To feature restores the view state to when an entity was first created. Opening
an existing Markup file also restores the last saved view state.

From the Markup Navigation Tree, right-click the markup entity that you want to view
and select Go To.

Double-clicking on a markup entity from the Markup
Navigation tree also has the same result as the Go To feature.

AutoVue displays the markup page containing the entity.

If you selected a markup entity that is on another page of the Markup file, the page
containing that entity will be displayed.

8.15.2 Selecting Markup Entities
To select a markup entity, click the markup entity’s outer edge.

To select multiple entities, press the Shift or Control key while selecting. The markup
entity or entities are selected. You can also select the markup entities from the Markup
Navigation Tree. To select multiple entities, press the Shift or Control key while
selecting.

8.15.3 Moving a Markup Entity
In the Markup Navigation Tree or in the workspace, select the markup entity or
entities that you want to move.

To select multiple entities, press the Shift or Control key while selecting.

In the workspace, click and drag the selected markup entity or entities to anywhere in
the workspace.

8.15.4 Transforming Markup Entities

This menu option is only available for 2D and EDA files.

AutoVue provides the option to rotate markup entities.

8.15.5 Rotating all Markup Entities
From the Markup menu, select Transform, and then select Rotate. From the menu that
appears, you have one of two options to select from:

■ Rotate Clockwise: Rotates the markup entity 90 degrees in the clockwise
direction.

■ Rotate Counter Clockwise: Rotates the markup entity 90 degrees in the
counter-clockwise direction.

Note:

Note:

Note:



The markup entities rotate with respect to the center point of
the drawing.

Working with Markup Entities

Markups 8-57

8.15.6 Rotating a selected Markup Entity
This feature is only supported for the Text and Stamp markup entities.

1. From the workspace or the Markup Navigation Tree, select the markup entity to
rotate.

It is not possible to select multiple markup entities to rotate.

2. From the Markup menu, select Object, and then select Rotate.

3. Rotate the markup entity by clicking and dragging its control points. Pressing the
Shift key while dragging will snap the rotation to 45 degree intervals.

8.15.7 Changing Object Order
You can change the order of markup entities in a markup layer. To move an entity
forward or backward, do the following:

1. Select an entity from the workspace or Markup Entity tree.

2. From the Markup menu, select Object, then select Order, and then select one of
the following options:

Table 8–18 Options

8.15.8 Hiding All Markup Entities
To hide all markup entities, do the following:

1. From the Markup menu, select Hide Markups.

A check mark appears next to the Hide Markups option and the markup entities
are hidden on the Markup file.

2. To undo the hide option, from the Markup menu, de-select Hide Markups.

8.15.9 Hiding Markup Files
To hide selected a Markup file, do the following:

1. In the Markup Navigation Tree, right-click the Markup file, then select Hide.

2. To undo the hide option, right-click the file name again and select Show.

8.15.10 Grouping and Ungrouping Markup Entities
When you group markup entities, you can move, delete, copy and paste, transform, or
perform any modification on the group of entities that you would on a single markup
entity.

Note:

Option Description

To Back Moves the markup entity behind all the other entities in the markup layer.

To Front Moves the markup entity in front of all other entities in the markup layer.

Backward Moves the markup entity backward by one level.

Forward Moves the markup entity forward by one level.
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8.15.10.1 Grouping Markup Entities
1. In the Markup Navigation Tree or from the workspace, select the markup entities

that you want to group.

When selecting markup entities in Markup mode, press Ctrl and drag the box to
select all the markup entities within the area.

2. From the Markup menu, select Object, and then select Group.

You can also right-click the selected markup entities and then select Group.

The group of entities appear in the tree under Group.

3. Perform any modifications. The modifications are applied to all the entities in the
group.

8.15.10.2 Ungrouping Markup Entities
1. In the Markup Navigation Tree or from the workspace, select the markup entities

that you want to ungroup.

2. From the Markup menu, select Object, and then select UnGroup.

The group of entities appear on the markup as individual entities.

8.15.11 Deleting Markup Entities
1. Select the markup entity that you want to delete. To select multiple markup

entities, press the Shift or Control keys while selecting.

2. From the Markup Properties toolbar, click Delete Markups .

The selected entity or entities are deleted from the current active file.

You can also press the Delete key to delete the markup
entities. Alternatively, right-click the entity in the workspace or
Markup Navigation Tree, and select Delete.

8.16 Formatting Markup Entity Properties
With AutoVue, you can modify the formatting of a markup entity via the Format
option from the Markup menu, or via the Markup Entity Properties dialog.

See Using the Markup Entity Properties Dialog.

When creating a markup entity, you have the option to change the line color, line style,
line thickness, arrow style, fill color, and fill type. Additionally, you can assign the
markup entity the same color as the layer.

8.16.1 Changing Line Color
To change the line color, do the following:

1. Select the markup entity or entities for which you want to change the line color.

2. From the Markup menu, select Format, and then select Line Color.

Note:

Note:
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From the Markup Properties toolbar, you can also click Line Color. Alternatively,
right-click the entity in the workspace or Markup Navigation Tree, select Format,
and then select Line Color. .

The Line Color dialog appears.

3. From the Line Color list, select the color that you want for the entity.

Selecting Bylayer changes the markup entity color to the color of the layer.

4. To define a custom line color, from the Line Color list, select Custom Color .

5. From the Color dialog that appears, select a color and click OK.

6. Click OK to close the Line Color dialog.

The line color changes for the selected markup entity or entities.

Any new entities that you create will have the new line color.

8.16.2 Changing Line Style
The current line style is highlighted in the Line Style option.

1. Select the markup entity or entities for which you want to change the line style.

2. From the Markup menu, select Format, and then select Line Style. Select the new
line style from the options provided.

The line style changes for the selected markup entity or entities.

From the Markup Properties toolbar, you can also click Line
Style . Alternatively, right-click the entity in the workspace or
Markup Navigation Tree, select Format, and then select Line Style.

Any new entities that you create will have the new line style.

8.16.3 Changing Line Thickness
The current line thickness is highlighted in the Line Thickness option.

1. Select the markup entity or entities for which you want to change the line
thickness.

2. From the Markup menu, select Format, and then select Line Thickness. Select the
new line thickness from the options provided. The line thickness changes for the
selected markup entity or entities.

From the Markup Properties toolbar, you can also click Line Thickness .
Alternatively, right-click the entity in the workspace or Markup Navigation Tree,
select Format, and then select Line Thickness.

3. To define a custom line thickness, from the Markup menu, select Format, select
Line Thickness, and then select Customize.

The Custom Thickness dialog appears.

4. In the Line Thickness field, enter an integer value in pixels.

5. Click OK to close the Custom Thickness dialog.

Note:

Note:

Note:
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Any new markup entities that you create will have the new line thickness.

8.16.4 Changing Arrow Style
AutoVue gives you the option to add an arrow head to certain markup entities. For
example, you can change the arrow style of the line, polyline, arc, freestyle, and
polygon markup entities.

1. Select the markup line entity or entities for which you want to change the arrow
style.

2. From the Markup menu, select Format, and then select Arrow Style. Select the
new arrow style from the options provided.

The arrow style changes for the selected markup line entity or entities.

■From the Markup Properties toolbar, you can also click Arrow
Style . Alternatively, right-click the entity in the workspace or
Markup Navigation Tree, select Format, and then select Arrow
Style.

■ Any new entities that you create will have the new arrow style.

8.16.5 Changing Fill Type
1. Select the markup entity or entities for which you want to change the fill type.

2. From the Markup menu, select Format, and then select Fill Type.

From the Markup Properties toolbar, you can also click Fill Type .
Alternatively, right-click the entity in the workspace or Markup Navigation Tree,
select Format, and then select Fill Type.

The Fill Type dialog appears.

3. From the Fill Type list, select the fill type that you want for the markup entity:

■ Select Solid Fill, if you want the fill color to be solid.

■ Select Transparent Fill, if you want the fill color to be transparent.

■ Select No Fill, if you do not want any fill color.

4. Click OK. The fill type changes for the selected markup entity or entities. Any new
markup entities that you create will have the new fill type.

8.16.6 Changing Fill Color
1. Select the markup entity or entities for which you want to change the fill color.

2. From the Markup menu, select Format, and then select Fill Color.

From the Markup Properties toolbar, you can also click Fill Color .
Alternatively, right-click the entity in the workspace or Markup Navigation Tree,
select Format, and then select Fill Color.

The Fill Color dialog appears.

3. From the Fill Color list, select the color that you want for the markup entity.

Selecting Bylayer changes the markup entity color to the color of the layer it is
on and selecting Line Color assigns the same color as the markup entity’s line.

Note:
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4. To define a custom line color, from the Line Color list, select Custom Color .

5. From the Color dialog that appears, select a color and click OK.

The fill color changes for the selected markup entity or entities.

6. Click OK to close the Fill Color dialog.

Any new markup entities that you create will have the new fill color.

8.16.7 Assigning a Markup Entity the Same Color as the Layer
1. Select the markup entity or entities for which you want to assign the color of the

layer that they belong to.

2. To assign the line color:

■ From the Markup menu, select Format, and then select Line Color. The Line
Color dialog appears.

From the Markup Properties toolbar, you can also click Line
Color Right-click the entity in the workspace or Markup
Navigation Tree, select Format, and then select Line Color.

■ From the Line Color list, select Bylayer .

3. To assign the fill color:

■ From the Markup menu, select Format, and then select Fill Color. The Fill
Color dialog appears.

From the Markup Properties toolbar, you can also click Fill
Color .

■ From the Line Color list, select Bylayer .

4. Click OK. The selected markup entity or entities change to the color of the layer
that the entity belongs to.

8.16.8 Changing Font
You can change the font of the text box, leader, and measurement entities.

1. Create the markup entity that you want.

2. From the workspace or the Markup Navigation Tree, select the markup entity for
which you want to modify the font then do one of the following:

■ From Markup menu, select Format, and then select Font. The Font dialog
appears. From the lists select the font, font style, and font size. You also can
select to add a strikeout and underline by selecting their check boxes. Click
OK to the close the dialog and implement the changes.

■ From the Markup Entity toolbar, select the font, font size, and font style (bold,
italic, and underline) from their respective lists and buttons. The font changes
are implemented.

Note:

Note:
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8.16.9 Changing Measurement Units and Symbols
You can change the unit of measure and add a symbol to a measurement and have it
appear on the drawing.

1. Create the markup measure entity that you want.

2. Double-click the measurement that you want to change the unit of measure or add
a symbol to.

The appropriate Measure dialog appears.

3. De-select Display Unit check box if you want to hide the unit on the drawing. It is
selected by default.

4. From the Units list, select the unit that you want to change the measurement to.

5. From the Symbol list, select the symbol that you want to add to the measurement.

6. Click OK. The unit of measure changes and the selected symbol is added to the
measurement and appears in the workspace.

8.16.10 Using the Markup Entity Properties Dialog
You can use the Markup Entity Properties dialog to modify markup entities.

1. Select the markup entity you want to modify. To select multiple markup entities,
press the Shift or Control key while selecting.

2. From the Markup menu, select Format, and then select Markup Entity Attributes.

You can also right-click a markup entity in the Markup Navigation Tree or the
workspace, select Format, and then select Markup Entity Attributes.

The Markup Entity Properties dialog appears.

8.16.10.1 Line Color
Change the line color the selected markup entity or entities.

1. Select the markup entity or entities for which you want to change the line color.

2. From the Line Color list, select the color that you want for the entity.

Selecting Bylayer changes the entity color to the color of the layer.

3. Click OK to close the Markup Entity Properties dialog.

8.16.10.2 Defining a Custom Line Color
To define a custom line color, take the following steps:

1. From the Line Color list, select Custom Color .

The Color dialog appears.

2. Select a color and click OK.

3. Click OK to close the Markup Entity Properties dialog.

If you selected markup entities prior to specifying a custom color, only the selected
entities will have the new line color. To apply the new line color to any new
markup entity you create, make sure no markup entity is selected before opening
the Markup Entity Properties dialog.

The line color changes for the selected markup entity or entities.
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8.16.10.3 Line Style
Change the line style for a selected markup entity or entities.

1. Select the markup entity you want to change the line style. To select multiple
markup entities, press the Shift or Control key while selecting.

2. From the Line Style list, select the required line style.

3. Click OK to close the Markup Entity Properties dialog.

Any new markup entities that you create will have the new line style.

The line style changes for the selected markup entity or entities.

8.16.10.4 Line Thickness
Change the line thickness for a selected markup entity or entities.

1. Select the markup entity for which you want to change the line thickness. To select
multiple markup entities, press the Shift or Control key while selecting.

2. From the Line Thickness list, select the required line thickness. The line thickness
changes for the selected markup entity or entities.

8.16.10.5 Defining a Custom Line Thickness
To define a custom line thickness, do the following:

1. From the Line Thickness list, select Customize.

2. In the Width (Pixels) field, enter the desired width.

3. Click OK to close the Markup Entity Properties dialog.

The line thickness changes for the selected markup entity or entities.

Any new markup entities that you create will have the new
line thickness.

8.16.10.6 Arrow Style
Add an arrow head at one or both ends of a markup line entity.

1. Select the markup line entity you want to change the arrow style. To select
multiple markup line entities, press the Shift or Control key while selecting.

2. From the Arrow Style list, select the style of arrow that you want for the markup
line entity.

3. Click OK to close the Markup Entity Properties dialog. The arrow style changes
for the selected markup line entity or entities.

Any new markup line entities that you create will have the
new arrow style.

8.16.10.7 Fill Type
Change the transparency for selected markup entity or entities.

1. Select the markup entity or entities for which you want to change the fill type. To
select multiple markup entities, press the Shift or Control key while selecting.

2. From the Fill Type list, select the fill type that you want for the markup entity:

Note:

Note:
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■ Select Solid Fill, if you want the fill color to be solid.

■ Select Transparent Fill, if you want the fill color to be transparent.

■ Select No Fill, if you do not want any fill color.

3. Click OK. The fill type changes for the selected markup entity or entities.

Any new markup entities that you create will have the new fill
type.

8.16.10.8 Fill Color
Change the line color, fill color, and fill type for a selected markup entity or entities.

1. Select the markup entity or entities for which you want to change the fill color. To
select multiple markup entities, press the Shift or Control key while selecting.

2. From the Fill Color list, select the color that you want for the markup entity.

Selecting Bylayer changes the markup entity color to the color of the layer it is
on and selecting Line Color assigns the same color as the markup entity’s line.

8.16.10.9 Defining a Custom Color
To define a custom color, do the following:

1. From the Fill Color list, select Custom Color . The Color dialog appears.

2. Select a color and click OK. The fill color changes for the selected markup entity or
entities.

3. Click OK to close the Markup Entity Properties dialog. The fill type changes for
the selected markup entity or entities.

Any new markup entities that you create will have the new fill
color.

8.16.10.10 Markup Layers
You can move selected markup entities to a specific layer—the markup entities will
inherit the properties of the layer.

1. From the Markup Layer list, select the layer you want to make active.

2. Click OK to close the Markup Entity Properties dialog.

The selected layer appears in the workspace.See Setting the Active Markup Layer.

8.16.10.11 Leader Alignment
With the Leader markup entity, you can adjust the location of the leader line’s anchor
point to the text box. The Leader Alignment list has the following option for anchor
point location with respect to the text box: Top Left, Top Center, Top Right, Center Left,
Center, Center Right, Bottom Left, Bottom Center, and Bottom Right.

8.16.10.12 Text Box Visibility
You can choose to hide the surrounding box for the Leader, Text, and 3D Text markup
entities.

Note:

Note:



9

Printing 9-1

9Printing

With AutoVue, you can print and preview files. Files can be printed on their own or
with associated markups and overlays. You can also choose which markup layers to
make visible so that they can print.

With the Batch Print option, you can send a list of files to print at the same time.

When printing a file, there are print properties that you can define. From the File
menu, select Print to display the following properties:

Table 9–1 Print Properties

9.1 Print Options
With the Options tab, you can define print options for the printed file. The options are:

Option Description

Print Define the print options

See Print Options.

Margins Define the margin settings

See Print Margins.

Headers/Footers Define the headers/footers to be included on every page
printed.

See Header/Footer.

Watermark Define the watermark to be included on every page printed.

See Watermarks.

Pen Settings Change the thickness assigned to a pen.

See Assigning Pen Settings.

Table 9–2 Print Options

Printer Dialog
Section Option Description

Printer Modify Select a printer and configure print properties, such as
paper size, number of copies, and so on.

Paper Size Displays selected paper size. This option also allows you to
modify the paper size.

Orientation Portrait - Specify if file should be printed portrait.
Landscape - Specify if the file should be printed landscape.

Auto - Specify if orientations should be printed as saved in
the file.
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Units From the drop-down list, set the unit for Scaling and
Alignment/Offset. The available units are pixels, inches
and millimeters.

Scaling Fit to Page Scales the image to fit on the output page.

Factor Specifies the number of drawing units per specified
number of inches.

Scale Scales the image according to a percentage. You can select a
predefined scaling factor or manually enter a custom
scaling factor.

Decimal places are accepted.

Alignment

/Offset

Specify where the drawing will appear on the printout.
You can define custom alignment in inches by entering a X
and Y value.

Note: This feature is disabled for spreadsheet formats.

Document
Pages

Specify the document pages to print: All, Current or
Range.

Page Area Select the page area to print.

Extents Print the extent of the document.

Displayed Print the area displayed in the View window.

Option is always enabled.

Limits Prints the file limits instead of extents.

Option is disabled when Current is selected for Document
Pages.

Note: This option is only available for AutoCAD drawings
that have the limits defined.

Selected This option is grayed out by default. To enable, click Select
and then select a print range. The Selected option is now
enabled.

Native settings
(from file)

This option only applies to Excel files. When selected,
AutoVue uses Excel’s print settings that are saved in the
excel document. The following print settings are
supported: Page Orientation, Scaling, Paper Size, Print
Areas, Page Breaks, Row and Column headers, Grid lines,
Left/Right/Top/Bottom margins.

Force to Black Force all colors to gray-scale.

Output a single
page

Limits output to a single page when the scaling options
selected causes a single page to span over several pages.

Note: This option is only available when Scale of Factor is
selected in the Scaling section.

Skip Blank
Pages

This option omits blank pages when printing.

Print Notes When in Markup mode, select this option to print the Note
markups of the current file.

Note: This option is only available when in Markup mode.

Table 9–2 (Cont.) Print Options

Printer Dialog
Section Option Description



Print Margins

Printing 9-3

9.2 Configuring the Print Options
1. From the File menu, select Print.

From the AutoVue toolbar, you can also click Print .

The Print Properties dialog appears.

2. Click the Options tab.

3. Configure the print options.

4. Configure other print options.

5. To view a partial view of the file, click Partial Preview.

The Partial Print Preview dialog appears.

6. Click OK to print. The Print dialog appears indicating the document is printing.

9.3 Print Margins
From the Margins tab of the Print Properties dialog, you can define the top, bottom,
right and left margins for the printed file. You can define:

Table 9–3 Print Margins

9.3.1 Setting the Margins
1. From the File menu, select Print.

From the AutoVue toolbar, you can also click Print .

The Print Properties dialog appears.

2. Click the Margins tab.

Print One Note
Per Page

When in Markup mode, select this option to print one Note
markup per page of the current file.

Note: This option is only available when in Markup mode.

Print Row
Headers

Select this option to print row headers.

Option is only enabled for spreadsheets and archive files.

Print Column
Headers

Select this option to print column headers.Option is only
enabled for spreadsheets and archive files.

Partial Preview Display a view of the printer page, highlighting the
printable area.

Option Description

Margins Set the value for the Left, Top, Right, and Bottom margins.

Minimum Set the acceptable minimum margins for the selected printer.

Units Specify the unit for the margins.

Override Printing Minimum
Margins

Select this option to override the predefined minimum print
margins.

Table 9–2 (Cont.) Print Options

Printer Dialog
Section Option Description
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3. Enter the margin size that you want for Left, Top, Right, and Bottom or click
Minimum if you want to set the margins to the minimum acceptable for the
selected printer.

4. To define margins that are less the minimum acceptable for the selected printer,
select Override Printing Minimum Margins.

5. From the Units list, select the unit to which you want to set the margins.

6. Configure other print options.

7. To view a partial view of the file, click Partial Preview.

The Partial Print Preview dialog appears.

8. Click OK to print. The Print dialog appears indicating the document is printing.

9.4 Header/Footer
From the Headers/Footers tab of the Print Properties dialog, you can define the
headers and footers that you want to print on every page of the document. You can
enter the text manually or choose from a list of Insert Codes.

The list of insert codes are:

■ %f: Full path of document

■ %v: Document Drive

■ %d: Document Directory

■ %b: Document Base name

■ %e: Document file extension

■ %n: Total document pages

■ %p: Current page number

■ %N: Total tiled-pages

■ %P: Current tile number

■ %Y: Date: Year

■ %M: Date: Month

■ %D: Date: Day

■ %W: Date: Day of week

■ %H: Time: Hour

■ %U: Time: Minute

■ %S: Time: Seconds

■ %r: New line

■ %F: Native Print Settings (Excel)

A literal percentage mark is entered manually as %%.

You can also print system variables in headers and footers. Select a variable from the
Insert Variable list. Some Insert Variable options are: user.name, browser and
java.home.

Note:
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9.4.1 Adding a Header and Footer
In the Headers/Footers tab, you can manually enter text or choose from a list of Insert
Codes to appear in the headers and footers. You can also print system variables.

1. From the File menu, select Print.

From the AutoVue toolbar, you can also click Print.

The Print Properties dialog appears.

2. Click the Headers/Footers tab.

3. Click in the Left, Center or Right field and enter the text that you want to appear
in the header and footer, or choose an Insert Code or Insert Variable.

4. To Insert Code in the header or footer, click Left, Center or Right, then select a code
from the list.

5. To Insert Variable in the header or footer, click Left, Center or Right, then select a
variable from the list.

6. To change the Font, click Set Font. The Font dialog appears.

7. From the Font list, select the type of font.

8. From the Size list, select the size of font.

9. To set the font Style, click Bold or Italic or both, then click OK.

10. In the Print Properties dialog, configure other print properties.

11. To view a partial view of the file, click Partial Preview.

The Partial Preview dialog appears.

12. Click OK to print. The Print dialog appears indicating the document is printing.

9.4.2 Native Print Settings
You can choose to include predefined headers and footers when printing an Excel file
from AutoVue.

1. From the Print Properties dialog, click the Headers/Footers tab.

2. Under Headers and Footers, click inside the Left, Center, and Right boxes
corresponding to the header or footer position in the original file.

3. Select %F: Native Print Settings (Excel) from the Insert Code list.

4. Click OK to print. The Excel file’s headers and footers are printed.

9.4.3 Watermarks
From the Watermark tab of the Print Properties dialog, you can specify a watermark
that will appear on a printed file. When printing a watermark, it appears transparent
on the file contents. You can choose a diagonal, horizontal or vertical orientation for
the watermark.

In addition to entering text, you can:

■ set the type, size and style of font

■ insert Watermark information

■ print system variables
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To insert Watermark information, AutoVue provides a list of codes that you can choose
from. These codes are:

■ %f: Full path of document

■ %v: Document Drive

■ %d: Document Directory

■ %b: Document Base name

■ %e: Document file extension

■ %n: Total document pages

■ %p: Current page number

■ %N: Total tiled-pages

■ %P: Current tile number

■ %Y: Date: Year

■ %M: Date: Month

■ %D: Date: Day

■ %W: Date: Day of week

■ %H: Time: Hour

■ %U: Time: Minute

■ %S: Time: Seconds

■ %r: New line

■ %F: Native Print Settings (Excel)

A literal percentage mark is entered manually as %%.

You can also print system variables in watermarks. Select a variable from the Insert
Variable list. Some Insert Variable options are: user.name, browser and java.home.

9.4.4 Adding a Watermark
1. From the File menu, select Print.

From the AutoVue toolbar, you can also click Print.

The Print Properties dialog appears.

2. Click the Watermark tab.

3. Enter the Watermark Text that you want to appear on the file.

4. To insert a code in the watermark, select a code from the Insert Code list.

For example, if you select %n: Total document pages, the total number of pages for
the selected file will appear in the Watermark. You can insert more than one code.

5. To insert a system variable, select a variable from the Insert Variable list.

For example, if you select browser.version, the version of the browser that the file
is displayed in will appear in the Watermark.

You can insert more than one system variable.

Note:
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6. To set the orientation of the watermark, click Diagonal, Horizontal or Vertical.

7. To change the Font, click Set Font. The Font dialog appears.

a. From the Size list, select the size of font.

b. From the Font list, select the type of font.

8. In the Print Properties dialog, configure other print properties.

9. To view a partial view of the file, click Partial Preview.

The Partial Preview dialog appears.

10. Click OK to print. The Print dialog appears indicating the document is printing.

9.5 Assigning Pen Settings
From the Pen Settings tab of the Print Properties dialog, you can set the thickness of
the color indices for the print file.

AutoVue uses the default pen color indices of the native
document for the vector file being viewed. You will not be able to
change the color assigned to a pen with AutoVue.

1. From the File menu, select Print.

From the AutoVue toolbar, you can also click Print.

The Print Properties dialog appears.

2. Click the Pen Settings tab.

3. Under From/To, select the Color Index that you want to assign a new pen
thickness.

To change more than one color indices, press the Shift or Control key while
selecting.

4. From the Units list, select the unit of measure that you want to set the thickness.

5. Enter the new thickness. The new Thickness appears beside the Color Index.

6. In the Print Properties dialog, configure other print properties

7. Configure other print options.

8. To view a partial view of the file, click Partial Preview.

The Partial Print Preview dialog appears.

9. Click OK to print. The Print dialog appears indicating the document is printing.

9.5.1 Creating a New Pen Setting
1. Set the thickness for the color indices that you want.

2. Click Save As. The Save As dialog appears.

3. Enter a file name with a .c2t extension, then click OK. The new pen setting appears
in the Current Pen Settings list.

4. In the Print Properties dialog, click OK to print.

The Print dialog appears indicating the document is printing.

Note:
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9.5.2 Deleting a Pen Setting
1. Select the pen setting that you want to delete from the Current Pen Settings.

2. Click Delete.

The pen setting disappears from the list.

3. Click Cancel to close the Print Properties dialog.

9.6 Partial Preview of a File
The Partial Print Preview dialog displays the printable area on top of the page area so
that users can have a clear idea of what will be printed.

Option is only enabled when Current is selected from
Document Pages.

1. Configure the print properties.

2. Click Partial Preview in the Print Properties dialog. The Partial Print Preview
dialog appears and highlights the area that will be printed. The Paper size,
Printable Area, and Drawing Area are displayed.

3. Click OK to close the Partial Print Preview dialog.

9.7 Previewing a File Before Printing
You can preview a print copy of the current active file on screen according to your
printer’s capabilities and the print property settings.

1. View the file in AutoVue.

2. From the File menu, select Print.

From the AutoVue toolbar, you can also click Print.

The Print Properties dialog appears.

3. Configure the print properties.

4. Click OK.

You can print the file from the Print Preview window by clicking Print. You can
also zoom in and out of a file, as well as navigate from one page to another of a
multi-page file.

The file appears in Print Preview Mode in the Print Preview window.

5. Click Close to close the Print Preview window.

9.8 Printing a File
You can print original files along with their Markup files and selected markup layers
together so that they appear as one file.

When printing AutoCAD or PDF files with layer printability,
layers marked as “non-printable” may appear in the output when in
Compare mode.

Note:

Note:
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1. Open the file you want to print.

2. To print the associated markups, open the Markup file or files you want to print.

3. If you are printing Markup files and you want to print the visible layers, from the
Markup menu, select Markup Layers.

The Markup Layers dialog appears.

4. Select the markup layers you want visible.

5. Click OK to close the Markup Layers dialog.

6. From the File menu, select Print.

From the AutoVue toolbar, you can also click Print.

The Print Properties dialog appears.

7. Configure the print properties.

8. To view a partial view of the file, click Partial Preview.The Partial Print Preview
dialog appears.

9. Click OK to print. The Print dialog appears indicating the document is printing.

9.9 Batch Printing
With the Batch Print option you can send a list of files to print at the same time. You
can also generate a batch by simultaneously opening all the files included in the batch
print.

1. From the File menu, select Batch Print.

The Batch Print dialog appears.

2. To add a file to be printed, click Add.

The Open dialog appears.

3. Enter the file name or browse to locate the file or files that you want to add, then
click Open.

To add more files to the list, repeat steps 2 to 4. To remove a file(s), select the file
from the List of files to be printed and click Remove.

The files appear in the List of files to be printed.

4. Click OK in the Batch Print dialog.

The Print Properties dialog appears.

5. Configure the print properties.

6. Click OK to print. The Print Progress dialog appears. It displays document name,
number of pages and printing status (OK, Canceled or Printing). When the print
job completes, the dialog remains open and displays the print status of each job.
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Figure 9–1 Print Progress

7. To cancel a print job, select a check box to the left of the file and click Cancel
Job(s). Clicking the Close icon minimizes the Batch Print dialog to the lower left
corner of the AutoVue status bar. To restore the Batch Print dialog, click the Batch
Print icon on the AutoVue status bar.
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10Conversion

Sometimes you need to convert a file to be able to use it with an application it was not
created from. AutoVue provides several conversion file formats for you.

10.1 Conversion Options

3D files conversion is not supported.

From the File menu, select Convert to open the Convert dialog. Depending on the
conversion type being performed, the available options in the Convert dialog may
vary. These options are:

Note:

Table 10–1 Conversion Options

Option Description

Color Depth Select an option from the list:

1 = Black and white

4 = 16 colors

8 = 256 colors

24 = True color

auto = AutoVue selects the color depth that best matches the original
file.

Convert to Format A list of all the possible types of output file formats currently
available for conversion. The available formats are:

PDF

TIFF

Windows Bitmap

Note: Conversion to PDF is not supported when the AutoVue server
is running on Linux platforms.

Output Specify the name and path of the file in which the conversion is to be
stored. This file is also known as the output file. You can use Browse
to provide AutoVue with the file’s path.

If writing onto an existing file, a warning message appears, asking if
you want to overwrite the existing file.

Sub-Format The Sub-Format list appears when you select HP Laserjet Print or
TIFF from the Convert to Format list. Select a sub-format from the list.
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10.2 PDF
With AutoVue it is possible to convert Office, 2D and EDA formats to PDF. When
converted from Markup Mode, markups are added to the contents of the base PDF file.
When you open the PDF, you will see the base file along with all markups.

10.3 X and Y
Three factors affect the resolution of an image: the type of image you are scanning, the
output device and the acceptable file size. High-resolution scans often require large
files, causing longer processing and print time. Note that a high-resolution may not
produce a better-quality printed image if your output device does not recognize the
higher resolution information stored in the file. To keep file sizes manageable, select
the lowest resolution that provides acceptable quality on your output device.

With some file types, the Size option appears giving you a choice between millimeters
and inches. Page sizes can be selected from the Size list or you can customize page
sizes by configuring the Initialization file. For more information, refer to the Installation
and Configuration Guide.

Convert Region The area of the file to be converted. The available options are:

Display - The area displayed in the workspace. For example, if you
zoomed in on a particular region of the file, the zoomed portion of the
file is converted.

Extent - Refers to the entire extents of the file.

Selected - The selected entity is converted.

Convert Pages The pages to be converted. The available options are:

All - convert all pages

Current - convert the current page

Range - convert the pages indicated in the range

Size You can set the size and units (pixels, inches and millimeters) of the
output file.

With raster files the units are preset as pixels:

X indicates the number of horizontal pixels

Y is the number of vertical pixels for the current active file contents.

At times, AutoVue will preset X and Y to match the specifications of
the selected conversion file format. Other times, X and Y will be
available and may be changed according to your preferences. Your
selection here will not affect the current display but will affect the
conversion file’s resolution.

Scale Set the scale percentage of the converted page.

DPI You may set the dots per inch (DPI) for the converted page.

Table 10–2 Size List

Technical Drawing Page Sizes ISO Paper Format

A8.5” X 11.0” (216 mm X 279 mm) A4 285 mm X 198 mm

B11.0” X 17.0” (279 mm X 432 mm) A3 396 mm X 273 mm

Table 10–1 (Cont.) Conversion Options

Option Description
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10.4 Converting a File
To convert a file, do the following:

1. From the File menu, select Convert.

The Input area varies according to the type of file. For example, a word-processing
file displays the file and format, a raster file displays the file path/name, format
and size, and vector and database files display the size, file type and dimensions.

The Convert dialog appears.

2. In the Save As field, enter the path and filename or click Browse to locate the
directory where you want to save the converted file.

If writing on to an existing file, the contents of the output file will be overwritten.

3. Specify the conversion options.

4. Click OK. The file is converted and appears in the specified directory. You can
convert several selected pages of a multi-page file to a multi-page TIFF.

10.5 Changing the Pen Settings
With AutoVue, you can specify a thickness for each pen color when doing a
conversion.

This option only applies to vector files.

1. From the File menu, select Convert.

The Convert dialog appears.

2. Click Pens. The Pen Thickness dialog appears.

3. In the From/To section of the Pen Thickness dialog, select the Color Index for
which you want to modify the thickness.

To select more than one Color Index, press the Shift or Control keys while
selecting.

4. From the Units list, select the unit in which you want to set the thickness.

5. In the Thickness field, enter a thickness value.

6. Press the Enter key.

The new thickness value appears beside the selected Color Index in the From/To
section of the Pen Thickness dialog.

7. To save the changes that you made, click Save As.

The Save As dialog appears.

8. Enter a file name for the new pen settings.

9. Click OK.

C17.0” X 22.0” (432 mm X 559 mm) A2 570 mm X 396 mm

D22.0” X 34.0” (559 mm X 864 mm) A1 817 mm X 570 mm

E34.0” X 44.0” (864 mm X 1118 mm) A0 1165 mm X 817 mm

Table 10–2 (Cont.) Size List

Technical Drawing Page Sizes ISO Paper Format
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To modify an existing pen setting, select the pen setting from the Current Pen
Settings list, make the changes, then click Save.

The new pen settings are saved and appear in the Current Pen Settings list.

10. Click OK to close the Pen Thickness dialog.
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11Real-Time Collaboration

This feature is only available for Client/Server deployment.

The real-time collaboration option enables multiple users to review files interactively
and simultaneously, thereby shortening the review process for documents.

Participants in a Collaboration Session assume different roles. Each Collaboration
Session has a Host, a Controller and one or more users. These participants have
varying privileges during the Collaboration Session.

11.1 Collaboration User Tree
When you are in a Collaboration Session, the panel on the left displays the Users tab,
in addition to the tabs displayed when you are normally viewing a file. The Users tab
displays the Username, the Layer Color representing the user, the In Session value
and the user Status.

Figure 11–1 Collaboration User Tree

11.2 The Host
The person who initiates the Collaboration Session is the Host by default. The Host is
also automatically the Controller of the Collaboration Session. The Host can assign
another user to be the Host by selecting Assign Host from the Collaborate menu.

When initiating a Collaboration Session, the Host can specify the Markup to open; the
host can also open a Markup file while a session is in progress. The Host can invite
other users to join the Collaboration Session during the session or at initiation of the
session.

The Host can also save the collaboration markup, called the Session Markup. The host
is the only one who can save the Session Markup.

Note:
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11.3 The Controller
The Controller is the person who controls the base file's view during the Collaboration
Session. Other participants in the Collaboration Session can choose between
displaying or hiding the Controller's View changes.When a session is initiated, the
Host is also the Controller. The Controller can change the base file anytime during the
Collaboration Session. However, when the Controller is not the Host, opening a new
file has to be approved by the Host.At any time during a session, a participant who is
not an Observer can request control of a Collaboration Session.

11.4 Lock
Any user who is not the Controller of the Collaboration Session can choose to display
the Controller's View modifications on the base file and the other participants'
modifications on the Markup file made during the Collaboration Session. To do so,
from the Collaborate menu, select Lock View to Presenter, or from the Collaborate
status bar, click Lock View to Presenter .

When you lock your view, the file displayed will have the same Configuration options
that the Controller set in the Configure menu.

For all users, except for the Controller, view options are
disabled.

To unlock your view from the presenter, from the Collaborate menu, again select Lock
View to Presenter, or from the Collaborate status bar, click Unlock View to Presenter

.

11.5 Observer
Observers can take part in a Collaboration Session but cannot create Markup entities.
They can observe and make comments in the Chat window. The Host can designate a
user as an Observer when the Host invites the user to the Collaboration session. A user
can also decide to take part as an Observer in the Collaboration Session by selecting
Observer in the Join Session dialog. There can be more than one Observer during a
Collaboration Session.

11.6 Opening a File
The Controller is the only user who can open a file during a Collaboration Session.

To open a URL, from the File menu, select Open URL.

To open a local file, from the File menu, select Open Local File.

The File Open dialog appears, letting you specify the file to open.

When AutoVue is integrated with a Document Management System (DMS), clicking
Open URL opens a dialog that lets you view a DMS file. You can work on this file
opened through Open URL during the Collaboration Session. When the Host is the
same as the Controller and the Host opens a URL, the host is prompted to save the
Session Markup. When the Controller opens a URL, the Host is prompted to save the
Session Markup.

Note:
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11.7 Pointer
The Pointer is the cross-hair marker the Controller uses to point to a specific place
in the file.

11.8 Session Information
The Session Information option is available from the Collaborate menu during a
Collaboration Session. It displays the Session Subject (the name assigned to the
Collaboration Session), the Session ID, the name of the base file viewed, the Host and
the list of users participating.

11.9 Session Markup
This is the Markup file created during the Collaboration Session. All participants can
add Markup entities to the Session Markup file.

Only the Host can save the Session Markup. Save and Save As
are disabled for all other users.

11.10 Show Presenter Window
The Show Presenter Window option in the Collaborate menu is available to any user
whose view is set to unlocked. When you select Show Presenter Window from the
Collaborate menu, the Presenter Window appears displaying a bird's eye view of the
base file viewed and the Markup changes done during the Collaboration Session.

When you use Show Presenter Window, you can simultaneously track the Controller's
base file view changes and everyone's markup changes in the Presenter Window while
your main window display remains unaffected by anyone’s modifications. It is like
having a locked view and an unlocked view on hand at the same time.

11.11 Collaboration Session
The Collaborate menu provides you with a means to initiate a Collaboration Session
or join an existing session. When you initiate a Collaboration Session, a session object
is created on the server and you are the Host and Controller of the session. The Host
owns the Session Markup and is the only one who can save it and open an existing
Markup. The Host can also invite other users during a session.

11.11.1 Initiating a Collaboration Session
When you initiate a Collaboration Session, a session object is created on the server and
is maintained for the duration of the Collaboration Session. When you initiate a
session, you become the Host and the Controller of the session.

1. Open the file that you want to collaborate on.

2. From the Collaborate menu, select Start Collaboration Session.

The Initiate Session dialog appears.

3. In the Session Subject field, enter a session name.

4. If you want to open a Markup for the Collaboration Session, click Browse and
browse and select the markup you want to open.

Note:
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5. Select Public if you want the Collaboration Session visible to others who may
want to join the session.

6. Select Private if you want the Collaboration Session only visible to the
participants.

7. If you want to set a password for the Collaboration Session, enter a Password, then
enter it again to Confirm.

If you selected Private and chose not to set password, when you click OK, a
confirmation dialog appears asking if you are sure you do not want to set a
password.

8. From the Users list, select the users that you want to invite.

The Users list shows all users connected to the AutoVue server.

9. Click Add. To remove a user, select the user from the Invited list and click
Remove.

The user you selected appears in the Invited list.

10. To designate a user as an Observer, select the Invited check box.

11. Click OK.

AutoVue goes into Collaboration mode and the session is started. The user or
users that are invited receive a tooltip notification that he or she has been invited
to join the session. The notification message indicates the Session Name, File and
Initiator.

11.11.2 Changing a User’s Layer Color of a Session
1. In the Initiate Session dialog, click Layer Color.

The Layer Color dialog appears.

2. Select a Layer Color from the list or select Let user choose if you want the user to
choose their own color.

3. Click OK.

In the Initiate Session dialog, the selected layers color appears beside the
Username in the Invited list.

If you selected Let user choose, a custom color icon appears beside the Username,
indicating that the color can be changed by the user.

11.11.3 Adding New Users to a Session
You can also invite users that are not currently online using the Add New button on
the Initiate Session dialog.

1. In the Initiate Session dialog, click Add New.

The Add User dialog appears.

2. Enter Username.

3. Select Observer if you want to designate the user as an Observer.

4. Select a Layer Color from the list or select Let user choose if you want the user to
choose their own color.

5. Click OK. The new user is added to the Invited list in the Initiate Session dialog.
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11.11.4 Opening a Markup While Initiating a Session
1. From the Collaborate menu, select Start Collaboration Session.

The Initiate Session dialog appears.

2. Click Browse.

The Markup Files dialog appears.

3. In the Select Markup File(s) list, select the check box beside the Markup that you
want to open.

4. To import a Markup file, click Import.

The Select markup file to import dialog appears.

5. Locate the file that you want to open.

6. Click Open.

7. Click OK in the Markup Files dialog.

8. In the Initiate Session dialog, select Session Markup if you want to open a Session
Markup and keep the layer colors and markup entities from the Collaboration
Session.

9. Click OK.

The selected Markup appears in the Initiate Session dialog.

11.11.5 Opening a Markup During a Session
The Host can open Markups during a Collaboration Session. These Markups can be
session markups created during Collaboration Sessions or any non-session Markup
files.

1. During a Collaboration Session, from the Markup menu, select Open.

A confirmation dialog appears, prompting you to save the current Session
Markup.

2. Click Yes or No or Cancel.

The Markup Files dialog appears.

3. Select the check box beside the Markup that you want to open.

4. To import a Markup file, click Import.

The Select Markup File to Import dialog appears.

5. Locate the file that you want to open.

6. Click Open.

7. In the Markup Files dialog, select Session Markup if you want to open a Session
Markup and keep the layer colors and markup entities from the Collaboration
Session.

8. Click OK.

The selected Markup appears in the Collaboration window.

Note:
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11.11.6 Joining a Session
You can either join a collaboration session that you are invited to or to a session for
which you have been provided the session ID and password. When you are invited to
a collaboration session, you get a tooltip notification. If you do not want to receive any
notifications when you are invited to a Collaboration Sessions, select Do Not Disturb
from the Collaborate menu.

1. From the Collaborate menu, select Join Collaboration Session.

The Join Session dialog appears.

2. From the Session ID list, select the active session you want to join.

3. Enter the Password if the Host has set one.

4. If you just want to be an Observer, select the check box.

5. If you want to select a layer color, click Layer Color, select a color from the list in
the Layer Color dialog and click OK.

The Layer Color is disabled if the Host did not select Let user choose when
initiating the Collaboration Session or when you are invited to join the session.

The Layer Color dialog appears.

6. Click OK in the Join Session dialog. You have joined the session.

11.11.7 Inviting Users During a Session
1. From the Collaborate menu, select Invite.

The Invite dialog appears.

2. From the Online list, select the user or users that you want to invite.

3. Click Add.

You can add users that are going to join the session at a later time by clicking Add
New and entering the Username.

The user or users you selected appears in the Invited list.

4. Click OK.

The users receive a tooltip notification that he or she has been invited to join the
session.

11.11.8 Removing Users from a Session
When initiating a Collaboration Session, if you added a user by mistake and would
like to remove a user that has been added to the Invited list, you can do so. You cannot
remove Invited users once the Collaboration Session is in progress.

1. In the Invite dialog, locate the Invited list.

The Invite dialog appears.

2. From the Invited list, select the user or users that you want to remove.

3. Click Remove.

The user or users you selected appear in the Online list.

4. Click OK. The users receive a tooltip notification that he or she is no longer invited
to the session.
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11.11.9 Assigning a Host During a Session
1. From the Collaborate menu, select Assign Host.

The Assign Host dialog appears.

2. From the Users list, select the user that you want to assign as host.

3. Click OK. The user you selected is now the host of the Collaboration Session.

11.11.10 Passing Control of a Session to Another User
When you initiate a Collaboration Session, you are the default Controller of the session
until you relinquish control to another user. You may grant control to another user any
time during the session. Once you grant control to another user, all other users will
automatically lock their views to the new Controller.

1. From the Collaborate menu, select Pass Control.

The Grant Control dialog appears.

2. From the Users list, select the user that you want to grant control to.

3. Click OK.

The user you selected has control of the Collaboration Session.

11.11.11 Saving a Session Markup
The Host owns the Session Markup and is the only one who can save it.

1. At the end of the Collaboration Session, from the Markup menu, select Save As.

The Save Markup File As dialog appears.

2. Enter the Markup ID.

The Markup Information is optional.

3. Click OK to save.

The session Markup is saved and appears as a markup note entity with the control
history and chat transcript.

11.11.12 Closing a Session
Only a Host can close a Collaboration Session.

1. From the Collaborate menu, select Close Collaboration Session.

The Save Markup dialog appears prompting you to save the Session Markup.

2. Click Yes. All users are notified that the Collaboration Session is closed.

11.11.13 Requesting Control of a Session
1. From the Collaborate menu, select Request Control.

From the Collaboration status bar, you can also click Request Control .

The Controller receives a message that you have requested control.

2. The Controller clicks OK.

You become the Controller of the Collaboration Session.



If the Controller does not respond within 10 seconds, control is
automatically granted to the user who requested it.
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11.11.14 Tracking Changes
The Show Presenter Window option allows you to simultaneously track the
Controller’s base file view changes and everyone’s markup changes while your
markup file remains unchanged.

You must be in an unlocked view state before selecting Show Presenter Window.

From the Collaborate menu, select Show Presenter Window.

You can now track changes without affecting your view.

11.11.15 Unlocking a View
If you do not want to see the Controller’s view changes, clear the Lock View.

1. From the Collaborate menu click Lock View to Presenter.

From the Collaborate status bar, you can also click the Unlock View button .

The Lock View to Presenter option is deselected.

2. From the Collaborate menu, select Show Presenter Window if you want to
simultaneously track the Controller’s base file view changes and everyone’s
markup changes while your markup file remains unchanged.

You can now track changes without affecting your view.

The Show Presenter Window option is only available when the
view is unlocked.

11.11.16 Locking a View
The Lock View to Presenter option allows you view changes the Controller is making.
When you select the Lock View to Presenter option, you are also propagating your
markup modifications to the other participants in the session. Lock View to Presenter
is the default for all participants in a session.

1. From the Collaborate menu, select Lock View to Presenter .

The Lock View to Presenter option is highlighted.

11.11.17 Viewing Session Information
1. From the Collaborate menu, select Session Information.

The Session Information dialog appears displaying the Session Subject, Session ID,
File Name, Host, and Users of the session.

2. Click Close.

11.11.18 Leaving a Session
Only a Host can close a Collaboration Session. All other participants can leave a
Collaboration Session and rejoin at a later time if it is still in session.

From the Collaborate menu, select Leave Collaboration Session.

Note:

Note:
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The other participants are notified that you left the Collaboration Session and AutoVue
returns to View mode.

11.12 Chat Window
The Chat Window, is a tool you can use to communicate with other users. You send
each other messages via the Chat Window. The Chat Window is also useful in giving
you Collaboration Session updates such as which users are present and which users
have joined or left the session.

At the end of the Collaboration Session, a transcript of the Chat Window is saved as a
Note entity along with the Markup as the Collaboration Session Markup file. The Note
entity contains session information such who the Host was, who was invited and
session time and duration.

The Chat Window contains these menu options:

Table 11–1 Menu Options

11.12.1 Sending a Message to Selected Users
1. From the Collaborate menu, select Show Chat Window.

From the Collaborate status bar, you can also click Show Chat Window .

The Chat dialog appears.

2. Select Selected users.

A list of Users appear in the Chat dialog.

3. Under Users, select the user or users that you want to send the message to.

To select more than one user, press the Shift or Control key while selecting

4. In the Send Message to field, enter your message.

5. Click Send. The private message is sent to the selected users of the Collaboration
Session.

11.12.2 Sending a Message to All Users
1. From the Collaborate menu, select Show Chat Window.

From the Collaborate status bar, you can also click Show Chat Window .

The Chat dialog appears.

2. Select All Users.

Menu Option Description

File Send Message Sends text messages to other users.

Print Prints the contents of the Chat window.

Quit Close the Chat window.

Edit Copy Copy text from the Chat window.

Clear Clears all the text in the Chat window.

Find Text Searches for text in the Chat window.

Select All Selects the entire text in the Chat window.

Options Users Displays the users in the Collaboration Session.
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3. In the Send Message to field, enter your message.

4. Click Send.

The message is sent to all users in the Collaboration Session.
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AEDA Terms and Definitions

The following table presents commonly used EDA terms and their corresponding
definitions:

Table A–1 Definitions of EDA Terms

EDA Term Definition

Annular ring A circular strip of conductive material that remains after a hole has
been drilled through the pad of a printed circuit board.

Anti-copper An area within a fill zone in which copper cannot be placed.

Aperture An opening, similar to the aperture of a camera, that is used for
photo-plotting. Apertures are available in various sizes and shapes.

Aperture list A text file containing the dimensions for each of the apertures used
to photo-plot PCB artwork.

Clusters Components that are grouped according to their interrelationships
and placed in close proximity on the board. This keeps the
connections on the PCB short so that the board is easier to work
with.

Component An element or a part of a PCB.

Component density The quantity of components on a unit area of a PCB.

Component hole A hole in the printed circuit board that corresponds to a pin or wire
of a component. This hole serves the dual function of attaching the
component to the board and establishing the electrical connection
between the pin or wire and the remainder of the board circuitry.

Component library A computer data file that contains the footprint patterns for a
number of components.

Component side The uppermost or top layer of a board on which most components
are placed.

Component
silkscreen

The silkscreen markings of the printed circuit board that appear on
the component side. The silkscreen is applied over the solder mask.

Component solder
mask

The colored, usually translucent, coating applied to the board over
the etched copper. It protects the selected areas from the soldering
process.

Connection An unrouted, partially routed, or completely routed path between
two pads. In a net with n pads, there are exactly n–1 connections.

Copper pour A method by which a copper zone is filled with a specified pattern,
with objects that cross the zone or lie within the zone being
avoided.

Copper zone An area on a board designed to be covered by a layer of copper
when manufactured. Also known as a "metal zone".
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Cross hatching The breaking up of large conductive areas by the use of a pattern of
lines and spaces in the conductive material.

Datum A specific location (a point) that serves as a reference to locate a
PCB pattern or layer for manufacture.

Density On a PCB, the degree to which components are packed on the
board. Generally, the density is given as the number of square
inches per equivalent, i.e., a lower number indicates a more dense
board.

Discrete components Components with three or fewer electrical connections (for
example, resistors or capacitors).

Electrical check The process of checking the PCB to ensure that the connections they
are on match those specified in the net list.

Fill zone A zone that defines an area to be filled with copper.

Fine pitch A class of surface-mount components that is characterized by pins
measuring 0.64mm (0.025 inches) or less from pad center to pad
center.

Footprint The physical description of a component. It consists of three
elements: padstacks, representing the pads of the component;
obstacles, representing among other things, the physical outline of
the component, silkscreens, keepouts/keepins, and assembly
drawing data; and text documenting the footprint information (for
example, the component name). You may want each project to have
its own footprint library containing all the footprints used in that
project.

Ground plane A large area on the PCB, usually an entire layer, that provides a
common ground connection for all component ground pins and
other ground connections.

Heatsink A mechanical device made of a high thermal conductivity material
that dissipates heat generated by a component or assembly.

Heuristics A method of routing that consists of repeated attempts to apply
very simple routing patterns to unrouted connections in order to
complete the routing quickly and cleanly. Typically, heuristics are
used for memory and short point-to-point routing.

Hole The area where board material must be removed by drilling or
milling.

Isolation The clearance around a pad, track, zone, or via that defines the
nearest approach allowed by conductors of another signal set.

Jumper wire A discrete electrical component or wire used to make electrical
connections between points that have no copper etch due to board
density or some other factor.

Keepout An area fill within which no routing is allowed.

Land The copper pad needed for a surface mount pin.

Layer The copper pad needed for a surface mount pin.

Manual routing Individual connections, in the form of traces, vertices, arcs, and so
on, which are entered manually into the PCB design.

Mounting hole A hole used for the mechanical support of a PCB or for the
mechanical attachment of components to a PCB.

Table A–1 (Cont.) Definitions of EDA Terms

EDA Term Definition
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Multi-layer board A PCB that has multiple layers, separated by dielectric material,
with connectivity between layers established by vias or
through-holes. This term usually refers to a board with more than
two layers.

Net A logical construct (circuit) that originates in a schematic and is
transferred to a board to describe required electrical connections.
The connections may be completed by using vias, tracks, or zones.

Net list List of names of symbols or parts and their connection points which
are logically connected in each net of a circuit. A net list can be
extracted electronically on a computer from a properly prepared
schematic.

Obstacle An outline representing an object on the board. It must be taken
into account during routing, placement, or copper pour.

Pad On a PCB, a copper shape on one or more layers (there may be a
hole and an isolation surrounding the copper) used for connecting
a component pin to the PCB. The pad indicates where pins of a
component are placed.

Padstack A numbered list of pad descriptions. Each description contains a
pad definition, including layer, style, drill diameter, size, offset, and
solder mask guard width.

PCB - Printed Circuit
Board

A PCB is a board made up of components affixed to a common
surface and connected by copper tracks.

Pin The portion of a component to which an electrical connection can
be made.

Polarity Positive polarity refers to visible items. Negative polarity refers to
items that become transparent to reveal underlaying layers or
background color.

Ratsnest A number of unrouted straight-line connections between two or
more pads that represent the electrical connections in the netlist.
The ratsnest serves as a reminder that the pads must be connected,
and that, currently, there is no track on the board to make that
connection.

Reference designator A character string denoting the type of component and a number
that is specific to that component.

Routing Placing conductive interconnects between components on a PCB
layout. The process of turning nets into tracks.

Schematic A graphical description of an electrical circuit.

Segment The partial track that exists between two adjacent vertices or
between a vertex and a pin. Sometimes the track between two pins
is also called a segment, although connection is usually the more
appropriate term here.

Signal An electrical impulse of a predetermined voltage, current, polarity,
and pulse width.

Silkscreen Text or outlines (in ink) on the solder mask, on the top, and
sometimes on the bottom of board modules. A silkscreen is used for
component and identification placement on a PCB and usually
includes component outlines, reference designators, polarity
indicators, pin one markings, part numbers, the company name,
and copyright info.

Table A–1 (Cont.) Definitions of EDA Terms

EDA Term Definition



A-4 Oracle AutoVue User Manual

SMT - Surface
Mount Technology

PCB technology whereby the leads on the chips and components
are soldered onto the surface of the board rather than inserted into
it. The use of SMT results in smaller and faster printed circuit
boards.

Solder mask A negative plot of pads with a guard band around the pads. Also, a
lacquer applied to prevent solder from adhering to unwanted areas
on the PCB.

Solder paste A pattern that serves as a template for solder paste application
when the board is manufactured.

Solder side The PCB surface opposite the one on which most components are
mounted (component side). Also, the bottom layer of the board.

Test point A special point of access to an electrical circuit that is used for
electrical testing purposes.

Through-hole via A via that connects the surface layers on a PCB.

Trace (Track) The copper trails (electrical connection between two or more
points) on the PCB and the onscreen representation of that copper.

Venting patterns Patterns etched in the board that allow gases formed during
fabrication to escape.

Vertex A logical point at which a track is ended and restarted. A vertex is
located at each change of direction on the track.

Via (feed-through
hole)

A hole connecting layers of a PCB. A through-hole via connects the
surface layers of a board. On multilayer boards, a via not reaching a
surface layer on one side is called a blind via, and a via not reaching
a surface layer on either side, thus being externally invisible, is
called a buried via.

Viastack A numbered list of via descriptions. Each description contains a via
definition, including layer, style, drill diameter, size, offset, and
solder mask guard width.

Via string The copper etch that exists between a SMT pad and a
corresponding fanout via.

Zero-length
connection

An unrouted connection between layers where the end points in the
connection have the same X- and Y- coordinates.

Zone An area on a PCB layer designated as copper or anti-copper.
Copper zones may have net names, while anti-copper zones may
not.

Table A–1 (Cont.) Definitions of EDA Terms

EDA Term Definition
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BFeedback

If you have any questions or require support for AutoVue, please contact your system
administrator. If the administrator is unable to resolve your issue, please contact us
using the links below.

B.1 General AutoVue Information

B.2 Oracle Customer Support

B.3 My Oracle Support AutoVue Community

B.4 Sales Enquiries

Web Site http://www.oracle.com/us/products/applications/autovue/index.html

Blog http://blogs.oracle.com/enterprisevisualization/

Web Site http://www.oracle.com/support/index.html

Web Site https://communities.oracle.com/portal/server.pt

Sales Enquiries https://www.oracle.com/corporate/contact/global.html
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